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This book describes how to use IBM Storyboard Plus
Version 2.00, an easy-to-use system for preparing and
showing color presentations, or stones, with your com
puter.

Storyboard Plus has other uses, too. For example, most
of the figures in this book were created using the screen
capture and editing features of Storyboard Plus.

is OrgasiBzed

Chapter 1, "Introduction" describes Storyboard Plus and
how to get started using the program.

Chapter 2, "Picture Maker" describes how to create pic-
tures for your stories.

Chapter 3, "Picture Taker" describes how to "capture"
pictures from other programs and use them with
Storyboard Plus.

Chapter 4, "Text Maker" discusses how to create text
screens for use in your stories.

Chapter 5, "Story Editor" discusses how to put pictures
and text screens together to create stories.

Chapter 6, "Story Teller" describes how to present stories
you create with Story Editor.

Appendixes discuss the following information;

• Messages you may see while using Storyboard Plus

• Supported hardware



• How to set up Storyboard Plus for use on the IBM
PC Local Area Network

• How to set up a Kodak Remote Control Adapter

• Picture file format

• Creating new digitize and print drivers

• Product support and license information

Chapters 2 through 6 contain reference information about
the modules that make up Storyboard Plus. In addition,
each of these chapters includes a tutorial you can use to
learn more about some of the features discussed in that

chapter.

For information about product support and warranty,
refer to Appendix G, "Storyboard Plus Product Support
and License Information."

What Yoy Should Know Before Reading This Book

This book assumes you know basic information about
your computer, including how to;

• Switch your system on and off

• Insert, format, and handle diskettes

• Use input devices that may be attached to your
system, such as a mouse, graphics tablet, or joystick

You also should be familiar with basic Disk Operating
System (DOS) concepts, such as the role of files and
directories.

If you need more information about these topics, refer to
the DOS manual and to the manuals that accompanied —'
your computer system.

IV



What's New in This Version

If you have used IBM Storyboard Plus before, here's what
you can look forward to in Version 2.00:

Added Features

• New resolution mode, 640 x 480 - 256, using the IBM
Personal System/2® 8514/A Display Adapter (1MB of
memory required on card)

• Support for the TIFF and PCX file formats

• Ability to use the following video capture boards:

— Jovian Logic Corporation VIA' Video Frame
Grabber Board (PC Bus and MCA Bus versions)

— Truevision TARGA^ 16 Videographics Adapter

• New printers supported:

— IBM Pageprinter
— IBM Proprinter™ II
— IBM Proprinter II XL
— IBM Proprinter III
— IBM Proprinter III XL
— IBM Proprinter X24E™
— IBM Proprinter XL24E™
— IBM Pageprinter Model 2
— IBM Personal Pageprinter 010
— IBM Personal Pageprinter 020
— IBM Personal Page Printer II
— IBM Quickwriter

Personal System/2 is a registered trademark of the International Business
Machines Corporation.

1 VIA is a trademark of Jovian Logic Corporation.

2 TARGA is a trademark of Truevision Corporation.

Proprinter, Proprinter X24E, and Proprinter XL24E are trademarks of the
International Business Machines Corporation.



— Hewlett-Packard LaserJet Series II

— Hewlett-Packard PaintJet^

In Picture Maker:

— Contour option for selecting irregularly-shaped
areas

— Ruler option to help with alignment in pictures
— Ability to underline spaces when entering text
— Spread feature for creating interesting backgrounds

and filled areas using an automatically-generated
range of colors

— Ability to save and retrieve text attributes for ease
of style selection

— Change Color option for altering color with the
Paint and Spray icons

— Two additional palettes available in the 320 x
200 —4 resolution mode

— Ability to save defaults for Modes menu options,
library and font files, graph parameters. Print
panel, and other features

In Story Editor:

— Copy Story option for copying a story and all ref
erenced files to a directory or diskette

— Ability to view all partial pictures in sequence
— Ability to change all colors in text mode
— New command: /CALL (like /TELL, except that

control returns to the original story)
— Two new dissolve methods: INSTANT and

BLEND

— Ability to save default selection of Full Screen or
Monitor mode

3 Hewlett-Packard LaserJet Series II and Hewlett-Packard PaintJet are

trademarks of Hewlett-Packard Corporation.
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• In Picture Taker:

— Ability to define the key combination used to
capture screens

— Ability to convert text screens to graphics

Improved Performance and Usability
• Ability to type a filename on the File Services panel as

an alternative to scrolling and selecting from the list

• Quick Save feature in Picture Maker and Story Editor
for convenient saving of pictures and stories

• In Picture Maker:

— Improved print capabilities, including three print
sizes and ability to preview and change print
colors

— Ability to display and edit pictures created in
higher resolution modes in lower resolution modes

— Improved display of lower resolution pictures in
higher resolution modes

— Ability to use the Constrain option with the Scale
feature and when scaling library and graph images

— Display of Rotate, Scale, X,Y Coordinates, and
Zoom information in Full Screen mode

— Abihty to restore information after selecting Undo
— Use of Cursor keys for precise drawing while using

the mouse as the input device
— Ability to display keyboard assignments on the

screen while using Picture Maker
— Code swapping to a specified default buffer path

to reduce memory requirements

• In Story Editor:

— Improved performance of run functions, dissolve
methods, and commands

— Ability to type information directly into the story
table

— Ability to change path information directly for the
selected file

vii



— Ability to pass larger strings with the /INT
command

— Improved /EXEC command for faster transitions
to other programs, without clearing the screen

— Ability to display keyboard assignments on the
screen while using Story Editor

In Story Teller:

— Improved performance of run functions, dissolve
methods, and commands

— Two Story Teller files combined into one EXE file
— Faster progression through introductory program

screen
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About This Chapter

This chapter describes Storyboard Plus. It also includes
information about starting and using the program. You
may not need to read everything in this chapter, especially
if you have used Storyboard Plus before. Refer to the fol
lowing list to decide which sections in this chapter you
should read.

• "About Storyboard Plus" —Read this section if you
have never used Storyboard Plus before.

• "Getting Started" —Follow the procedures in this
section if you do not have backup copies of the
Storyboard Plus diskettes or if you want to install the
program on a fixed disk.

• "Starting and Exiting Storyboard Plus" —Read this
section if you do not know how to start and exit
Storyboard Plus.

• "Storyboard Plus Setup" and "Quick Menu
Maintenance" —Use the information in these sections

to customize Storyboard Plus for your system. You
can skip these sections if you want to use the standard
setup information included with the program (refer to
"Storyboard Plus Setup" to find out more about
standard setup information).

About Storyboard Plus

Storyboard Plus helps you create color presentations, or
stones, which you can run on an IBM PC or Personal
System/2, show with a video projector, or transfer to
other media, such as videotape, slides, or paper.
Storyboard Plus consists of five modules:

Picture Maker Story Editor
Picture Taker Story Teller
Text Maker
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Picture Maker

Picture Maker lets you create pictures and graphs for
your Storyboard Plus presentations. With Picture Maker,
you can modify pictures you have created and pictures
you have "captured" from other programs by using
Picture Taker.

With Picture Maker, you can:

• Draw rectangles, squares, circles, ellipses, and lines.

• Spray, paint, and fill areas with colors or pre-made
patterns which you can modify and save.

• Move, copy, scale, rotate, and flip figures.

• Create text in a variety of fonts and styles.

• Easily generate bar, pie, and line graphs.

• Use shadows in the depth, direction, and color of your
choice for figures, text, and graphs.

• Create pictures using a video camera. _

Picture Taker

Picture Taker is like a camera that captures what appears
on the screen and stores it in a file. With Picture Taker,
you can capture graphics screens or text screens from
other DOS applications. Then you can edit those screens
in Storyboard Plus. Picture Taker can save you time by
eliminating the need to recreate screens from scratch.

Text Maker

Text Maker lets you create and edit text screens for use in
your stories. You can create text screens from scratch, or
you can edit screens you have captured with the Picture
Taker module.
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For example, you can capture a screen from a spreadsheet
program that contains data you want to present. Then,
using Text Maker, you can add titles and explanatory text
to the screen before using it in your Storyboard Plus pres
entation.

Text Maker also lets you create boxes and draw text-
character pictures in the foreground and background
colors of your choice.

Story Editor
Story Editor is the module you use to assemble your
Storyboard Plus presentation. Story Editor makes it easy
to arrange your pictures and text screens in sequence and
select special dissolve techniques that lead you from one
screen to the next.

With Story Editor, you immediately see the results of
additions or changes to your story. You can display pic
tures sequentially forward or backward, or jump to spe
cific steps in the story. After you create or modify a
presentation, you can save it on diskette or fixed disk.

Story Teller
Story Teller lets you display presentations you have
created with Story Editor. You can present your stories
on a large monitor or video projector, if the equipment is
supported by your system configuration.
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Getting Started

This section describes how to back up the Storyboard
Plus diskettes and how to install and remove Storyboard
Plus from a fixed disk. If you already have backup copies
and Storyboard Plus is installed on your fixed disk, go to
"Starting and Exiting Storyboard Plus" on page 1-10.

Backing Up Your Program Diskettes
Before using Storyboard Plus, you should make a backup
copy of each of the program diskettes that accompany
this book. You can make these copies using the DOS
DISKCOPY command or using the backup program pro
vided with Storyboard Plus. The following steps describe
how to use the Storyboard Plus backup program.

1. Format and label one blank diskette for each

Storyboard Plus diskette you back up.

For example, if you are using the 5.25-inch, double-
sided, double-density Storyboard Plus diskettes, you
will need to format six 5.25-inch diskettes at 360KB

density.

If you are using the 3.5-inch, double-sided diskettes,
you will need to format three 3.5-inch diskettes at
720KB density.

Also, if you intend to store pictures and stories on
diskette, you should format one or more additional
diskettes.

2. Make sure drive A is the default drive (if C > appears
as the DOS prompt, type a: and press Enter).

3. Insert the Storyboard Plus Diskette 1 in drive A.
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4. Type install and press Enter. You see the
Backup/Install Menu.

: nn/hn/nn

n=HeIp

I6H Plus
Bacloip/Install

Backup/Ins tall Henu.

1. ifSLGK U disxette

Uepsion 2.N
Copgpiffht IBN Coppopatlon 1987, 1989

Esc:Exit

Figure 1-1. The Backup/Install Menu

Note that the first option on this menu, Back up
program diskette, is highlighted. You can highlight
other selections on Storyboard Plus menus by using
the Cursor keys. You select a highlighted option by
pressing Enter.

5. Select Back up program diskette from the menu.

6. Follow the instructions that appear on the screen.
When you see the message Back up is complete, press
Enter to return to the Backup/Install Menu.

7. Store the original Storyboard Plus diskettes in a safe
place. From now on, use your backup copies to run
the program.

If you want to install Storyboard Plus on a fixed disk,
follow the steps in the next section. To start using
Storyboard Plus, go on to "Starting and Exiting
Storyboard Plus" on page 1-10.

1-7



Installing Storyboard Plus on a Fixed Disk
If you use a fixed disk, you may wish to install
Storyboard Plus in its own subdirectory. You can install
using the DOS MAKE DIRECTORY and COPY com
mands or using the installation program provided with
Storyboard Plus. The following steps describe how to use
the Storyboard Plus installation program.

1. Display the Backup/Install Menu as described in the
previous section.

2. Select Install on a disk from the Backup/Install Menu.
A box appears where you enter the drive and directory
in which to install Storyboard Plus.

3. Press Enter if you want to install the program on
drive C in a subdirectory named STORYBD (the
Install program creates this subdirectory for you). To
install Storyboard Plus in a different drive or direc
tory, type a new path and press Enter (to cancel
installation, press Esc).

4. Follow the instructions that appear on the screen.

5. When you see the message Installation is complete,
press Enter to return to the Backup/Install Menu.

6. If you are using 5.25-inch diskettes, remove Diskette 6
from drive A and insert Diskette 1. If you are using

® 3.5-inch diskettes, remove Diskette 3 and insert
Diskette 1.

7. Press Esc to exit the Backup/Install Menu. A message
asks you to confirm that you want to exit.

8. Press Y. You return to the DOS prompt.
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Removing Storyboard Plus from a Fixed Disk
If you want to reorganize your fixed disk or move
Storyboard Plus to a different system, you should first
remove Storyboard Plus from the subdirectory in which it
is installed.

To do this, use the Remove program from a fixed disk
option on the Backup/Install Menu. Note that this
option only removes files that were included on the ori
ginal Storyboard Plus program diskettes. Any files you
have created remain in the subdirectory.

To use this option:

1. Make sure drive A is the default drive (if C > appears
as the DOS prompt, tj^e a: and press Enter).

2. Insert the Storyboard Plus Diskette 1 in drive A.

3. Type install and press Enter. You see the
Backup/Install Menu.

4. Select Remove program from a fixed disk from the
Backup/Install Menu. A box appears with
C:\STORYBD as the default drive and directory in
which Storyboard Plus is installed.

5. If C:\STORYBD is the correct path, press Enter to
continue. If Storyboard Plus is installed in a different
drive or directory, type the path where Storyboard
Plus is installed, and then press Enter. The
Storyboard Plus files are removed from the drive and
directory you specified.

6. Press Enter to return to the Backup/Install Menu.

7. Press Esc to exit the Backup/Install Menu. A message
asks you to confirm that you want to exit.

8. Press Y. You return to the DOS prompt.

Remember to go back and erase the other files you
created after you copy them to your new location.
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starting and Exiting Storyboard Pius

The following sections describe how to start Storyboard
Plus from a fixed disk or diskette, and how to exit the
program.

Starting From Fixed Disk
To start Storyboard Plus from a fixed disk, follow these
steps:

1. Start DOS.

2. At the DOS prompt, change to the directory in which
you installed Storyboard Plus. For example, at the
DOS prompt enter:

cd\storybd

Refer to your DOS manual if you need more informa
tion about changing directories.

3. Type sbmenu and press Enter.

The Storyboard Plus Quick Menu/Setup screen
appears. This menu displays the selections you choose
to start the Storyboard Plus modules. Starting a
module is discussed further in the chapter about that
module.

Starting From Diskette
To start Storyboard Plus from diskettes, follow these
steps:

1. Start DOS.

2. Insert the Storyboard Plus Diskette 1 in drive A.

3. Type sbmenu and press Enter.
The Storyboard Plus Quick Menu/Setup screen
appears. This menu displays the selections you choose
to start the Storyboard Plus modules. Starting a
module is discussed further in the chapter about that
module.
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Exiting Storyboard Pius
To exit Storyboard Plus from the Quick Menu/Setup
screen, press the Esc key. A message appears asking you
to confirm that you want to exit the menu. Type y to
exit, or press Enter to cancel exiting the program.

Storyboard Pius Setup

This section describes how to set up Storyboard Plus with
information about your system and how you want the
program to work. If Storyboard Plus already has been set
up on your computer, go to the chapter that describes the
Storyboard Plus module you want to use. Refer to this
section in the future if you need information about
changing how Storyboard Plus is set up.

When you set up Storyboard Plus from the Quick
Menu/Setup screen, you select:

• How the date appears on Storyboard Plus menus

• The default buffer path (drive and directory) used by
Storyboard Plus to swap out parts of the program
when you need more memory

• The default data path used automatically by
Storyboard Plus to store and retrieve your work

• The digitizer card you use, if any

• The type of input device you use (keyboard, mouse,
graphics tablet, or joystick)

• The type of printer you use

• The color you would like to use for the screen

• The resolution mode you work in most often

• Whether you want to use sound for messages and
errors
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If you do not set the default data path, input device,
printer, and resolution mode, Storyboard Plus is set up
with:

• Drive A as the default data and buffer paths

• The keyboard as your input device

• An IBM Proprinter as your printer

• An IBM Color Display in 320 x 200 - 4 resolution
mode

Note: The name of this resolution mode, "320 x
200 —4," indicates how many pixels (320 x 200)
and how many colors (4) can be used in a picture.
Pixels are discussed later in this chapter.

To set up Storyboard Plus, press the F2 key. The Setup
menu appears. To select an option from this menu, high-
Ught the option using the Cursor Up or Down key, and
then press Enter. The following sections describe how to
use each of these options.

When you have finished using these options, press Esc. If
you made any changes to the setup, a message informs
you that the changes have been saved. Press Enter to
return to the Quick Menu/Setup screen.

Choosing the Date Format
With Date format highlighted on the Setup menu, press
Enter to determine how the date appears on all of the
Storyboard Plus main menus. After you select this
option, a box appears that shows three date formats.

The list of formats contains more than the three dis

played. To view the other choices, use the Cursor keys to
scroll through the list.

To select a date format, highlight the format and press
Enter. You return to the Setup menu.
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Setting the Default Buffer Path
The programs that make up Storyboard Plus use your
computer's memory. When Storyboard Plus needs more
memory, it temporarily takes sections of programs out of
memory and places them on the fixed disk or diskette, so
that other parts of the program can use the memory.

The default buffer path is the drive and directory where
Storyboard Plus temporarily places programs. To set this
path, press the Cursor Down key to highlight Default
buffer path on the Setup menu. Then press Enter. A box
appears where you can enter a drive and a directory.

When you first use this option, A:\ appears in this box.
This indicates that the root directory of the diskette in
drive A is the default buffer path. You can change this
path to any drive or directory.

Press Enter when you have finished typing the default
buffer path. You return to the Setup menu.

You also can display a panel to help you select the default
buffer path. With the Default Buffer Path box displayed,
press FIO to display the File Services panel.
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Figure 1-2. The File Services Panel

This panel also appears if you enter an incorrect buffer
path or if you delete the information in the Default Buffer
Path box and press Enter.

The File Services panel displays your system's drives,
directories, and files. You can use the Tab and Shift-Tab
keys to move the cursor among the Drive, Directory, and
Filename boxes of this panel. Selecting a drive displays
the directories on that drive. Selecting a directory dis
plays the files and subdirectories in that directory.

As you select drives and directories, the information in
the Default Buffer Path box changes to reflect your
selections. When the default buffer path you want to use
is displayed in the Default Buffer Path box, press FIO.
You return to the Setup menu.

Note: The most efficient buffer path involves
using a virtual disk, which you can set up using
the VDISK.SYS file included with DOS. The least

efficient buffer path is a diskette drive.
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Setting the Default Data Path
The default data path is the drive and directory in which
you most commonly store your work. When using the
Storyboard Plus modules, you have the option of
changing the drive and directory where work is stored.
Setting the path you will use most often will save you
time as you use Storyboard Plus.

To set the default data path, use the Cursor Down key to
highlight Default data path on the Setup menu. Then
press Enter. A box appears where you can type a drive
and a directory. While typing the path, you can use the
Cursor Right and Left, Insert, and Delete keys to edit
your entry. After typing the default data path, press
Enter. You return to the Setup menu.

You also can display a panel to help you select the default
data path. With the Default Data Path box displayed,

_ press FIO to display the File Services panel. This panel
also appears if you enter an incorrect data path or if you
delete the information in the Default Data Path box and

press Enter. Refer to the previous section for information
about using this panel.

Selecting a Digitizer Card
If you use a digitizer card, select Digitizer card on the
Setup menu to tell Storyboard Plus the type of card you
use. A box appears displaying three of the choices. Use
the Cursor keys to scroll through the list and view the
other choices. To select a digitizer card, highlight your
choice and then press Enter. You return to the Setup
menu.

Note: Select Other if you are using a digitizer
card other than those listed. To use a card other

than those listed, you must supply a digitize driver.
Refer to Appendix F, "Creating New Digitize and
Print Drivers" for information about creating
digitize drivers.
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Choosing an Input Device
You can use a mouse, keyboard, graphics tablet, or
joystick with Storyboard Plus. If you have a mouse
attached to your system, you may find that the mouse is
more convenient to use than the keyboard, especially with
Picture Maker and Story Editor. The mouse lets you
point and click when selecting options and other objects
on the screen.

The input device you select using the Setup menu will be
the default input device every time you start the program.
If you do not use this option to change the input device,
the program expects you to use the keyboard as your
input device.

To change the default input device;

1. Use the Cursor Down key to highlight Input device on
the Setup menu.

2. Press Enter. The Input Device menu appears.

3. Select Input device from the Input Device menu. A list
of input devices appears.

4. Use the Cursor Up or Down key to scroll through the
list and highlight the device you want to select as the
default input device.

Note: Highlight Other if you are using a device
other than those listed.

5. Press Enter. You return to the Input Device menu.

6. If your input device is attached to one of your
system's communications ports, select DOS device
name on the Input Device menu to tell Storyboard
Plus which port you use.

A menu appears where you select COMl, COM2, or
none. Highlight the device name of your choice and
press Enter. You return to the Input Device menu.
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7. Press FIO to accept all of your changes. If you
selected a mouse as your default input device, an addi
tional menu appears where you select right- or left-
handed operation and button action.

By default, Storyboard Plus is set for right-handed
mouse operation. This means that Button 1 on the
mouse is the left button. Button 2 is the right button.
To switch to left-handed operation, select Hand on the
menu. Then, select Left handed. This makes Button 1
the right button and Button 2 the left button on the
mouse.

The Button action option lets you choose how the
mouse buttons are used to select and carry out
Storyboard Plus features. By default, the program
uses the Button press action. (The instructions in this
manual assume that this is the type of button action
you use.) With this action, you start and stop most
operations by pressing and releasing a mouse button.

The other button action. Button release, lets you start
an operation by pressing a button, and then stop the
operation by releasing the button. You can switch to
this mode by selecting Button action from the menu.
Then select Button release.

After selecting hand operation and button action,
press FIO to accept your changes and return to the
Setup menu.

Using a Joystick as input Device

To use a joystick as your input device, you first must
install the joystick driver program supplied with
Storyboard Plus. This program is located on the
Storyboard Plus Diskette 2 (3.5-inch) or Diskette 3

^ (5.25-inch).
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To install this program from DOS:

1. Make sure drive A is the default drive.

2. Insert the Storyboard Plus Diskette 2 (3.5-inch) or
Diskette 3 (5.25-inch) in drive A.

3. At the DOS prompt, type joystick, and then press
Enter. Instructions appear on the screen that help you
set up your joystick for use with Storyboard Plus.
After you follow these instructions, a message indi
cates installation is complete. You return to DOS.

4. Start Storyboard Plus as described earlier in this
chapter.

5. Press F2 at the Quick Menu/Setup screen to display
the Setup menu.

6. Select Input device to change the default input device.

7. Select Input device from the Input Device menu.

8. Select Other from the list of input devices.

9. Press FIO to accept all changes.

When using a joystick, you must follow these steps to
install the driver program before starting Storyboard Plus.
The program stays in memory until you install a driver
program for a different device, reset the system by
pressing the Ctrl-Alt-Delete keys, or switch off your com
puter.

Selecting a Printer
To set up Storyboard Plus with information about your
printer:

1. Select Printer on the Setup menu. The Printer menu
appears.

2. Select Printer on the Printer menu to select the type of
printer you use. A list of printers appears.
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3. Use the Cursor keys to scroll through the printer list
and highlight the printer you use.

4. Press Enter to select the highlighted printer.

5. When selecting certain printers, such as the IBM Per
sonal Pageprinter 010, another box appears where you
choose printer resolution. Printer resolution is meas
ured in dots-per-inch (DPI). Select 100 DPI for
lower-resolution printing, or 300 DPI for higher-
resolution printing. You return to the Printer menu.

Note: Your printer may need additional memory
to operate in 300 DPI printing mode. If after
selecting 300 DPI your pictures do not print prop
erly, return to this setup procedure and select 100
DPI.

6. If you are using the printer in a country other than
the United States, select Model on the Printer menu.
A box appears with the selections United States and
Other countries. Select Other countries from the box.

7. If you are using single sheets of paper that are manu
ally or automatically fed select Paper feed from the
Printer menu. Another menu appears. Select Cut
sheet auto or Cut sheet manual from the menu. The

default is Continuous.

8. To select the port to which your printer is attached,
select DOS device name from the Setup menu (the
default is LPTI). Another menu appears from which
you can select the port. Parallel printers use LPTl,
LPT2, or LPT3. Serial printers use COMl or COM2.

9. Use the Cursor Up or Down key to scroll through the
list of ports and highlight the port to which your
printer is attached.

10. Press Enter to select the highlighted port. You return
to the Setup menu.

11. Press FIG to accept all changes.
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Notes:

1. Select Other if you are using a printer other
than those listed. Refer to Appendix F for
information about creating a driver for printers
not shown in this list.

2. The IBM Personal Pageprinter 010, IBM Per
sonal Pageprinter 020, and IBM Personal Page
Printer II are supported in Hewlett-Packard
LaserJet -I- emulation mode only.

Selecting Screen Colors
Select Screen color on the Setup menu to change the color
of message boxes, help text, instructions, screens, and
main menus. After you select this option, the Change
Screen Colors menu appears. Follow the instructions at
the bottom of this menu to change the color of various
menus, panels, and boxes you see while using Storyboard
Plus. You also can view instructions by pressing Fl.

Choosing a Resolution Mode
Select Resolution modes on the Setup menu to select the
resolution, or sharpness, of the pictures you create with
Storyboard Plus. The resolution mode also determines
the number of colors available to you.

Screen resolution is measured in pixels. Pixels are tiny
rectangles that make up a graphic image. The names of
the resolution modes indicate how many pixels and colors
are available to you. The greater the number of pixels on
the screen, the sharper the image you can create.

For example, in 320 x 200 —4 resolution mode, the screen
is 320 pixels wide by 200 pixels tall, and the number of
available colors is four. In 640 x 480 —256 resolution

mode, the screen is 640 pixels wide by 480 pixels tall, and
the number of available colors is 256. The second mode

is referred to as a higher resolution mode than the first.
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The pixels in this mode are smaller and more numerous,
and therefore, will yield a sharper picture.

After you select Resolution modes, a list of modes is dis
played. Use the Cursor keys to scroll through the list and
highlight the mode you want to use. Press Enter to select
the highlighted resolution mode.

The resolution modes you can use are determined by the
tj^e of display and graphics adapter you have. Use the
following table to help you decide which resolution modes
you can select.

Table 1-1 (Page 1 of 2). Equipment and supported resolution
modes.

Display and GrapMcs
Adapter

Supported Resolution
Modes

Color Display and
Color/Graphics Adapter

320 x 200-4

Color Display and
Enhanced Graphics
Adapter

320x200-4

Enhanced Color Display
and Enhanced Graphics
Adapter

320 x200-4

Enhanced Color Display
and Enhanced Graphics
Adapter with 256KB of
memory

320 X 200-4, 640 x
200-16, 640 X 350-16

IBM Personal System/2
Model 25 or 30 with

Model 8512, 8513, or
8514 Color Display

320 X 200-4, 320 x
200-256
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Table 1-1 (Page 2 of 2). Equipment and supported resolution
modes.

Display and Graphics
Adapter

Supported Resolution
Modes

IBM Personal System/2
Model 50, 60, 70, or 80
with Model 8512, 8513,
or 8514 Color Display

All modes except 640 x
480-256

IBM Personal System/2
Display Adapter with
Model 8512, 8513, or
8514 Color Display

All modes except 640 x
480-256

IBM Personal System/2
8514/A Display Adapter
with the Model 8512,
8513, or 8514 Color
Display (1MB of memory
required on display
adapter)

All modes

Notes:

1. If you select a mode for which you do not
have enough memory or the correct display
and graphics adapter, Storyboard Plus uses the
next lower available resolution mode.

2. You can create pictures in one resolution mode
and display them in another. However, the
pictures may not appear as you expect.



Switching Sound On and Off
By default, Storyboard Plus is set up so that errors and
completed tasks are accompanied by an audible tone. To
switch off sound in the program, select Sound on/off on
the Setup menu. A box appears where you can select On
or Off. Select Off to switch off sound. Select On to

switch sound back on.

Quick Menu Maintenance

Press F3 to customize the Quick Menu/Setup screen by
changing the following:

• Date format

• Screen colors

• Program names

• Order in which the Storyboard Plus modules are dis
played on the screen

After you press F3, a menu appears that lets you make
these changes. To view more information about each
option, highlight the option and then press Fl. After
selecting an option, follow the instructions on the screen.

This chapter briefly described Storyboard Plus and its five
modules. This chapter also described how to:

• Back up the Storyboard Plus program diskettes

• Install Storyboard Plus on a fixed disk

• Remove Storyboard Plus from a fixed disk

• Start and exit Storyboard Plus

• Set up Storyboard Plus for use with your system

• Customize the Quick Menu/Setup screen
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After completing this chapter, you should go on to the
chapter that discusses the Storyboard Plus module you
want to start using first. For example, go to one of the
following chapters:

• Chapter 2, "Picture Maker"

• Chapter 3, "Picture Taker"

• Chapter 4, "Text Maker"

• Chapter 5, "Story Editor"

• Chapter 6, "Story Teller"

Each of these chapters includes a tutorial section that
helps you learn more about the module and its features.
You can use the tutorials before reading the rest of the
information in the chapters, but you should read the first
few pages of each chapter for necessary information about
using the tutorial.
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This chapter describes how to use Picture Maker, the
module that lets you create and edit graphic pictures for
use in your Storyboard Plus presentations.

The section "Learning Picture Maker" on page 2-12 is a
tutorial designed to help you become familiar with some
of Picture Maker's features. Before using this tutorial,
you should read the following sections "Starting and
Exiting Picture Maker" on page 2-4, and "The Picture
Maker Screen" on page 2-8. Picture Maker reference
information begins with the section "Drawing With
Picture Maker" on page 2-63.

We recommend that you use a mouse as your input device
when using Picture Maker. However, if you are using the
keyboard instead, look for boxes labeled "Notes for Key
board Users." These boxes contain information about the

keys to use instead of mouse buttons in each procedure.
You also can view this information on the screen while

using Picture Maker by pressing Alt-Fl. A panel appears
that you can scroll through using the PgDn and PgUp
keys. When you have finished viewing this information,
press Esc.

To see general information about a menu option or other
feature, move the arrow, or "pointer," so the tip of the
pointer touches the option or feature, then press F1 for
Help. A box appears with text you can scroll through by
selecting the arrow pointing down. You also can use the
PgDn and PgUp keys to view all of the Help information.
When you have finished viewing this information, press
Esc or Button 2.

Note: Throughout this chapter, you are instructed
to select something on the screen. "Selecting"
means to move the pointer until the tip of the
pointer touches an object. Then, press Button 1.
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Unless otherwise indicated, making a selection
involves pressing Button 1. When you are
required to press Button 2, you are explicitly
instructed to do so.

Notes for Keyboard Users

Making a selection involves moving the pointer with
the Cursor keys until the tip of the pointer touches an
object you want to select. Then press Enter or the
Plus key on the numeric keypad in place of Button 1
on the mouse. When you are instructed in this chapter
to press Button 2, press Esc or the Minus key on the
numeric keypad.

Starting and EMiting Picture Maker

Starting From Fixed Disk
If you started Storyboard Plus by entering sbmenu at the
DOS prompt, you can choose Picture Maker from the
Quick Menu/Setup screen. Use the Cursor Up or Down
key to highlight Picture Maker. Then, press Enter to
display the Picture Maker Main Menu.
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Figure 2-1. The Picture Maker Main Menu

You also can start Picture Maker from the DOS prompt
by typing pm and pressing Enter. Starting the module in
this manner displays the Picture Maker Main Menu
without first displaying the Quick Menu/Setup screen.

The first selection on the Picture Maker Main Menu takes

you to the Picture Maker screen. The other selections on
this menu let you set up your input device and printer as
you did in the section "Storyboard Plus Setup" on
page 1-11. You can use these selections to change this
information just for the current Picture Maker session.
The next time you use Picture Maker, the information
again is set according to the default selections you made
by pressing F2 at the Quick Menu/Setup screen.

Starting from Diskette
To start Picture Maker from diskettes:

1. Highlight Picture Maker on the Quick Menu/Setup
screen using the Cursor Down or Up key, and then
press Enter.

A message appears instructing you to insert a program
diskette.
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2. Remove Diskette 1 from drive A and insert Diskette 2.

3. Press Enter. The Picture Maker Main Menu appears.

4. If you have two diskette drives, insert a formatted
diskette for storing your work in drive B. If you have
one diskette drive, remove Diskette 2 from drive A
and insert a formatted diskette for storing your work.

You also can start Picture Maker from the DOS prompt
without displaying the Quick Menu/Setup screen. Here's
how:

1. Insert Diskette 2 in drive A.

2. At the DOS A > prompt, type pm and press Enter.
After a few moments, a message asks you to insert
Diskette 1 in drive A.

3. Remove Diskette 2 from drive A and insert Diskette 1.

4. Press Enter. Another message asks you to insert the
PM Program diskette (this is Diskette 2).

5. Remove Diskette 1 from drive A and insert Diskette 2.

6. Press Enter. The Picture Maker Main Menu is dis

played.

7. If you have two diskette drives, insert a formatted
diskette for storing your work in drive B. If you have
one diskette drive, remove Diskette 2 from drive A
and insert a formatted diskette for storing your work.

Note: To eliminate diskette swapping when
starting Picture Maker from the DOS prompt, use
the DOS COPY command to copy the STB.CLR
and STB.PRO files from Diskette 1 to Diskette 2.

If in the future you change setup information from
the Quick Menu/Setup screen, you must copy these
files again to Diskette 2.



The first selection on the Picture Maker Main Menu takes

you to the Picture Maker screen. The other selections on
this menu let you set up your input device and printer as
you did in the section "Storyboard Plus Setup" on
page 1-11. You can use these selections to change this
information just for the current Picture Maker session.
The next time you use Picture Maker, the information
again is set according to the default selections you made
by pressing F2 at the Quick Menu/Setup screen.

Exiting Picture Maker
To exit the module from the Picture Maker Main Menu,
press Button 2. A message asks you to confirm that you
want to exit the program. The message also reminds you
if any changes to a picture have not been saved. Press
Button 1 to exit, or press Button 2 to keep the Picture
Maker Main Menu displayed.

If you press Button 1, the Quick Menu/Setup screen or the
DOS prompt is displayed, depending on how you started
Picture Maker. If you started Picture Maker from
diskette using the Quick Menu/Setup screen, a message
asks you to insert Diskette 1 in drive A.

— Notes for Keyboard Users

Press Esc to exit Picture Maker from the Main Menu.

Press y to continue, or press Enter to keep the Picture
Maker Main Menu displayed.
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Th© Picture Maicer Screen

With the Draw selection highlighted on the Picture Maker
Main Menu, pressing Button 1 (or the Enter key) displays
the Picture Maker screen. The following figure shows the
parts of this screen:

2-8

File Edit nodes Tools Text

active pattern box
active dravii^ color
button status boxes

patterii area

im 19B3

Figure 2-2. The Picture Maker Screen

Following is a description of each part of this screen.

Screen Area Description

Drawing area The drawing area is the space in which
you create your pictures. This area is
the size of your screen. You can scroll
the area or expand it to its full size as
described later in this chapter.

Menu area Each word in the menu area represents
a separate menu you can display by
selecting the word. For example,
selecting File displays the File menu.
With a menu displayed, you can select
an option on that menu.



Icon area Icons are tools you use to create figures
and text in the drawing area. These
tools are:

❖ Scroll T lext

1 1 Select d Nicroscopi

1 Eraser 1 Pencil

Spray Line

jhMMmmm

Faint 1 1 Kectangle

Fill o Circle

Figure 2-3. Picture Maker Icons

Palette area

Line styles area

Pattern area

This area displays the drawing colors
you can use for figures and text.

The styles of lines you can use in your
pictures are displayed in this area.

The pattern area shows the patterns
you can select to use the Spray, Paint,
and Fill icons. The pattern you select
appears in the active pattern box.

This box shows you the pattern that
will be used if you select the Spray,
Paint, or Fill icon.

Active pattern box

Active drawing color
The active drawing color is shown
either by color number or in a small
color box.
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Button status boxes

Mouse Buttons 1 and 2 have active and

inactive states. Both buttons must be

inactive before you can select an icon
or menu option. The button status
boxes indicate these states as shown in

Figure 2-4.

Buttons 1 and 2

inactive

• •

Button 1

active

ktton status
boxes

Button 2

active

• I

Figure 2-4. Button Status Boxes

To return to the Picture Maker Main Menu, select Main
Menu from the File menu.
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— Notes for Keyboard Users

When the Picture Maker screen first appears, the
pointer is in the drawing area. Use the following keys
to move the pointer to other parts of the screen:

Screen Area Key
Icon area F3

Palette area F4

Line styles area F5

Pattern area F6

Active pattern box F9

File menu 1

Edit menu 2

Modes menu 3

Tools menu 4

Text menu 5

After moving the pointer to an area or menu, use the
Tab key or Cursor keys to move the pointer over the
option you want to select. Then press Enter or the
Plus key on the numeric keypad.
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This section is a tutorial designed to introduce you to
some of Picture Maker's features. It shows you step-by-
step how to draw and color boxes, enter text, and make
graphs. You need at least 30 minutes to complete this
section. Picture Maker reference information begins with
the section "Drawing With Picture Maker" on page 2-63.

Note that this section does not contain all of the informa

tion you may need to know about features you will use.
For more information about Picture Maker features, refer
to the Contents at the beginning of this chapter or to the
Index at the back of this book for the relevant page
numbers in this chapter. You also can get information
while using Picture Maker by pressing the F1 key.

Before using this section, make sure you have backup
copies of the Storyboard Plus diskettes and that the
program has been set up for your system. Chapter 1 dis
cusses backup and setup procedures. Also refer to
Chapter 1 if you need information about starting
Storyboard Plus.

If you are using this tutorial, make sure you have read the
sections "About This Chapter" on page 2-3, "Starting
and Exiting Picture Maker" on page 2-4, and "The
Picture Maker Screen" on page 2-8, before getting
started.

Note: This tutorial assumes that:

• You use a fixed disk.

• All of the files included on the original
Storyboard Plus diskettes are located in the
same default data path as described in
"Storyboard Plus Setup" on page 1-11.
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• You use the 320 x 200-4 resolution mode.

• The Picture Maker defaults have not been

changed as described in "Changing and Saving
Default Settings" on page 2-154.

If any of these assumptions is not true for you,
steps may be added or missing from the tutorial,
or your screen may differ slightly from the screens
shown in this book.

Starting Picture Maker
1. Select Picture Maker on the Quick Menu/Setup screen.

When the Picture Maker Main Menu appears. Draw is
highlighted. The resolution mode you selected when
you set up Storyboard Plus is displayed next to Draw.

])ate: nn/ftn/nn Picture Raker

To select, use t or T anti. press

Version 2.68
Copyright m Corporation 1985. 1987. 1989

Copyright Krepec PublishiDg Corporation Ltd. 1985. 1987i 1989

n=Help Esc=fc{it

2. Start using Picture Maker by pressing Button 1 (or
Enter) while Draw is highlighted. The Picture Maker
screen is displayed.
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Retrieving a Picture
Retrieve a picture called SYSTEM.PIC that was included
with Storyboard Plus by following these steps:

1. Move the pointer to File in the menu area.

17c7ibm laaa^

2-14

r FiiLe Edit Hodes Tools TeKt

2. Press Button 1. The File menu is displayed.

Note: Moving the pointer to an object and
pressing Button 1 is called selecting. From now
on, you will be instructed to select something
instead of being told to move the pointer and press
Button 1.



3. Select Get Picture from the File menu.

Savt^Picture
Save BSave
Renove Pictare

Shou Page
Print
Save Defaults
Hain Denu

nodes Tools (C) IBM

The File Services panel appears. Look for the box
named Filename in the lower right comer of the panel.

4. Select the arrow pointing down on the right side of
the Filename box until the file SYSTEM.PIC is dis

played in the list of files. If you pass this file, select
the arrow pointing up.
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5. Select SYSTEM.PIC in the Filename box.

liHC!\STQRVBD
ifi i"

r File Edit flodes Tools TokI

PIC tile^
6EI Picture file.CAP files

QeO 1IIP files

Directory Filenene

< Previous >

(C) IBM

Note: If the SYSTEM.PIC file is not displayed in
the Filename box, move the pointer to the arrow
pointing down on the right side of the Filename
box and press Button 1 until the SYSTEM.PIC
filename appears. Then select the file.



6. Select YES in the middle of the File Services panel.
The picture in the SYSTEM.PIC file is displayed in
the drawing area. Your screen should look like this:

rsVSTEtl ,PICI File Edit tlodes Tools Tent

iIIt'I

a
MQI

•
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(oiBMuea

— Notes for Keyboard Users

• Select the File menu by pressing the 1 key.

• Select Get Picture by pressing the Plus key on the
numeric keypad.

• Use the Plus and Minus keys on the numeric
keypad in place of Buttons 1 and 2, respectively.

• Use the Tab and Shift-Tab keys to move the
pointer in the File Services panel.

• Press Y or N to select YES or NO on the File Ser

vices panel.
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Drawing Rectangles and Circles
In this section you draw a display monitor for the PC on
your screen using the Rectangle and Circle icons. At the
end of this section, your picture will look like this:

rsVSTEfl .PICl File Edit Hodes Tools TeKt

ImJ
rilHi

niinii

(C) IBM

But first we'll show you how to display information about
any icon or menu option on the screen.
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1. Move the pointer so the tip of the pointer is on the
Rectangle icon.

l^ySTEn .PlCl File Edit Hodes Tools Tewt [(oiBMUifl
B'Ifi

llectangle icon

2. Press Fl. A box appears that displays information
about the Rectangle icon. To view more information,
select the arrow pointing down in the upper right
corner of the box (or press PgDn).

3. When you have finished viewing information about
the Rectangle icon, press Button 2 to exit the Help
box.

4. Select the Rectangle icon.
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5. Move the pointer to the drawing area as shown in the
picture. Note that your pointer becomes a crosshair
cursor in the drawing area.

StSTEn .PICI File Edit nodes Tools leHt (C) IBM 13B9

•an

6. Press Button 1 to anchor a comer of the rectangle.
From this comer you can pivot and expand the rec
tangle in any direction.



7. Try it. Expand the rectangle by moving the mouse
until your screen looks like this:

SVSTEn .PIC File Edit nodes Tools leKt (C) IBM 1909

Hint: If you find that you can draw only squares,
select Modes in the Menu area and select Constrain

from the Modes menu. This lets you draw rectan
gles other than squares.

8. Press Button 2 to fix the rectangle in the drawing area.

9. Press Button 1 to reposition the crosshair and begin a
second rectangle inside the first.

Note: If you make a mistake, select Undo from
the Edit menu and try again.
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10. Place the crosshair inside the rectangle you've already
drawn, as shown, and press Button 1 to start the
second rectangle.

rsVSTEn .PICl File Edit ttodes Tools Text |(c)i

pa

Bi

ll. Expand the rectangle to draw the computer screen
inside the first rectangle. Press Button 2 to fix it in
the drawing area. Make sure you leave enough space
on the right side to draw the third box and the knobs
of your display.
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12. Press Button 1 to reposition the crosshair for the third,
small rectangle on the right side of the computer
screen.

13. Now draw the third rectangle as shown.

rsVSTEtl .PICl File Edit Hodes Tools TeKt |(01BM 18B3

STI

HZI
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After drawing the third rectangle, you are ready to
select the Circle icon and draw the knobs on the

display monitor.
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Remember: To select a new icon, both status
boxes in the lower left corner of the screen must

show that the buttons are inactive.

Buttons 1anj 2

inactive

• •

Button i

active

buttonstatus

boxes

Button 2

active

ID •!

Make a button inactive by pressing it.



14. Select the Circle icon.

SVSTEH .PICl File Edit ttodes Tools Tent IwiBMiaar

15. Move the pointer to the drawing area. The pointer
becomes a crosshair cursor in the drawing area. With
circles and ellipses, the center of the crosshair marks
the center of the circle or ellipse you draw.
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16. Draw two knobs on the PC as shown. You use

Buttons 1 and 2 to draw circles just as you use them
to draw rectangles.

^TEtl .PICl File Edit (lodes Tools fert

|S.Esml

Notes for Keyboard Users

Press F3 to move the pointer to the icon area.

Use the Cursor keys to move the pointer to the
Rectangle and Circle icons.

Use the Plus and Minus keys on the numeric
keypad in place of Buttons 1 and 2, respectively.

Use the Cursor keys to move the pointer in the
drawing area.

Press the 3 key to move the pointer to the Modes
menu.

Press the 2 key to move the pointer to the Edit
menu.



Saving a Picture
Now let's save the drawing and name it PCI.

1. Select File in the menu area. The File menu appears.

2. Select Save Picture on the File menu.

iSVSTEn .PIC Edit nodes Tools

Get Picture

Save^Save
Renove Picture

Shou Page
Print
Save Defaults
Tlain Menu

(C) IBM 19B9

The File Services panel appears. Look for the box in
this panel named Filename.

2-27



2-28

3. Select New in the Filename box.

S\^IEn .PICl File Edit nodes Tools IsHt

•liii p:\STORfBD
>9 H

SflUE Picture file

I mi files "I I VES I

Directory Filenane

< Previous >

< Nev

(ti IBM 1909

The word New disappears and the line becomes high-
lighted with a blinking cursor. The blinking cursor
indicates you can type a name for the new file. As
with any DOS filename, it can consist of up to eight
numbers and letters.

4. Type PCI and press Enter.

The File Services panel is removed from the screen.
The new filename appears in the upper left corner of
the screen. A copy of the file remains in the drawing
area for you to continue editing.



Notes for Keyboard Users

• Press the 1 key to move the pointer to the File
menu.

• Use the Cursor Down key to move the pointer to
the Save option.

• Use the Plus and Minus keys on the numeric
keypad in place of Buttons 1 and 2, respectively.

• Use the Tab and Shift-Tab keys to move the
pointer in the File Services panel.

• Press Y or N to select YES or NO on the File Ser
vices panel.

Selecting and Moving Part of a Picture
Now you will move the PC to a new location in the
drawing area using the Select icon and the Move option.

1. Choose the Select icon.

tIe
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2. Move the pointer to the upper left corner of the PC
picture as shown. Note that the pointer becomes a
crosshair cursor.

3. Press Button 1. Moving the pointer now displays a
dashed line box called a "select box."

4. Move the mouse so the select box expands to encom
pass all of the PC picture.

•PICl File Edit tlodes Tools Text

• [
uiiiiii:
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5. Press Button 2 to fix the select box around the PC.

6. Select the Modes menu.

7. Select the Move option from the Modes menu.

8. Position the pointer inside the select box and press
Button 1.

.PICl File Edit Hodes Tools Tewt IBM 13Ba
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9. Move the PC to the right side of the drawing area and
press Button 2.

PCI .MCl File Edit Hodes lools Text IToibmisITi

i
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10. Press Button 1. The select box returns to its original
position. To remove the select box, move the pointer r^S
outside of the box and press Button 1.

File Edit nodes Tools leHt (C) IBM 1SB9



Notes for Keyboard Users

• Press F3 to move the pointer to the icon area.

• Press the 3 key to move the pointer to the Modes
menu.

Copying Parts of a Picture
Now you will use the Select icon and the Copy option to
make three copies of the PC and position them in the
drawing area.

1. Select the Modes menu.

2. Select the Copy option.

3. Draw a select box around the PC as you did in the
previous section.

4. Position the pointer inside the select box and press
Button 1. Now as you move the mouse, a copy of the
PC moves in the drawing area.

5. Move the copy to the upper left corner of the drawing
area and press Button 2. Now you have two PCs in
the drawing area.

PCI .PIC File Edit tlodes Tools TeSt IcoiBMimi
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As you move the mouse, note that the select box and
a copy of the PC still move in the drawing area. You
can copy the contents of the select box as many times
as you need by positioning the copy and pressing
Button 2.

6. Position two more copies of the PC as shown.

File Edit Hodes Tools Tewt hoiBMigaal
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7. Press Button 1 to cancel copying. Note that the
pointer and select box return to the drawing area. To
remove the select box from the drawing area, make
sure the pointer is not in the box and press Button 1.

Notes for Keyboard Users

• Press the 3 key to move the pointer to the Modes
menu.

• Press F3 to move the pointer to the icon area.



Erasing Parts of a Picture
In this section you will use the Eraser icon to erase one of
the PC copies.

1. Select the Eraser icon.

SVSTEn .PIC File Edit nodes Tools TeHt |(c>ibmi3B3

|| |H tmiiii
1 Mr

2. Move the pointer into the drawing area. Note that
the pointer becomes a solid block.
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3. Position the pointer on the PC copy shown in the fol
lowing figure, and then press Button 1.

File Edit Nodes Tools leKt I(c)IBM 19Ba'

pointer

4. Erase the PC by moving the pointer back and forth
over the PC until it is erased.

Note: To restore areas you accidentally erased,
press Button 2 and move the pointer over the areas
you want to restore. Press Button 2 again when
you have finished restoring areas.

5. Press Button 1 when you have finished erasing the PC.

— Notes for Keyboard Users

• Press F3 to move the pointer to the icon area.

• Use the Cursor keys to move the pointer in the
drawing area.



Using the Fill icon
Now add color to the picture using the Fill icon.

1. Select a pattern by moving the pointer to a pattern
shown in the pattern area and pressing Button 1.
Note that the pattern you selected appears in the
active pattern box in the lower left comer of the
screen.

File Edit tlodes Tools Text UoiBMiaaal

active paitem tox

pattern area ^ |H
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2. Select the Fill icon, and then move the pointer to the
screen of a PC display and press Button 1. The
pattern you selected appears on the screen of the
display monitor.

File Edit Hodes Tools leKt RoiBMiSBa

3. Fill the other two displays using the same or different
patterns from the pattern area.

4. Save this picture and name it PC2.

— Notes for Keyboard Users

• Press F6 to move the pointer to the pattern area.

• Press F3 to move the pointer to the icon area.

Filling a Rectangle or Circle as You Draw It
Here's a technique you can use to fill rectangles and
circles as you draw them:

1. Select the Modes menu.

2. Select Fill Shape on the Modes menu.
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3. Select the Rectangle icon and draw a box. Note that
after you press Button 2 to fix the box, it is automat
ically filled with the pattern displayed in the active
pattern box. Circles also are filled automatically in
this manner.

4. Select the Modes menu again.

5. Select Hollow Shape to switch off the Fill Shape
option.

— Notes for Keyboard Users

• Press the 3 key to move the pointer to the Modes
menu.

• Press F3 to move the pointer to the icon area.

Undoing Your Latest Work
Before we go on, let's undo the filled box you just
created.

1. Select the Edit menu.

2. Select Undo from the Edit menu. The filled box is

removed from the drawing area.

— Notes for Keyboard Users

Press the 2 key to move the pointer to the Edit menu.
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Drawing Lines
In this section you use the Line icon to draw a line that
connects the three PCs in the picture.

1. Select the Line icon.

2-40
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2. Position the pointer on the edge of the PC on the
right side of the drawing area.

TPICI File Edit tlodes Tools Tewt
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3. Press Button 1 to start drawing a line.

4. Move the pointer left to draw a short line.

PIC File Edit Hodes Tools leKt (C) IBM 19B9

5. Press Button 2 to set the first segment of the line.

6. Move the pointer up to draw a second line segment
perpendicular to the first.

File Edit nodes Tools Tent (c) IBM 1999
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7. Press Button 2 to set the second line segment and
switch direction.

8. Move the pointer left to draw a horizontal line
extending from the second segment to the system unit
of the PC in the upper left corner of the screen.

File Edit nodes Tools Tent (c) KM 1919

9. Press Button 1 so you can reposition the pointer and
start drawing a second line.



10. Draw the second line as shown. Do not extend the

line all the way to the PC in the lower left corner of
the screen.

IPC2 .PIC File Edit nodes Tools Tent UoiBMiaBS

H

— Notes for Keyboard Users

Press F3 to move the pointer to the icon area.
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Drawing with the Microscope
In this section you will magnify part of your picture for
detailed drawing.

1. Select the Microscope icon.

[PC2~ .PICl File Edit "Bodes" Tools Tewt " hoiBMmal
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2. Move the pointer to the gap between the end of the
last line you drew and the PC.

'PC2 .PICl File Edit llodes Tools Tewt [(oiBMuaiO IBM ISBB 1
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3. Press Button 1. That section of the drawing is magni
fied. A small box in the upper left corner of the
screen shows you the magnified portion of the screen
in normal scale. Any changes you make to the magni
fied area are reflected in this box so you can see how
the changes appear in normal scale.

4. Move the pointer to the white box next to the end of
the last line you drew, as shown in the following
figure.

File Edit nodes Tools Tent (O IBM UB9

5. Press Button 1.

6. Move the pointer left to extend the line so it touches
the side of the PC system unit. Any squares touched
by the pointer are changed to the default drawing
color (black).

7. When the line touches the right side of the PC, press
Button 1 to stop drawing.

If you accidentally colored additional boxes black,
move the pointer to one of those boxes and press
Button 2. Button 2 lets you restore a box to its ori
ginal color. Move the pointer over the boxes you
want to restore, then press Button 2 to stop restoring.
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8. To exit the microscope, move the pointer to the box
displaying the normal scale view and press Button 1.

9. Save this picture and name it PC3.

— Notes for Keyboard Users

• Press F3 to move the pointer to the icon area.

• Hold the Shift key down while using the Cursor
keys to draw in Microscope.

• Press the 1 key to move the pointer to the File
menu.

Using Text in Your Picture
Now you will add text to the picture using the Text icon.

1. Select the Text icon.

2-46
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2. Move the pointer into the drawing area. Note that
the pointer becomes a crosshair cursor.



3. Position the crosshair on the first PC you drew.

File Edit flodes Tools leKt (c) IBM

crosshair
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4. Press Button 1. Note the crosshair disappears and a
blinking cursor appears where the first position of
your text will be placed.

5. Type PCI.

6. Press Button 2.
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7. Continue labeling the other PCs as shown.

File Edit tlodes Tools Text

n il

— Notes for Keyboard Users

Press F3 to move the pointer to the icon area.



Changing Text Font
In this section you will change the text font for other text
you will enter in the picture.

1. Select Set Attributes from the Text Menu. The Set

Attributes panel appears.

C File Edit Hodes Tools Tent (c) IBM 19BS

Change Font Enter Text

Set Spacing
Change Position

Fix Spacing

Proportion-dl

Left .Til-."tifind

Right Justified

Centered

Underline
Italic
Outline Double Horiz
Shadou Double Uerti
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2. Select Change Font from the Set Attributes panel.
The File Services panel is displayed.

rPC3 .PIcTFile Edit tlodes Tools Tewt
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Directory
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GET Font file
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< Type >

(c) IBM

3. Select THINIO.FAC in the Filename box of the File
Services panel.

SET Font file

Drive Directory Filenane

< Previous >
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4. Select YES to get the font called Thin 10.

The File Services panel is removed. An example of a
character in the Thin 10 font appears in the large box
on the Set Attributes panel. To change the color of
the font, select a color from the palette area. The
sample character in the box changes to the color you
selected.

rpc3
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5. To change the size of the font you selected, move the
pointer to Size 1 and press Button 1. The size is now
Size 2.

6. Try selecting each of the following options on the Set
Attributes panel to see how they affect the sample
character.

Bold

Underline

Italic
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7. When you have finished changing your text attributes
and you are satisfied with the results, select YES to
return to the drawing area.

A large crosshair appears showing where text you
enter will appear. As you move the mouse, a second
large crosshair appears to indicate a new text position.

8. Position the second crosshair as shown below and
press Button 1.

isi crosshair

i

S ,
M crosshair

9. Press Button 2 and type Host as a label for the PC.

10. If you want to, reposition the text you just typed by
pressing Button 1 to display the Set Attributes panel.

11. Select Change Position from the Set Attributes panel.
The panel is removed, and you can move the large
crosshair to indicate the new position of the text you
just typed.

12. Press Button 1 to set the new position. The text is
moved to the new position.

13. Press Button 2 to resume typing text.
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14. Press Button 2 again to set the text in the drawing
area.

15. Use the following figure as a guide to label the other
two PCs.

PC3 .PIC File Edit nodes Tools leKt
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Host
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16. Save the drawing and name it PC4.

17. Select Clear from the Edit menu to clear the drawing
area. A message gives you the chance to confirm that
you want to clear the screen.

18. Select YES to clear the drawing area.
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- Notes for Keyboard Users

• Press the 5 key to move the pointer to the Text
menu.

• Use the Tab and Shift-Tab keys to move the
pointer in the Set Attributes and File Services
panels.

• Press Y or N to select YES or NO on the File Ser

vices and Set Attributes panels.

• Press the 1 key to move the pointer to the File
menu.

• Press the 2 key to move the pointer to the Edit
menu.

Creating Graphs
Now you will create a graph that illustrates the projected
sales increase of a certain product due to the networking
of the company's computers.

1. Select Graph from the Tools menu. The Graph panel
is displayed.
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2. Move the pointer to the first box in the Data column
and press Button 1. The first box becomes highlighted
so you can enter the first data value for your graph.

M./
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3. Type 2 and press Enter. The second box in the
column becomes highlighted.

4. Continue entering the following values in the Data
column.

5

10

20

35

55

85

5. Type 140 as the last data value, and press Button 1 to
accept all of the numbers.
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6. Move the pointer to the first box under Graph param
eters and press Button 1.
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7. Type 50 in the Graph value field and press Enter. This
value indicates the amount of space to leave between
the bars in the graph.

8. Type 10 in the Scale interval field and press Enter.
The Scale interval indicates the spacing of tics on the
scale axis.

9. Type 0 in the Low mark field and press Enter. The
Low mark indicates the lowest scale mark you want to
use.

10. Type 150 in the High mark field. The High mark
indicates the highest scale mark you want to use.

11. Press Button 1 to accept all of the information.



12. To display your graph with shadows, position the
pointer as shown and press Button 1.
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A panel appears where you can select the color, direc
tion, and depth of the graph's shadow.

Draw Graph

I VK I
Graph type

Shadow

Color

terval

One color till

13. Change shadow color by selecting a new color from
the palette area.
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14. Change the direction and depth of shadow by
selecting the arrows on the left side of the panel.

15. Move the pointer outside of the shadow panel and
press Button 2 to accept your selections. The boxes in
the lower left of the Graph panel display the color,
depth, and direction of shadow you selected.

16. Select YES on the Graph panel to display your graph.
The Graph panel is removed, displaying the graph in
the upper left corner. The graph is framed in a select
box.

I File Edit Hodes Tools Tewt
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17. Position the pointer inside the select box and press
Button 1.



18. Move the select box in the drawing area as shown.
The graph remains in the upper left comer as you
move the select box to a new location.

r I File Edit flodes Tools Tent ItoiBMiHlT

19. Press Button 1. The graph is moved to the new
location.

20. To increase or decrease the size of the graph, position
the pointer inside the select box and press Button 2.

21. Move the mouse to make the select box larger or
smaller, and then press Button 2. The graph is resized
and displayed inside the select box.
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22. Position the pointer outside the select box and press
Button 1 to fix the graph to the screen. The graph is
drawn with colors and shadowing.

I File Edit Hodes Tools loKt (c) IBM 19B3
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23. Press Button 1 again to remove the select box from the
screen.

24. Now label the graph by selecting the Text icon.
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25. Use the Set Attributes panel to select new fonts of
your choice and enter text for the graph title and data
labels, as shown in the following figure.

File Edit nodes Tools Tent

26. Save the graph and name it GRAPH.

27. Exit the Picture Maker screen by selecting Main Menu
on the File menu. The Picture Maker Main Menu
appears.

28. Press the Esc key. A message reminds you that you
are about to exit Picture Maker.

29. Type Y to return to the Quick Menu/Setup screen.
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— Notes for Keyboard Users

• Press the 4 key to display the Tools menu.

• Use the Tab and Shift-Tab keys to move the ^
pointer in the Graph panel. ' ^

• Press Y or N to select YES or NO on the Graph
panel.

• Press F3 to move the pointer to the icon area.

• Press the 1 key to move the pointer to the File
menu.

This concludes the Picture Maker tutorial. The rest of

this chapter contains reference information and
instructions for using each of the Picture Maker features.
You can use the pictures you created here in the Story
Editor tutorial, "Learning Story Editor" on page 5-14.
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Picture Makeff

Selecting a Line Style
Picture Maker provides five line styles for drawing rectan
gles, circles, and lines. These styles are displayed to the
left of the drawing area above the active pattern box.
The three solid line styles are also available when using
the Graph feature described later in this chapter.

The current, or active, line style is indicated by an arrow.
To change the active line style, select a different style.
The arrow moves to the style you select.

Note: Only the thinnest solid line style is available
with the Pencil icon. If this icon is selected, you
cannot change the active line style.

Notes for Keyboard Users

Press F5 to move the pointer to the Line Styles
area.

Use the Tab key or Cursor Up and Down keys to
move the pointer to a new selection.

Use the Enter key or the Plus key on the numeric
keypad in place of Button 1.
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Drawing Rectangles and Squares
You can draw rectangles using the Rectangle icon to the
left of the drawing area. By first selecting the Constrain
option on the Modes menu, you can limit the Rectangle
feature to drawing squares.

Note: The Fill Shape option on the Modes menu
lets you draw rectangles and squares that are filled
in with the active pattern. With the Hollow Shape
option active, you draw just the outline of a rec
tangle or square. Patterns are discussed later in
this chapter.

To draw a rectangle or square:

1. Select the Rectangle icon.

2. Move the pointer into the drawing area where you
want one corner of the rectangle (or square) to be
located (the pointer now appears as a crosshair).

3. Press Button 1 to anchor one comer of the rectangle.

4. Move the pointer in any direction to stretch the rec
tangle to the desired size and shape. As you move the
pointer, a rectangle appears in the active line style.

5. Press Button 2 to set the rectangle (or press Button 1
to cancel).

6. Move the pointer to draw another rectangle connected
to the one you just drew, or press Button 1 to stop
drawing rectangles.

2-64



— Notes for Keyboard Users

• Press F3 to move the pointer to the icon area.

• Use the Tab key or the Cursor Up and Down keys
to move the pointer to a new selection.

• Use the Plus and Minus keys on the numeric
keypad in place of Buttons 1 and 2, respectively.

• Use the following keys for pointer movement in
the drawing area:

Key
Cursor Keys
Home

End

PgUp
PgDn
Shift-Cursor Key

Shift-Diagonal Key

Direction

Right, left, up, and down
Diagonally up and left
Diagonally down and left
Diagonally up and right
Diagonally down and right
One pixel in direction of
arrow

One pixel in direction of
diagonal movement

If using the Constrain feature to draw squares, use
the diagonal cursor keys (Home, End, PgUp and
PgDn) to stretch the square.

Drawing Circles and Ellipses
The Circle icon lets you draw circles and ellipses. By first
selecting the Constrain option on the Modes menu, you
can limit this feature to drawing circles.

Note: The Fill Shape option on the Modes menu
lets you draw circles and ellipses that are filled in
with the active pattern. With the Hollow Shape
option active, you draw just the outline of a circle
or ellipse. Patterns are discussed later in this
chapter.
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To draw an ellipse or circle:

1. Select the Circle icon.

2. Move the pointer into the drawing area where you
want the center of the ellipse (or circle) to be located.
The pointer now appears as a crosshair.

3. Press Button 1 to anchor the center of the ellipse.

4. Move the pointer in any direction to stretch the ellipse
to the desired size and shape. As you move the
pointer, an ellipse appears in the active line style.

5. Press Button 2 to set the ellipse (or press Button 1 to
cancel).

6. Move the pointer to draw another ellipse with the
same center as the one you just drew, or press Button
1 to stop drawing ellipses.

Notes for Keyboard Users —

Press F3 to move the pointer to the icon area.

Use the Tab key or the Cursor Up and Down keys
to move the pointer to a new selection.

Use the Plus and Minus keys on the numeric
keypad in place of Buttons 1 and 2, respectively.

If using the Constrain feature to draw circles, use
the diagonal cursor keys (Home, End, PgUp and
PgDn) to stretch the circle.

See "Notes for Keyboard Users" in the "Drawing
Rectangles and Squares" section for information
about moving the pointer in the drawing area.



Drawing Lines
You can draw single, straight lines or connected line seg
ments using the Line icon. Selecting Constrain on the

— Modes menu lets you draw lines at angles which are mul-
tiples of 45 degrees.

Hint: When drawing equally spaced, parallel lines, select
the Grid option on the Modes menu before using the Line
icon. This option is discussed later in this chapter.

To draw lines:

1. Select the Line icon.

2. Move the pointer into the drawing area where you
want one end of the line to be located.

3. Press Button 1 to anchor the end of the line.

4. Move the pointer in any direction to stretch the line to
the desired length.

5. Press Button 2 to set the line (or press Button 1 to
cancel).

6. Move the pointer to draw another line connected to
the one you just drew, or press Button 1 to stop
drawing lines.

— Notes for Keyboard Users

• Press F3 to move the pointer to the icon area.

• Use the Cursor keys to move the pointer to a new
selection.

• Use the Plus and Minus keys on the numeric
keypad in place of Buttons 1 and 2, respectively.

• See "Notes for Keyboard Users" in the "Drawing
Rectangles and Squares" section for information
about moving the pointer in the drawing area.
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Freehand Line Drawing Using the Pencil icon
The Pencil icon lets you draw freehand lines. Only the
thinnest solid line style is available when using this
feature. No matter what the active line style, selecting the ^
Pencil icon changes the active line style to the thinnest
solid line. Selecting a different icon switches the line style
back to the previously active style.

To use the Pencil icon:

1. Select the Pencil icon.

2. Move the pointer into the drawing area where you
want to start drawing.

3. Press Button 1 to start drawing.

4. Move the pointer to draw.

5. Press Button 1 again to stop drawing. Press Button 2
to erase any lines you just drew (press Button 2 again
to stop erasing).
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Notes for Keyboard Users

• Press F3 to move the pointer to the icon area.

Use the Cursor keys to move the pointer to a new
selection.

Use the Plus and Minus keys on the numeric
keypad in place of Buttons 1 and 2, respectively.

See "Notes for Keyboard Users" in the "Drawing
Rectangles and Squares" section for information
about moving the pointer in the drawing area.



Using the Eraser
The Eraser icon lets you erase any part of the picture.
Areas you erase are replaced with the current background
color. To use this feature:

1. Select the Eraser icon.

2. Move the pointer into the drawing area where you
want to start erasing. Note that the pointer becomes
a solid block.

3. Press Button 1 to start erasing.

4. Move the pointer over areas you want to erase. To
restore areas you have erased, press Button 2 and
move the pointer over the areas you want to restore.
(As soon as you select another icon or option, you
cannot restore what you have erased.)

5. Press Button 1 again to stop erasing, or Button 2 to
stop restoring erased areas.

Notes for Keyboard Users

Press F3 to move the pointer to the icon area.

Use the Cursor keys to move the pointer to a new
selection.

Use the Plus and Minus keys on the numeric
keypad in place of Buttons 1 and 2, respectively.

See "Notes for Keyboard Users" in the "Drawing
Rectangles and Squares" section for information
about moving the pointer in the drawing area.
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Using Shadows
You can draw rectangles, circles, and lines so they appear
with shadows. Use the Set Shadow option on the Tools
menu to activate shadows and set their color, direction,
and depth.

Shadows also are used with options that involve a select
box, such as Move and Copy. Shadows cannot be used
with rectangles, circles, or lines when the active line style
is a dashed line.

To use shadows:

1. Select Set Shadow from the Tools menu. You see the

following panel:

r

♦ Tj
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m

I File Edit Hodes Tools Tewt

Shadou

Color

Figure 2-5. The Set Shadow Panel

The right side of this panel displays the current
shadow color. The left side is used to set the direction
and depth of the shadow you want to use.
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2. To change the shadow color, select a new color from
the palette area. The new shadow color appears in the
Shadow Color box.

Note: If you are using the 320 x 200 —256 or 640
X480 - 256 resolution mode, you can move the
pointer to the palette area and press Button 2 to
display the extended palette. The extended palette
is discussed later in this chapter.

3. Set the shadow direction and depth by selecting one of
the four arrows on the left side of the Set Shadow
panel. A shadow appears on the side of the square
opposite the direction you selected. Selecting a direc
tion repeatedly lengthens the shadow. Select a second
direction adjacent to the first if you want to create a
slanting shadow.

4. Exit the Set Shadow panel by pressing Button 2 (make
sure the pointer is outside of the palette area before
doing so).

To deactivate shadows, select the Tools menu again.
Then, move the pointer to the Set Shadow option and
press Button 2. The arrow next to the option disappears.

Notes for Keyboard Users

• Press the 4 key to move the pointer to the Tools
menu.

• Use the Cursor keys to move the pointer to a new
selection.

• Use the Plus and Minus keys on the numeric
keypad in place of Buttons 1 and 2, respectively.
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Controlling Alignment in Your Pictures

Aligning to a Grid

You can align text and pictures to an invisible grid by
using the Grid option on the Modes menu before you
start drawing. This option restricts pointer movement so
that drawing begins and ends on the invisible grid. With
the Grid option active, you cannot access pixels that are
not on the grid.

To use the Grid option, select Grid from the Modes menu.
Select Grid again to cancel the option (use Button 2 to
cancel the option and keep the Modes menu displayed).

Using a Crosshair

With the Crosshair option on the Modes menu, you can
display a screen-sized crosshair while creating rectangles,
circles, lines, and text. The crosshair helps you align
objects as you draw them.

The Crosshair option can be used with other options that
involve a select box. Using a select box is discussed later
in this chapter.

To use the Crosshair option, select Crosshair from the
Modes menu. Select Crosshair again to cancel the option
(use Button 2 to cancel the option and keep the Modes
menu displayed).

Displaying Screen Coordinates

Another way you can control alignment is by contin
uously displaying the screen coordinates of the pointer
position. You can do this by selecting the X,Y Coordi
nates option on the Modes menu.
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The coordinates, which are displayed in the Line Styles
area, show two representations of the pointer's position in
the drawing area:

• By pixel location, with 0 on the X axis at the left
edge, and 0 on the Y axis at the top of the full-screen
drawing area

• As a percentage of the drawing area's width from left
to right (the X axis), and as a percentage of the
drawing area's height from top to bottom (the Y axis)

To switch off the display of screen coordinates, select X,Y
Coordinates again on the Modes menu.

Using a Ruler

Picture Maker also lets you display a ruler at the top and
left side of the drawing area while you create and edit pic
tures. When used with the Crosshair option on the
Modes menu, the ruler lets you measure and align ele-
ments of your pictures.

To use this feature, select Ruler on the Tools menu. To
remove the ruler, select Ruler again.

Creating Pictures for Composite Video

If you create pictures in the 320 x 200 —4 resolution mode
that you want to record on videotape or display on a
video monitor, video projector, or television screen, you
should first select Composite Video on the Modes menu.

Selecting this option ensures that images you create are
aligned to even pixel boundaries, as required by composite
video display technology.
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For more information about attaching composite video
and RGB monitors to the Color/Graphics Adapter in
your system unit, refer to the Guide to Operations for your
system.

— Notes for Keyboard Users

2-74

The Grid and Composite Video options are not
available when you use the keyboard as your input
device.

Press the 3 key to move the pointer to the Modes
menu.

Press the 4 key to move the pointer to the Tools
menu.

Use the Cursor keys to move the pointer to a new
selection.

Use the Plus and Minus keys on the numeric
keypad in place of Buttons 1 and 2, respectively.



UsSng Teict I01 Y@yr Pictures

The Text Icon

The Text icon lets you type text in your pictures. To use
this feature:

1. Select the Text icon.

2. Move the pointer to the position in the drawing area
where you want to start typing text. The pointer
becomes a small crosshair.

3. Press Button 1. A cursor appears, indicating you can
start typing text. Text that you type appears in the
active drawing color indicated in the lower left corner
of the screen.

When typing numbers, use the number keys on the
main portion of the keyboard. The numbers on the
Numeric Keypad are not active while you are using
the Text icon or the Text menu.

4. Press Button 2 or the Esc key when you are finished
typing text (pressing Button 1 or F2 displays the Set
Attributes panel, which is described in the next
section).

Once you have pressed Button 2 or Esc, the text is set as
part of the picture, just as a line or rectangle you draw
would be set. However, before you press Button 2 or Esc,
you can use the following keys to edit the text:

Key Action

Enter Moves the cursor to the beginning of the
next line.

Backspace Moves the cursor to the left, erasing any
characters you have typed.

Cursor keys Move the cursor up, down, right, and
left.
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Insert Changes the cursor to a block, indi
cating you can insert characters. Press
Insert again to switch off insert mode.

Delete Deletes the character at the cursor posi-
tion, moving any characters to the right
of the cursor left one space.

Shift-Insert Inserts a blank line before the line where
the cursor is located.

Shift-Delete Deletes the line where the cursor is
located.

Home Moves the cursor to the position where
you pressed Button 1 to start typing
text.

F2 Displays the Set Attributes panel
(described in the next section).

FIO When using shadows with text, lets you
see how text will appear after you are
finished.

Esc Indicates you are finished typing text,
and that you want to keep the text.

Shift-Esc Lets you quit typing text and erases
what you just typed.
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— Notes for Keyboard Users

• Press F3 to move the pointer to the icon area.

• Use the Cursor keys to move the pointer to a new
selection.

• Use the Plus and Minus keys on the numeric
keypad in place of Buttons 1 and 2, respectively.



Setting Text Attributes
You can determine the font, size, justification, and other
aspects of text using the Set Attributes panel. You can
access this panel two ways:

• By selecting Set Attributes from the Text menu

• By pressing Button 1 or F2 while typing text.

After you take one of these actions, you see the Set Attri
butes panel:

File Edit tlodes Tools Text (C) IBM IBBS

Change Font Enter Text

Set Spacing
Change Position

Fix Spacing

Pruportioridl

Lett Jii.iititiH.j

Right Justified

Centered

Underline
Italic
Outline Double Horiz
Shadou Double Uerti

Figure 2-6. The Set Attributes Panel

The large box on the right side of this panel shows you a
sample text character with the attributes that are currently
active. The name of the currently active font appears
above the box containing the sample text character. The
other boxes on this panel are described in the following
sections.

Note: If the current drawing color and back
ground color are the same, the sample character
does not show on the Set Attributes panel. To
display the sample character, select a different
drawing color.
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Changing Font

You can change the font of your text by following these
steps:

1. Select Change Font in the Set Attributes panel. You
see the File Services panel. The font files in the
current directory are listed in the lower right box of
this panel. The active font is highlighted.

2. To select a font from a different directory or drive,
select the directory or drive from those listed in the
Drive and Directory boxes.

3. Select the name of the font file you want to get from
those listed in the Filename box. Or, select Type in
the Filename box to enter the name of a file.

Note: If you are running Picture Maker from
5.25-inch diskettes, remember that all font files
except ROMAN.FAG are located on Diskette 3.
The ROMAN.FAC file is located on Diskette 2.

Before changing fonts, you must insert the correct
diskette in a drive, and then select that drive on
the File Services panel.

4. If you selected the name of a file, select YES to get it
(or NO to cancel). If you selected Type, type the
name of the file and press Enter. The Set Attributes
panel appears with a sample of the font you just
selected.

Selecting Font Size

Fonts have five sizes from which you can choose (except
for the Label font, which has three). You can change
font size using the box under the sample text character.

Repeatedly selecting the Size box cycles through all of the
sizes available for a font. The sample text character
changes each time to reflect the new size.
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Doubling the Height and Width of a Font

You also can alter the size of a font using the Double
Horiz and Double Verti boxes in the lower right portion
of the Set Attributes panel.

Selecting Double Horiz widens characters as shown by the
sample text character. Selecting Double Verti makes char
acters taller. These options can be used individually or
together. To deactivate an option, select it again.

Spacing Text

You can choose between proportional and fixed spacing
for text by selecting Proportional or Fix Spacing on the
Set Attributes panel.

When using either of these options, you can determine the
amount of space between characters using the Set Spacing
option on the Set Attributes panel. Selecting this option
displays the following panel:

File Edit nodes Tools Tent

CheDflfi-EflDi Enter Text

Set Spacing

* e Horizontal

t e Uertical

Outline Double Horiz.
Shadou Double verti.

Figure 2-7. The Set Spacing Panel
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The spacing value displayed can range from -10 to + 30.
Select the arrow pointing up or down to increase or
decrease vertical spacing; select the arrow pointing right
or left to increase or decrease horizontal spacing.

When you are finished with this panel, press Button 2 to
return to the Set Attributes panel.

Justifying Text

Select from three options on the Set Attributes panel to
determine how your text is justified: Left Justified, Right
Justified, or Centered.

As you type text that is left justified, the cursor moves to
the right. When you press Enter, the cursor moves to the
next text line below the first character you typed.

As you type text that is right-justified, the cursor remains
stationary and text moves to the left. When you press
Enter, the cursor moves to the next text line below the last
character you typed.

As you type centered text, the cursor moves to the right
and text moves to the left. When you press Enter, the
cursor moves to the next text line below the center of the
preceding text line.

Choosing Type Styles

You can choose combinations of type styles by selecting
from the Bold, Underline, Italic, Outline, and Shadow
options on the Set Attributes menu. As you select these
options, the sample text character changes.

Combinations of these styles are valid with one exception:
text can be bold or outlined, but not both. If you select
both options, outlining takes precedence.

2-80



You can change the outline color by moving the pointer
to the Outline option and pressing Button 2. A box
appears showing you the active outline color. When you
select a different color from the palette area, the color
appears in the outline color box. Press Button 2 to return
to the Set Attributes panel.

You also can determine the color, direction, and depth of
shadow by moving the pointer to the Shadow option and
pressing Button 2. The Set Shadow panel appears. For
information about using the Set Shadow panel, refer to
"Using Shadows" on page 2-70.

Notes:

1. You can choose to underline spaces and text by
moving the pointer to Underline and pressing
Button 2. A box appears where you choose
whether to underline spaces or not. After
making your choice, press Button 2 to return to
the Set Attributes panel. Note that spaces are
not underlined until you have typed the next
character following the spaces.

2. If using 320 x 200 - 256 or 640 x 480 - 256
resolution mode, you can move the pointer to
the palette area and press Button 2 to display
the extended palette. Using the extended
palette is discussed later in this chapter.

Changing the Position of Text

While typing text, you may decide that you want to repo
sition it in the drawing area. You can reposition text
using the Change Position option on the Set Attributes
panel, provided you have not pressed Button 2 to set the
text. (If you have set the text, reposition it using the
Rewrite Last Text feature described in the next section.)
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To reposition text while typing:

1. Press Button 1 to display the Set Attributes panel.

2. Select Change Position. You return to the drawing
area. A large flashing crosshair marks the current text
position. As you move the mouse, a second crosshair
appears. You use the second crosshair to select the
new position of the text.

3. Position the crosshair where you want the text to be
located.

4. Press Button 1. The text moves to the new position.

5. If you are not satisfied with the new position, press
Button 1 again to reposition the crosshair cursor. To
stop repositioning, press Button 2. The text cursor
reappears where you left off typing.

2-82

— Notes for Keyboard Users

• Press the 5 key to move the pointer to the Text
menu.

• Use the Cursor keys to move the pointer to a new
selection.

• Use the Plus and Minus keys on the numeric
keypad in place of Buttons 1 and 2, respectively.

• Use the Tab and Shift-Tab keys to move the
pointer in the Set Attributes and File Services
panels.

• Press Y or N to select YES or NO on the Set Attri

butes and File Services panels.

• Use the Cursor keys to move the pointer and set
spacing in the Set Spacing box.



Rewriting the Last Text You Entered
The Rewrite Last Text option on the Text menu lets you
display a copy of the last text you entered, reposition this
copy, and edit the text. The original text remains on the
screen. (Use the Eraser icon or Clear option to remove
unwanted text.)

After you select Rewrite Last Text, a copy of the last text
you entered is displayed in the drawing area with a large
crosshair. If you changed the size of the text prior to
selecting Rewrite Last Text, all of the text may not be dis
played.

Reposition the text by moving the crosshair to a new
location and pressing Button 1. Once you are satisfied
with the new position, press Button 2. The text cursor
appears at the beginning of the text, enabling you to edit
it. Press Button 2 again when you have finished editing

^ the text.

Notes for Keyboard Users

Press the 5 key to move the pointer to the Text
menu.

Use the Cursor keys to move the pointer to a new
selection.

Use the Plus and Minus keys on the numeric
keypad in place of Buttons 1 and 2, respectively.

Saving and Retrieving Text and Attributes
Picture Maker lets you store attributes with text that you
use in your pictures. You also can retrieve text attributes
in preparation for entering new text. This abihty allows
you to set up combinations of attributes that you use fre
quently so you can maintain consistency among the titles,
captions, and other text in your pictures.
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Saving Text and Attributes

You can save the text you typed since you last entered
text and pressed Button 2 by following these steps:

1. Select Save Text & Attr. on the Text menu. The File
Services panel appears.

The box at the top of this panel shows the currently
selected drive and directory. The left side of the
middle box is where you decide which files will be
listed in the Filename box in the lower right portion
of the panel. When saving text, .TXT files is high
lighted in the middle portion of the panel, which
means only files with the extension TXT are listed in
the Filename box. To list all files in the current direc

tory, select All files.

The bottom portion of the panel is where you select
the drive, directory, and filename in which to save
text. In each of the Drive, Directory, and Filename
boxes, arrows pointing up and down on the right side
of the box enable you to scroll through the list when
there are more entries than those displayed.

2. Select a filename from the Filename box if you want
to replace a previously saved text file. Select New if
you want to create a new text file.

3. If you selected a filename, select YES to save the text
(or NO to cancel).

If you selected New, the word New disappears and the
line becomes highlighted with a blinking cursor, indi
cating you can enter a filename. Enter a name of up
to eight numbers and letters (follow DOS file naming
conventions).

To change the TXT file extension appended to the
filename you enter, press the Period (.) key after
typing the filename. The cursor moves to the exten
sion field where you can enter a different extension for
the file.
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4. If you are saving text with an existing filename, a
message informs you that saving the file will overwrite
the file on disk with the same name. Select YES to

continue (or NO to cancel).

Retrieving Text and Attributes

The Text menu also gives you the option of retrieving text
and attributes. You can retrieve just the text in a file and
use the currently selected attributes, or you can retrieve
just the attributes used in a text file. You also can select
both text and attributes. When you get the attributes of a
text file (with or without the text), the Set Attributes
panel is updated to reflect the new attributes.

The ability to save and retrieve text attributes lets you
easily establish and maintain consistent text styles among
your pictures.

To use these options:

1. Select Get Text, Get Attributes, or Get Text & Attr.
from the Text menu. The File Services panel is dis
played. The text files in the current drive and direc
tory are listed in the Filename box.

2. To get a file from a different directory or drive, select
the directory or drive from those listed in the Drive
and Directory boxes.

3. Select the name of the text file you want to get from
those listed in the Filename box. Or, select Type in
the Filename box to enter the name of a file.

4. If you selected the name of a file, select YES to get it
(or NO to cancel). If you selected Type, type the
name of the file and press Enter.

If you selected Get Text, just the text from the file is
displayed in the drawing area with a large crosshair
cursor. If you selected Get Attributes, the last text
you entered appears with the attributes of the selected
file (if you have not entered any text in the current
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Picture Maker session, the attributes are set according
to the selected text file, but no text appears in the
drawing area).

If you selected Get Text & Attr., the text and attri-
butes of the selected file are displayed with a large
crosshair cursor.

The amount of text displayed can be increased or
decreased by selecting different font sizes and styles.

5. Reposition the text by moving the crosshair cursor to
a new location and pressing Button 1.

6. Once you are satisfied with the new position, press
Button 2. The text cursor appears at the beginning of
the text, enabling you to edit it.

7. Press Button 2 when you have finished editing the text.

Notes for Keyboard Users

Press the 5 key to move the pointer to the Text
menu.

Use the Cursor keys to move the pointer to a new
selection.

Use the Plus and Minus keys on the numeric
keypad in place of Buttons 1 and 2, respectively.

Use the Tab and Shift-Tab keys to move the
pointer in the File Services panel.

Press Y or N to select YES or NO on the File Ser

vices panel.



Limits on Text Entry
Storyboard Plus accepts 25 lines of 80 characters per line
during a single text entry session. The size and style of
the font you select determines how much of the text is dis
played on the screen.

For example, if you select the font THINIO, Size 2, Pro
portional, and the Full Screen option on the Tools menu,
you can type and see all 25 lines of 80 characters. If you
increased the size to 4, all of the characters would still be
in memory, but not all of them would be displayed on the
screen.

Editing and Creating Fonts
The Font Editor selection on the Text menu lets you edit
existing Picture Maker fonts and create new ones.

Editing Fonts

To edit an existing Picture Maker font:

1. Select Font Editor from the Text menu. The following
Font Editor panel is displayed:

Figure 2-8. The Font Editor Panel
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2. Select Get Font. The Get Font panel is displayed.

3. Select the size of the font you want to edit.

4. Select Keep the original size or Scale to current size.
The first option retains the original size of the font as
defined when the font was created. The second option
scales the font to the current size of the editing area of
the Font Editor panel.

Note: Depending on the current size of the
editing area and the original size of the font,
scaling the font may degrade the appearance of
characters.

5. Select YES on the Get Font panel to continue (or NO
to cancel editing a font). The File Services panel
appears.

The box at the top of the File Services panel shows
the currently selected drive and directory. The left
side of the middle box is where you decide which files
will be listed in the Filename box in the lower right
portion of the panel. When getting fonts, .FAC files
is highlighted in the middle portion of the panel,
which means only files with the extension FAC are
listed in the Filename box. To list all files in the

current directory, select All files.

The bottom portion of the panel is where you select
the drive, directory, and filename of the font to get.
In each of the Drive, Directory, and Filename boxes,
arrows pointing up and down on the right side of the
box enable you to scroll through the list when there
are more entries than those displayed.

6. Select a font file from the Filename box, or select Type
to type the name of a font file.



7. If you selected a filename, select YES to get the font
(or NO to cancel). If you selected Type, press Enter
to get the font whose filename you typed.

The font file is read into Picture Maker and is ready
for editing.

There are three ways of selecting the characters you want
to edit:

• Use the left and right arrows above the edit options to
display the character you want to edit.

• Enter the ASCII code of the character you want to
edit. To enter an ASCII code, hold down the Alt key
and then type the code number on the numeric
keypad. For example, press and hold the Alt key and
then type 65 for the "A" character (then release the
Alt key).

• Enter the character by pressing the actual key. For
example, if you want to edit the lower case "a," press
the "a" key. To edit the upper case "A," press
Shift-A.

The current character appears in the editing area. Use the
following edit options to change the current character.

Pencil: The Pencil option lets you change characters with
pixel precision. After selecting this option, move the
pointer to the editing area. Press Button 1 to start
changing pixels. Move the pointer over the pixels you
want to change. Press Button 1 again to stop changing
pixels.

To restore pixels to their original color, press Button 2
rTi and move the pointer over the pixels you want to restore.

Press Button 2 again when you have finished restoring
pixels.
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Brush: The Brush option works similarly to the Pencil
option, except that you change an area two pixels square
as you move the pointer.

Cut: Select Cut to cut the design of one character and
copy it to another character using the Paste option. After
selecting Cut, move the pointer into the editing area and
press Button 1. The character is stored in memory for
later use with Paste.

Paste: Select Paste to recall the last character you stored
in memory using the Cut option. After you select Paste,
move the pointer into the editing area and press Button 1.
The cut character is pasted in the editing area.

Move the pointer to position the cut character, and then
press Button 1 to set the character in place.

Note: You also can edit a character from the

main Picture Maker screen, then cut the character
and paste it using the Font Editor panel. The
character always is pasted in the same position in
the character box, unless that position has been
changed in the main drawing mode.

Define Baseline: Select Define Baseline to set the

baseline for the character you are editing. The baseline is
the vertical distance between the bottom of a character

and the line on which it is written.

After selecting this option, move the pointer to the line in
the editing area where you want the baseline to be
located. Press Button 1.

UNDO: Selecting UNDO lets you undo all changes you
made since you last selected an editing option.
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Creating a Font

Select Start New Font to create your own font.

After selecting this option from the Font Editor panel, a
box appears in the editing area where you can set the size
of the new font. Select from the four arrows to increase

or decrease the height and width of the new font. A box
on the Font Editor panel changes as you select these
arrows. The minimum font size is five by five pixels. The
maximum size is 48 by 50 pixels.

Once you have adjusted the size of the font, select YES to
start creating the font.

To create each character in a font, you first assign the
character to a keystroke. There are three ways to assign a
character to a keystroke:

• Use the left and right arrows above the edit options to
display the keystroke of the character you want to
create.

• Enter the ASCII code of the character you want to
create. To enter an ASCII code, hold down the Alt
key and then t5^e the code number on the numeric
keypad. For example, press and hold the Alt key and
then type 65 for the "A" character (then release the
Alt key).

• Press the actual key you want to assign to a character.
For example, if you want to create the lower case "a,"
press the A key. To create the upper case "A,"
press Shift-A.

Use the edit options on the Font Editor panel to create
— each character in the new font.
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Saving a Font

The Save Font option on the Font Editor panel lets you
save a font you have edited or created. To use this option:

1. Select Save Font from the Font Editor panel. A box
appears in the editing area where you select the size of
the font.

2. Select the size you want to save. You can save up to
five font sizes in one font file.

3. Select YES to save the font (or NO to cancel). The
File Services panel is displayed.

4. Select a filename from the Filename box if you want
to replace a previously saved font size or add a new
size to the file. Select New if you want to create a new
font file.

5. If you selected a filename, select YES to save the font
(or NO to cancel).

If you selected New, the word New disappears and the
line becomes highlighted with a blinking cursor, indi
cating you can enter a filename. Tj^e a name of up
to eight numbers and letters and press Enter (follow
DOS file naming conventions).

To change the FAC file extension automatically
appended to the filename you enter, press the Period
(.) key after typing the filename. The cursor moves to
the extension field where you can enter an extension
for the file.

6. If you are saving a font with an existing filename, a
message informs you that saving the file will overwrite
the file on disk with the same name. Select YES to

continue (or NO to cancel).
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Exiting the Font Editor

To exit the Font Editor and return to the Picture Maker

screen, select Exit Font Editor on the Font Editor panel.

Notes for Keyboard Users

• Press the 5 key to move the pointer to the Text
menu.

• Use the Cursor keys to move the pointer to a new
selection.

• Use the Plus and Minus keys on the numeric
keypad in place of Buttons 1 and 2, respectively.

• Use the Spacebar to move the pointer between the
editing area and the right portion of the Font
Editor panel.

• Use the Tab and Shift-Tab keys to move the
pointer in the File Services panel.

• Press Y or N to select YES or NO on the File Ser

vices panel.
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Picture Maker automatically draws bar, pie, and line
graphs you can use in your pictures. To use this feature,
select Graph from the Tools menu. You see the Graph
panel:

Figure 2-9. The Graph Panel

Graph paraHeters

190[Graph value
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Entering Graph Data
You can enter up to 36 data values for a graph using the
data area of the Graph panel. To start entering data,
select the first line of the data area. The line is high
lighted, and a blinking cursor appears.

Type the first data value and press Enter. The next line
becomes highlighted, indicating that you can enter the
next data value. Keep entering values in this manner.
When you finish, press Button 1 or the Esc key.
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While entering values, you can use the following keys.

Key

Backspace

Cursor keys

Insert

Delete

PgDn

PgUp

Tab

Action

Moves the cursor to the left, erasing any
characters you have typed.

Move the cursor up, down, right, and left.

Changes the cursor to a block, indicating
you can insert characters. Press Insert
again to exit insert mode.

Deletes the character at the cursor posi
tion, moving any characters to the right of
the cursor left one space.

Displays lines for the next 12 graph values.

Displays lines for the previous 12 graph
values.

Lets you type information in the graph
parameter fields.

You can enter negative values for a graph. With pie
graphs, a negative value results in the pie slice being
moved away, or exploded, from the center of the pie.

Selecting a Graph Type
Select from the four types of graphs listed on the Graph
panel. The default graph type is vertical bar (VBAR).
You also can select horizontal bar (HEAR), pie, or line.
You can switch among these selections and draw different
types of graphs using the same data.
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Setting Graph Parameters
You can determine how graphs are displayed by selecting
the following graph parameters on the Graph panel.
While typing in these fields, you can press the Tab key to
enter information in the data area of the Graph panel.

Graph Value

For bar graphs, the graph value determines how much
space exists between bars. The default value of 100
results in no space between bars. If you enter a value
greater than 100 or less than -100, bars overlap.

Grapli Valae =100 Graph Value =50

Figure 2-10. The Effects of Graph Value on Bar Graphs

For pie graphs, the graph value determines the distance
that exploded slices (those with negative data values) are
removed from the pie center.
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Distance is a percentage of radius length. A negative
graph value results in exploded slices not being shown.

Graph Value: SO Graph Value =-50

Figure 2-11. The Effects of Graph Value on Pie Graphs

For line graphs, the graph value determines the width of
the line in pixels. Values can range from 1 to 10 (a value
of 0 results in no line).

Graph Value =5 Graph Value =1

Figure 2-12. The Effects of Graph Value on Line Graphs
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Scale Interval

Use this parameter to control the appearance of axes and
tics in bar and line graphs (this parameter is not appli
cable to pie graphs). No value in this field results in the
graph being drawn without axes and tics.

Positive values result in tics being placed on the scale axis
at the specified interval (the scale axis is the vertical axis
in vertical bar and line graphs, and the horizontal axis in
horizontal bar graphs).

A zero value results in no tics being drawn on the scale
axis.

Negative values cause grid lines to be drawn across the
graph extending from the tics.

Scale Internal=-10 Scale Interval=10

Figure 2-13. The Effects of Scale Interval Values on Bar Graphs
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Low Mark

This parameter lets you specify the lowest tic value in a
bar or line graph (this parameter is not applicable to pie
graphs). No value in this field results in the minimum
data value or 0 being used, whichever is less.

When the low mark value is zero or negative, data values
less than the low mark value default to the low mark

value when the graph is drawn.

High Mark

This parameter lets you specify the highest tic value in a
bar or line graph (this parameter is not applicable to pie
graphs). When you leave this field blank, the high mark
is determined by the scale interval and the highest data
value.

Data values greater than the high mark value default to
the high mark value when the graph is drawn.

Choosing How Graphs are Colored and Shadowed
You can choose to have Picture Maker select the colors

for your bar or pie graph, or you can select the colors
yourself. To let Picture Maker choose the colors, select
Multiple color fill at the bottom of the Graph panel.
Picture Maker selects a different color for each bar or pie
slice.

To use one color or pattern you select for all bars and pie
slices, select One color fill at the bottom of the Graph
panel. To fill bars and pie slices with a pattern, select a
pattern from the right side of the Picture Maker screen.
To fill with a drawing color, select a color from the
palette area, then select the active pattern box to make the
drawing color the active pattern. (Selecting a drawing
color also changes the outline color used in the graph.)
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Alternatively, you can fill bars and pie slices with different
colors or patterns of your choice by selecting One color
fill and selecting white as the active pattern. After
drawing the graph, use the Fill icon to fill each bar or pie
slice with a pattern or color of your choice.

The axes, tics, bars, lines, and pie slices in graphs can be
drawn with shadows. To set shadow direction, depth,
and color, move the pointer over the four boxes in the
lower left comer of the Graph panel and press Button 1.
The Set Shadow panel appears. For information about
using this panel, see "Using Shadows" on page 2-70.

After you use the Set Shadow panel, the four boxes in the
lower left corner of the Graph panel are shown with the
shadow settings you selected. To deactivate the use of
shadows with graphs, move the pointer over these boxes
and press Button 2. To switch shadows back on without
changing settings on the Set Shadow panel, move the
pointer to the four boxes and press Button 2 again.

Selecting a Line Style
For bar, pie, and line graphs, you can select from the
three solid line styles in the line styles area for use in your
graph.

Drawing the Graph
When you are ready to draw your graph, select YES on
the Graph panel. The panel is removed, and the graph
(minus color and shadows) appears in the upper left
corner of the drawing area in a select box. If there
already was a select box in the drawing area, the graph
appears in the existing select box.

You can move and scale the graph as described in the
next section. To set the graph, press Button 1 while the
pointer is outside of the select box.
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Once you set the graph, the graph is drawn with the
colors and shadowing you selected on the Graph panel.
Press Button 1 again to remove the select box.

Note: Refer to "Editing Pictures" on page 2-121
for information about the Transparent and
Opaque options, which affect the way graphs
overlay areas of your pictures.

Moving and Scaling the Graph
After you select YES on the Graph panel, the graph
appears in a select box in the drawing area. To place the
graph in your picture, move the pointer inside the select
box and press Button 1. Move the graph to its new
location and press Button 1 again.

Scale the graph by moving the pointer inside the select
box and pressing Button 2. Move the mouse to scale the
select box, and then press Button 2 again.

Note: Select Constrain on the Modes menu to

scale the graph proportionally in all directions.

After moving or scaling the graph, move the pointer
outside of the select box and press Button 1 to set the
graph in your picture. If you have scaled the graph to the
full size of the screen, press FIO to set the graph. Once
you set the graph, the graph is drawn with the colors and
shadowing you selected on the Graph panel. Press Button
1 (or FIO) again to remove the select box.

Another way to place and scale a graph is to draw a select
box in the shape, size, and position you want the graph to
appear before you define the graph. When you draw the
graph, it is automatically placed and scaled according to
the select box you drew. For more information about
drawing select boxes, see "Selecting Areas of the Picture"
on page 2-121.
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Labeling Graphs
You can use titles, legends, and data labels with graphs
using the Text icon and Set Attributes panel described in
"Using Text In Your Pictures" on page 2-75. Refer to
this section for information about entering and posi-
tioning the text for your graphs.

— Notes for Keyboard Users
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Press the 4 key to move the pointer to the Tools
menu.

Use the Cursor keys to move the pointer to a new
selection.

Use the Plus and Minus keys on the numeric
keypad in place of Buttons 1 and 2, respectively.

Use the Tab and Shift-Tab keys to move the
pointer in the Graph panel.

Use the following keys to move the pointer to
other parts of the Picture Maker screen while using
the Graph panel:

F4 palette area
F5 line styles area
F6 pattern area
F9 active pattern box

Press Y or N to select YES or NO on the Graph
panel.



Working with Colors and Patterns

Picture Maker employs two color-related concepts:
drawing color and pattern. Drawing colors are used for
rectangles, circles, lines (using the Line or Pencil icon),
text, and graphs (for lines and bar/slice outlines).
Drawing colors also are used for shadows, background
color, text outline color, and the Transparent and Opaque
options.

Patterns are used when you spray, paint, or fill (with the
Fill icon and using the Fill Shape option). As discussed
later in this chapter, you also can spray, paint, and fill
with drawing colors.

Using Drawing Colors
The number of drawing colors available depends on the
resolution mode you use. The name of the resolution
mode indicates how many colors are available in that
mode. For example, the 320 x 200- 4 resolution mode
offers four colors; the 640 x 480 - 256 resolution mode
offers 256 colors.

Selecting the Active Drawing Color

The active drawing color is shown in the lower left comer
of the Picture Maker screen below the active pattern box.
To change the active drawing color, select a new color
from the palette area above the line styles area. The
number of the new color is displayed.

If you use the 320 x 200—256 or 640 x 480—256 resol
ution mode, you can select from an extended palette of
240 colors in addition to those displayed in the palette
area. To display the extended palette, move the pointer
to the palette area and press Button 2. The extended
palette appears in the drawing area. Select the active
drawing color from this palette just as you would select a
color from the palette area.
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After you select a color from the extended palette, the
color (rather than a color number) appears in the lower
left comer of the screen. Press Button 2 to exit the

extended palette. The next section describes how to
further use the extended palette.

You also can select the active drawing color from a color
in the picture. Point to a color and press the F2 key.
Selecting the active color in this manner is especially
useful when using the extended palette of the 320 x
200 —256 and 640 x 480 - 256 resolution modes.

Changing Colors in the Extended Palette

This section applies to you only if you use the 320 x
200 —256 or 640 x 480 —256 resolution mode.

There are different systems for describing color. Picture
Maker employs the RGB system, which describes all
colors as some combination of red, green, and blue.
You can change any color in the extended palette by
changing the amount of red, green, or blue in the color.
You do this by using the three color scales to the right of
the extended palette.

I File Edit Hodes Tools "Tewt
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Figure 2-14. The Extended Palette
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When you select a color from the extended palette, a box
in each color scale shows you the amount of red, green, or
blue in the color. The amount is a number on the scale

from 0 to 63.

To change a color in the extended palette:

1. If the extended palette is displayed, press Button 2 to
remove it.

2. Make sure Fix Palette on the Tools menu is switched

off (an option is off when no arrow appears in front
of the option name).

3. Move the pointer to the palette area and press Button
2 to display the extended palette.

4. Select a color to change in the extended palette. The
boxes in the color scales show you the amount of red,
green, and blue in the color.

/^*^ 5. Select a box in one of the color scales.

6. Move the box up to increase the amount of red, green,
or blue in the color, or move the box down to
decrease the amount. The color in the extended

palette changes to reflect the altered amount of red,
green, or blue.

7. Press Button 1 again to set the box.

8. Select a box in another scale to move, or select
another color to change from the extended palette.

9. When you have finished changing colors, press Button
2 to exit the extended palette.
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Changing the 16-coior Palette

If you are using the 640 x 350— 16 or 640 x 480— 16 resol
ution mode, you can change colors in the palette area as
follows:

1. Make sure Fix Palette on the Tools menu is switched

off (an option is off when no arrow appears in front
of the option name).

2. Select the color in the palette area you want to
change.

3. Press Button 2. The color number changes in the
lower left comer of the screen. Each time you press
Button 2, the color number increases by 1 and the
color in the palette area changes. In this manner you
can scroll through all 64 available colors.

To reverse direction, press Button 1 once, then resume
pressing Button 2. The color number decreases by one
each time you press Button 2.

Changing the Background Color

The Background Color option on the Modes menu lets
you change the background color in the drawing area. To
use this option:

1. Select Background Color from the Modes menu. A
box appears that shows you the current background
color.

2. Select a new background color from the palette area
(or from the extended palette, if you are using the 320
X 200 - 256 or 640 x 480 - 256 resolution mode). The
new color appears in the background color box.

3. Press Button 2 to remove the background color box.
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Note that using this option does not automatically change
the former background color in your picture to the new
color. The new background color will show up when you
use the following features:

• The Eraser icon

• The Move option on the Modes menu
• The Clear option on the Edit menu

Changing Screen Color

In all resolution modes except 320 x 200 - 256 and 640 x
480 - 256, you can change the screen color by performing
the following steps.

1. If you use the 640 x 200— 16, 640 x 350— 16, or 640 x
480—16 resolution mode, make sure the Fix Palette
option on the Tools menu is switched off (an option is
off when no arrow appears in front of the option
name).

2. Move the pointer to the second color in the palette
area and press Button 2. The screen color changes.
Continue pressing Button 2 to scroll through all avail
able screen colors.

Following is the number of available screen colors
depending on the resolution mode you use:

Resolution Mode Colors

320 x 200-4 15

640x200-16 15

640 x 320-16 64

640 x 480-16 64

Note: In 320 x 200 —4 resolution mode, you also
can switch among bright white, yellow, white, and
brown in the menu area, pattern area, icon area,
and drawing area. To switch colors, move the
pointer to the first color in the palette area and
press Button 2. Changing these colors also alters
the drawing colors.
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Creating Color Spreads
In all resolution modes except 320 x 200 —4, you can
create areas of graduated color called color spreads.
Color spreads are useful for shading objects and creating
attractive backgrounds in your pictures. You create color
spreads using the Fill icon and the Spread option on the
Modes menu. How you use this option differs based on
the number of colors supported by the resolution mode
you use.

Using 16-Coior Resolution Modes

If you use the 640 x 200— 16, 640 x 350 —16, or 640 x
480— 16 resolution mode, you can create color spreads
using the background color and one drawing color. To
create a color spread in these resolution modes:

1. Use the Background Color option on the Modes menu
to select a background color for the spread.

2. Select the drawing color for the spread.

3. Select Spread from the Modes menu. You see the
Color Spread panel.
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Figure 2-15. The Color Spread Panel in 16-Color Resolution Modes
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4. Select an arrow in the Spread Direction box to set the
direction in which the spread is drawn. For example,
if you select the arrow pointing right, the spread starts
on the left side of the drawing area. The drawing
color you selected is spread across the drawing area to
the right, gradually replaced by the background color.

If you select the center of the Spread Direction box,
the spread radiates in a circular pattern. The center of
the circle is determined by the pointer's location when
you initiate the spread.

5. Select Wave Effect on the Color Spread panel to
spread the drawing color into the background color,
and then back again. This option creates a mirror-
image effect with the color spread.

6. Move the pointer outside of the Color Spread panel
and press Button 2. The panel is removed.

7. Select the Fill icon.

8. Move the pointer to the area you want to fill with the
color spread.

9. Press Button 1. The area you selected is filled with the
color spread.

Notes:

1. If you want to use the entire drawing area with
a color spread, select Full Screen on the Tools
menu before you select the area to fill. Refer
to "Using the Full Screen" on page 2-138 for
more information about this option.

2. You also can create color spreads using the
Alter Color option on the Edit menu. For
more information about using this option, refer
to "Altering Color" on page 2-129.
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3. To remove a color spread you just created,
select Undo on the Edit menu. You must

remove an existing color spread before you
refill an area with a new color spread.

4. To resume using the Fill icon with patterns,
move the pointer to Spread on the Modes
menu and press Button 2. The arrow in front
of the Spread option disappears.

Using 256-Color Resolution Modes

If you use the 320 x 200 —256 or 640 x 480 —256 resol
ution mode, you can create color spreads using up to 240
colors in the extended palette. To create a color spread in
these resolution modes:

1. Make sure Fix Palette on the Tools menu is switched

off (an option is off when no arrow appears in front
of the option name).

2. Select Spread on the Modes menu. You see the Color
Spread panel with the extended palette.
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Figure 2-16. The Color Spread Panel in 256-Color Resolution Modes
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3. Move the pointer to the color in the extended palette
that you want to be the starting color in the spread.

4. Press Button 1. The color you select appears on the
left between the brackets below the Wave Effect

option. A dotted line around the color indicates that
you can change the color using the color scales to the
right of the extended palette. To use these scales, see
"Changing Colors in the Extended Palette" on
page 2-104.

5. Move the pointer to the last color you want to use in
the spread.

6. Press Button 2. The color appears between the
brackets above the extended palette. You also can
change this color using the color scales.

7. At this point, you have selected the starting and
ending colors of the spread. If you were to create a
spread right now. Picture Maker would use these
starting and ending colors, and all colors in between
as they appear in the extended palette.

However, you also can use the starting and ending
colors to create a spread within the extended palette
by selecting Spread Between Brackets at the bottom of
the Color Spread panel. The colors in the palette
between the starting and ending colors change. Now
when you create a spread in your picture, the spread
you defined in the extended palette will be used.

8. Select an arrow in the Spread Direction box to set the
direction in which the spread is drawn. For example,
if you select the arrow pointing right, the spread starts
on the left side of the drawing area with the first color
you selected. The rest of the colors in the spread fill
the area moving to the right.
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If you select the center of the Spread Direction box,
the spread radiates in a circular pattern. The center of
the circle is determined by the pointer's location when
you initiate the spread.

9. Select Dither if you want Picture Maker to "blur" the
boundaries of the colors in the spread.

10. Select Wave Effect to create a mirror-image effect with
the color spread.

11. When you are finished selecting colors and options on
the Color Spread panel, select YES to accept your
changes. The panel is removed.

12. Select the Fill icon.

13. Move the pointer to the area you want to fill with the
color spread.

14. Press Button 1. The area you selected is filled with the
color spread.

Notes:

1. If you want to use the entire drawing area with
a color spread, select Full Screen on the Tools
menu before you select the area to fill. Refer
to "Using the Full Screen" on page 2-138 for
more information about this option.

2. You also can create color spreads using the
Alter Color option on the Edit menu. For
more information about using this option, refer
to "Altering Color" on page 2-129.

3. To remove a color spread you just created,
select Undo on the Edit menu. You must

remove an existing color spread before you
refill an area with a new color spread.
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4. To resume using the Fill icon with patterns,
move the pointer to Spread on the Modes
menu and press Button 2. The arrow in front
of the Spread option disappears.

5. Before retrieving pictures that contain color
spreads, switch off the Fix Palette option on
the Tools menu. If you retrieve a picture
without switching off this option, the color
spread will not appear as you expect. Switch
off Fix Palette, and then get the picture again.
For more information about retrieving pic
tures, refer to "Getting Pictures" on
page 2-147.

Notes for Keyboard Users

Press F4 to move the pointer to the palette area.

Use the Cursor keys to move the pointer to a new
selection.

Use the Plus and Minus keys on the numeric
keypad in place of Buttons 1 and 2, respectively.

Press F3 to move the pointer to the icon area.

If you use the 320 x 200 —256 or 640 x 480 —256
resolution mode, press the Tab key to move the
pointer to the RGB scales on the right side of the
extended palette.

Press the 4 key to move the pointer to the Tools
menu.

Press the 3 key to move the pointer to the Modes
menu.

2-113



Using Patterns

Selecting the Active Pattern

The active pattern is displayed in the box above the active
drawing color number in the lower left comer of the
Picture Maker screen. You can change the active pattern
by selecting a different pattern from the pattern area on
the right side of the Picture Maker screen.

Note: If you are using the 640 x 200—16, 640 x
350- 16, or 640 x 480— 16 resolution mode, you
have 30 additional patterns to choose from. To
alternate between the pattern sets, move the
pointer to the pattem area and press Button 2.

Making the Active Coior the Active Pattern

You also can use any drawing color as the active pattern.
First select the active drawing color. Then, move the
pointer to the active pattern box and press Button 1. The
active drawing color appears in the active pattern box.

Spraying Patterns

The Spray icon lets you spray the active pattern onto
your picture. To use this feature:

1. Select the Spray icon.

2. Move the pointer to the area in the picture where you
want to start spraying. The pointer changes to a
diamond shape.

3. Press Button 1 to start spraying.

4. Move the pointer over the areas you want to spray.
Note that the spray is not solid. To create a solid
spray, move the pointer over the same area several
times. —

5. Press Button 1 again to stop spraying. To erase an
area you just sprayed, press Button 2 and move the
pointer over the area. Press Button 2 again to stop
erasing.
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Painting Patterns

With the Paint icon, you can paint solid patterns onto
your picture. To use this feature:

1. Select the Paint icon.

2. Move the pointer to the area in the picture where you
want to start painting. The pointer changes shape
(the shape depends on the currently active brush
shape).

3. Press Button 1 to start painting.

4. Move the pointer over the areas you want to paint.

5. Press Button 1 again to stop painting. To erase an
area you just painted, press Button 2 and move the
pointer over the area. Press Button 2 again to stop
erasing.

To change the brush shape, follow these steps:

1. Select Brush Shape from the Tools menu. A panel
appears that shows the available brush shapes. The
active brush shape is outlined with a box.

2. Select a different brush shape. You return to the
drawing area.

Filling with Patterns

You can fill areas of the screen with the active pattern
using the Fill icon. To use this feature:

1. Make sure the Buffer Fill and Spread options on the
Modes menu are switched off (an option is switched
off when no arrow appears in front of the option
name).

2. Select the Fill icon.

3. Move the tip of the pointer to an area in the picture
you want to fill.
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4. Press Button 1. The area is filled with the active

pattern until a different color is encountered. If the
area you want to fill is not completely enclosed by a
different color, surrounding areas are also filled. Press
Button 2 to stop a fill.

You always can refill a solid colored area with another
color or pattern. However, you can refill a patterned area
you just filled only if you have not selected a menu
option, icon, or Help in the meantime. To change the
pattern, simply select a new active pattern from the
pattern area, and then press Button 2. The new pattern
fills the area. Otherwise, erase the pattern and fill the
area with a different pattern.

Editing Patterns

You can edit any existing pattern to create your own.
Edited patterns are saved when you save your pictures.
The original patterns remain available for all other pic
tures you create.

To edit a pattern:

1. Select the pattern that can be most easily modified to
achieve the effect you want.

2. Select Edit Pattern from the Tools menu. A panel
with two boxes appears. The right box is the pattern
in normal scale. The left box is a magnified portion
of the pattern.

3. Select the active drawing color you want to use to
change the pattern.

4. Move the pointer to a pixel you want to change in the
magnified pattern and press Button 1. The pixel
changes to the active drawing color. Move the pointer
to change adjacent pixels to the same color. The
pattern also changes in the box on the right.
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5. To stop changing pixels, press Button 1. To restore
pixels to their previous color, press Button 2. Press
Button 2 again to stop restoring pixels.

6. Select different active drawing colors as needed while
changing pixel color.

7. When you have finished editing the pattern, select
YES to save your changes (or NO to cancel). If you
save the edited pattern, it replaces the original pattern
in the pattern area, but only for the picture you are
currently creating or editing.

Hint: If you will be using a set of edited patterns often,
edit and save the patterns in a blank picture file just for
that purpose. Retrieve this file when you want to create a
new picture that uses one or more of the edited patterns.

— Notes for Keyboard Users

• Press F6 to move the pointer to the pattern area.

• Use the Cursor keys to move the pointer to a new
selection.

• Press F9 to move the pointer to the active pattern
box.

• Use the Plus and Minus keys on the numeric
keypad in place of Buttons 1 and 2, respectively.

• Press F3 to move the pointer to the icon area.

• Press the 4 key to move the pointer to the Tools
menu.
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Creating Picfyres with a Video Camera

The Digitize option on the Tools menu lets you create an
image using a video camera. The Digitize option takes
video signals and digitizes them for use with Storyboard
Plus. Once digitized, the image can be displayed, edited,
and saved with Picture Maker.

You need special equipment to use this feature, such as
that listed under "Video Input Devices" in Appendix B.
Refer to the manual that accompanies your equipment for
installation instructions. Once you have correctly
installed this equipment, follow these steps to use the
Digitize option:

1. In all resolution modes except 320 x 200 —4, select Fix
Palette on the Tools menu to switch off the option (an
option is off when no arrow appears before the option
name).

2. Select Digitize on the Tools menu.

Note: If you are running Picture Maker from
5.25-inch diskettes, remember that a file essential
to using the Digitize option, DIGITIZE.PDR, is
located on Diskette 3. Before selecting this option,
insert Diskette 3 in the default drive.

3. Position the pointer on the Brightness scale and press
Button 1 to change the brightness of your digitized
image.

4. Position the pointer on the Contrast scale and press
Button 1 to change the contrast of your digitized
image.

Note: The image must be digitized again to reflect
any changes made to the Brightness or Contrast
setting.

2-118



5. Use one of three options to digitize your picture:
Black & White, Shades, or Color. The number of
shades and colors available varies depending on the
resolution mode you are using.

6. To digitize an image, select YES. Whatever the video
camera is pointing at will be digitized onto the screen.

7. Once the image has been digitized, you can press Enter
to digitize the image again. To return to the Digitize
panel, press the Esc key. You can now make adjust
ments in the brightness and contrast and digitize the
image again, or select NO to exit the Digitize panel.

Use the other options on the Digitize panel as follows:

One Input

Select this option to use a video camera with one input
jack. Place the input line from the camera in the first
channel of the video capture board you are using.

RGB input

Select this option to use a video camera that has RGB
input capabilities. The RGB input lines should be placed
in the second, third, and fourth channels of the video
capture board you are using.

Digitizing in 256-Coior Modes
If you use the 320 x 200 —256 or 640 x 480 —256 resol
ution mode, you can further adjust a digitized image
before you return to the Digitize panel.

2-119



With the digitized image displayed, you can adjust the
amount of red, green, and blue in the image, as well as
adjust intensity and reset the image to its original colors,
using the following keys:

Keys Action
Fl, F2 Decreases (Fl) or increases (F2) red in the image
F3, F4 Decreases (F3) or increases (F4) green in the

image
F5, F6 Decreases (F5) or increases (F6) blue in the image
F7, F8 Decreases (F7) or increases (F8) the intensity of

the image
F9 Resets the image to its original color and intensity
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Notes for Keyboard Users

Press the 4 key to move the pointer to the Tools
menu.

Use the Cursor keys to move the pointer to a new
selection.

Use the Plus and Minus keys on the numeric
keypad in place of Buttons 1 and 2, respectively.



Editing Picfyres

Undoing Your Latest Changes
Select Undo on the Edit menu to undo all changes to a
picture since you last selected an icon or pattern. For
example, if you paint a pattern, and then decide you don't
like it, select Undo to remove it.

Remember that Undo cancels everything you did since you
last selected an icon or pattern. If you draw five rectan
gles in succession, selecting Undo erases all five rectangles,
not just the last one you drew. When using the Fill icon,
selecting Undo removes all fills since you last selected a
pattern, not just the last fill.

You can restore changes by selecting Undo again— pro
vided you have not already selected another menu option
or icon, or you have not performed any other action in
the drawing area (other than pressing Button 2 while
using the Pencil, Eraser, Spray, or Paint icon).

Selecting Areas of the Picture
Several of Picture Maker's editing features work with
areas of the picture you frame using the Select icon.
Using this icon lets you draw a dashed-line rectangle,
called a select box, around an area of the picture. For
some features, a selected area of the picture is optional;
for other features, a select box is required.

To select an area of the picture:

1. Move the pointer to the Select icon and press Button
1.

2. Move the pointer into the drawing area where you
want one corner of the select box to be located. The

pointer becomes a crosshair cursor.
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3. Press Button 1 to start drawing the select box.

4. Move the pointer to stretch the select box so it encom
passes the area of the picture you want to select.

5. Press Button 2 to set the select box, or press Button 1
to cancel.

To remove a select box, move the pointer outside of the
select box and press Button 1. If the select box takes up
the full screen, press FIO to remove the select box.

Moving and Copying Seiected Areas of the Picture
To move or copy a selected area of the picture:

1. Select Move or Copy from the Modes menu. These
two options are mutually exclusive; only one of them
can be switched on at a time (an option is on when an
arrow appears in front of the option name).

2. If you have not already done so, select the area of the
picture you want to move or copy.

3. Move the pointer over the select box in the drawing
area and press Button 1. The pointer disappears.

4. Move the select box to a new location in the picture.
If you are copying the selected area, the area remains
in its original location as you move the copy.

5. Press Button 2 to set the select box in its new location
(or press Button 1 to cancel the move or copy). The
area remains selected for further moving or copying.

6. Move the pointer outside of the select box and press
Button 1 to finish moving or copying. If the select
box takes up the full screen, press FIO.

Note: If the Select icon is flashing, the selected
area is too large to move or copy. Try selecting a
smaller area. The size of the area you can select
before the Select icon starts flashing depends on
the resolution mode you are using.
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Transparent and Opaque Moving and Copying

When you move or copy an area in a select box, all pixels
within the boundaries of the select box are moved or

copied. There may be times when you want to move or
copy just a figure without the surrounding pixels in a
selected area. You can do this using the Transparent and
Transparent Color options on the Modes menu.

For example, a picture contains three figures: a red circle,
a blue square, and a green rectangle. The red circle is on
the blue square, but you want to move it to the green rec
tangle without moving any of the blue as well. You can
do this by making blue a transparent color before you
move the red circle. Here's how:

Lr

1. Select Transparent Color on the Modes menu. A box
appears that shows you the current transparent color.

2. Select the blue used for the square from the palette
area. The blue appears in the transparent color box.

3. Press Button 2 to remove the transparent color box.

4. Select Transparent from the Modes menu.

5. Using the Select icon, draw a select box around the
red circle.

6. Move the select box to the green rectangle and press
Button 2.

7. Press Button 1 to finish. The red circle appears on the
green rectangle without any blue around it. The
selected area in the blue square is gone. The back
ground color appears there instead.

You also can select the transparent color from those
— , available in the select box. Before you press Button 2 to

set a moved or copied area in place, press FT or F8 to
cycle through the available transparent colors within that
select box. When the color you want to make transparent
disappears, press Button 2.
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To move or copy all pixels in a select box, select Opaque
from the Modes menu. The Transparent and Opaque
options are mutually exclusive; only one of them can be
switched on at a time (an option is on when an arrow
appears in front of the option name).

Moving and Copying Using Contour

Select boxes limit you to moving or copying rectangular
or square areas of a picture. You also can move or copy
an irregularly-shaped area by outlining it using the
Contour option on the Edit menu. To use this feature:

1. Select Contour on the Edit menu.

2. Move the pointer into the drawing area where you
want to start outlining the area to move or copy. The
pointer changes to indicate you are using Contour.

3. Press Button 1 to start outlining the area.

4. Move the pointer around the area you want to move
or copy. A line appears around the area.

5. Press Button 2 when you have finished outlining the
area. The area appears bUnking within a select box.

To cancel outlining an area, press Button 1 instead of
Button 2. Then, to cancel using the Contour feature,
press Button 2.

6. With the pointer in the blinking area, press Button 1
to move or copy the selected area.

7. Move the bhnking area to a new position.

8. Press Button 2 to set the selected area in its new posi
tion (or press Button 1 to cancel).

9. Move the pointer outside of the selected area and
press Button 1 when you have finished moving or
copying the selected area.
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Inverting Colors
Select Invert on the Edit menu to invert the colors on the

screen. If there is a select box on the screen, only the
selected area is inverted.

Select Invert again to restore the original colors to the
picture or selected area.

Note: You can invert a selected area even if the

Select icon is flashing.

Flipping Pictures
You can flip the entire picture or selected areas of the
picture from top to bottom or left to right. To flip the
picture or selected area top to bottom, select Flip Vertical
on the Edit menu. To flip left to right, select Flip Hori
zontal on the Edit menu.

Note: You can flip a selected area even if the
Select icon is flashing.

Rotating Selected Areas of a Picture
The Rotate option on the Edit menu lets you rotate a
selected area of a picture in five-degree increments, either
clockwise or counterclockwise. Here's how:

1. Use the Select icon to draw a select box around the

area of the picture you want to rotate.

2. Select Rotate from the Edit menu.

3. Move the pointer up to rotate the selected area clock
wise; move the pointer down to rotate the area
counterclockwise. The degree of rotation is displayed
in the line styles area.
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4. Press:

• Button 1 to set the rotation and move or copy the
area to another location in the drawing area
(depending on whether Move or Copy is selected
on the Modes menu). After moving or copying
the selected area to the new location, press Button
2 (or Button 1 to cancel).

• Button 2 to set the rotated area in place.

Notes:

1. The Move and Copy options affect the selected
area you rotate. If you want to replace a
selected area with a rotated version of it, make
sure Move is switched on in the Modes menu.

2. Depending on the resolution mode you use and
the complexity of the image, rotating may
cause distortion.

3. When canceling a rotation, use the Undo
option instead of rotating a selected area back
to its original orientation. Otherwise, the
selected area may become distorted.

4. If the Select icon is flashing and you cannot
rotate an area, try selecting a smaller area.

Scaling Selected Areas of a Picture
The Scale option on the Edit menu lets you make a
selected area of a picture larger or smaller, horizontally
and/or vertically. To scale an area the same amount hor
izontally and vertically, select Constrain on the Modes
menu before scaling the area.

To scale a selected area:

1. Use the Select icon to draw a select box around the

area of the picture you want to scale.

2. Select Scale from the Edit menu.
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3. Move the pointer up or down to scale the selected
area vertically; move the pointer left or right to scale
the area horizontally. The percentage of horizontal
(top number) and vertical (bottom number) scaling is
displayed in the line styles area.

4. Press:

• Button 1 to set the new scale of the area and move

or copy the area to another location in the
drawing area (depending on whether Move or
Copy is selected on the Modes menu). After
moving or copying the selected area to the new
location, press Button 2 (or Button 1 to cancel).

• Button 2 to set the scaled area in place.

Notes:

1. The Move and Copy options affect the selected
area you scale. If you want to replace a
selected area with a scaled version of it, make
sure Move is switched on in the Modes menu.

2. Depending on the resolution mode you use and
the complexity of the image, scaling may cause
distortion.

3. When canceling an image you scaled, use the
Undo option instead of scaling a selected area
back to its original size. Otherwise, the
selected area may become distorted.

4. If the Select icon is flashing and you cannot
scale an area, try selecting a smaller area.
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Cutting, Pasting and Filiing from Buffer
You can cut a selected area of the picture and store it in a
buffer for use with the Paste and Buffer Fill options.
These options let you cut areas from one picture for use
in others.

To cut a selected area, select Cut from the Edit menu.
The area in the select box is stored in a buffer (the area
remains unchanged in the picture).

If the select box changes to a dash/dot style (the normal
style uses dashes only), the selected area is too large to
cut. You also hear a tone, if you have set up Storyboard
Plus to issue audible signals. Select a smaller area, and
then try cutting again. The size of the area you can cut
varies depending on the resolution mode you are using.

To paste the cut image in the same picture, select Paste
from the Edit menu. The image appears in a select box in _
the upper left comer of the drawing area. Move or copy ' ^
the image as needed.

To paste the cut image in another file, follow these steps:

1. Select Get Picture from the File menu. The File Ser

vices panel appears. Use this panel to select the file
you want to paste the image in (see "Getting Pictures"
on page 2-147 for more information about retrieving
picture files). The file appears in the drawing area.

2. Select Paste from the Edit menu. The last image you
cut appears in a select box in the drawing area.

3. Move or copy the image as needed.

You also can cut an image for use with the Buffer Fill
option on the Modes menu. Using Buffer Fill is similar
to using the Fill icon, except the area you select is filled
with the last image you cut. To use this feature:

1. Select Buffer Fill from the Modes menu.
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2. Select the Fill icon.

3. Move the tip of the pointer to an area in the picture
you want to fill, and then press Button 1. The area
fills first with the letter "c," then with the image you
last cut. The area fills until a different color is

encountered. If the area you want to fill is not com
pletely enclosed by a different color, surrounding areas
are also filled. Press Button 2 to stop a fill.

Note: If you have set up Storyboard Plus to use
sound for messages and errors, you may hear a
beep while trying to use Buffer Fill. This is a
signal that there is no cut image with which to fill.

4. To resume using the Fill icon with patterns, select
Buffer Fill again to switch off the option.

Altering Color

Using the Alter Color Option

Use the Alter Color option on the Edit menu to change a
color in all or a selected area of the picture to the active
drawing color. To use this option:

1. Select Alter Color from the Edit menu.

2. Move the pointer into the drawing area. The pointer
changes to a box with a tip on it. As the tip of the
box touches a pixel, the color of that pixel is displayed
in the box.

3. When the color you want to change is displayed in the
pointer box, press Button 1. All pixels of that color
are changed to the active drawing color. If there is a
select box in the drawing area, only pixels in the
selected area are altered.

4. To use a different drawing color, use the pointer box
to select a different drawing color from the palette
area. Then select the color to change in the drawing
area.
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5. Press Button 2 when you have finished altering colors.

Note: You also can use Alter Color with color

spreads. First select Spread from the Modes
menu. Then, follow the steps above to change all
pixels of one color to the current color spread.
For more information about using the Spread
option, see "Creating Color Spreads" on
page 2-108.

Using the Change Color Option

You also can alter color in your picture using the Change
Color option on the Tools menu and the Paint or Spray
icon. Here's how:

1. Select the Change Color option on the Tools menu.

2. Select the new color you want to change to and make
it the active pattern.

3. Select the color you want to change.

4. Select the Paint or Spray icon.

5. Move the pointer to the area of the picture in which
you want to alter color.

6. Press Button 1 and move the pointer to change the old
color to the new color. Press Button 1 again to stop
altering color. To restore areas to the old color, press
Button 2 and move the pointer over areas you want to
restore. Press Button 2 again to stop restoring.

7. When you have finished altering color, select the
Change Color option on the Tools menu again.

Clearing the Picture
Select Clear on the Edit menu to clear all or a selected

area of the picture. Selected areas can be chosen using
the Select icon or the Contour option on the Edit menu.
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If you select this option to clear the entire picture, a
message asks you to confirm that you want to continue
(you are not asked to confirm if clearing a selected area).
Select YES to continue or NO to cancel. If you select
YES, any changes you made since the last time you saved
the file are lost.

The active background color appears in areas you have
cleared. For this reason, the Clear option is useful after
you change the background color with the Background
Color option on the Modes menu (see "Changing the
Background Color" on page 2-106 for more information
about the Background Color option).

Note: You can clear a selected area even if the

Select icon is flashing.

Retrieving Library Images
Picture Maker includes several library files of images you
can use in your pictures. To use these images, select
Library from the Tools menu. You see the following
Library panel.

File Edit tlodes Tools Tewt

Change Library
^ieu Picture

pn

Drau Pictiire

I VES I I NO I

.LBR

NO. Description

1 EHTERIORS

2 Barber shop t

3 ree 1
A free 2
5 free 3

niilUple Color Fill

One Color Fill

Figure 2-17. The Library Panel
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The box in the middle of this panel displays a list of
images in the current library file, the name of which
appears above the list. Use the arrows on the right side
of the image list to scroll through all of the images.

To view an image, select it from the list and then select
View Picture. The image you chose appears on the screen.
To view the next image in the Ubrary file, press Button 1.
You can scroll through all of the images in the library file
while viewing them. Return to the Library panel by
pressing Button 2.

Changing Library Fiies

Picture Maker includes several library files, which you can
identify by their LBR file extension. You can change the
current library file by following these steps:

1. Select Change Library on the Library panel. The File
Services panel is displayed.

The box at the top of this panel shows the currently
selected drive and directory. The left side of the ^
middle box is where you decide which files will be
listed in the Filename box in the lower right portion
of the panel. Because you are changing libraries,
.LBR files is highlighted in the middle portion of the
panel, which means only files with the extension LBR
are listed in the Filename box. (To list all files in the
current directory, select All files.)

The bottom portion of the panel is where you select
the drive, directory, and filename of the library you
want to change to. In each of the Drive, Directory,
and Filename boxes, arrows pointing up and down on
the right side of the box enable you to scroll through
the list when there are more entries than those dis-

played.
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Note: If you are running Picture Maker from
5.25-inch diskettes, remember that all library files
except PM.LBR are located on Diskette 3. The
PM.LBR file is located on Diskette 2. Before

changing libraries, you must insert the correct
diskette in a drive, and then select that drive on
the File Services panel.

2. To get a library from a different directory or drive,
select the directory or drive from those listed in the
Drive and Directory boxes.

3. Select the name of the library file you want to get
from those listed in the Filename box. Or, select Type
in the Filename box to enter the name of a file.

4. If you selected the name of a file, select YES to get it
(or NO to cancel). If you selected Type, type the
name of the file and press Enter. You return to the
Library panel, where you can select and view the
images in the new library.

Choosing How Library Images are Colored and Shadowed

You can choose to have Picture Maker select the colors

for your library image. Images can be multicolored or all
one color. To use multiple colors, select Multiple color fill
at the bottom of the Library panel.

To use one color in an image, select One color fill. When
using this option, you can select the fill color from the
patterns on the right side of the Picture Maker screen.
You also can fill using a drawing color by selecting a
color from the palette area, then selecting the active
pattern box in the lower left comer of the screen. The
active color becomes the active pattern. (Selecting a
drawing color also changes the outline color of the
image.)
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Alternatively, you can select your own colors for an image
by selecting One color fill and selecting white as the active
pattern. After selecting YES on the Library panel to
draw the image, use the patterns and drawing colors to
fill, paint, or spray the image however you choose.

To set the direction, depth, and color of shadows in
library images, move the pointer over the four boxes in
the lower left comer of the Library panel and press
Button 1. The Set Shadow panel appears. For informa
tion about using this panel, see "Using Shadows" on
page 2-70.

After you use the Set Shadow panel, the four boxes in the
lower left comer of the Library panel are shown with the
shadow settings you selected. To deactivate the use of
shadows with library images, move the pointer over these
boxes and press Button 2. To switch shadows back on
without changing settings on the Set Shadow panel, move
the pointer to the four boxes and press Button 2 again.

Drawing the Library image
When you are ready to draw the library image, select YES
on the Library panel (or select NO to exit the panel
without drawing an image). The panel is removed, and
the image (minus color and shadows) appears in the upper
left corner of the drawing area in a select box. If there
already was a select box in the drawing area, the image
appears in the existing select box.

You can move and scale the image as described in the
next section. To set the library image in its current
location, press Button 1 while the pointer is outside of the
select box. Once you set the image, it is drawn with the
colors and shadowing you selected on the Library panel.
Press Button 1 again to remove the select box.
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Note: Refer to "Transparent and Opaque Moving
and Copying" on page 2-123 for information
about the Transparent and Opaque options, which
affect the way library images overlay areas of your
pictures.

Moving and Scaling the image

After you select YES on the Library panel, the image
appears in a select box in the drawing area. To place the
image in your picture, move the pointer inside the select
box and press Button 1. Move the image to its new
location and press Button 1 again.

Scale the library image by moving the pointer inside the
select box and pressing Button 2. Move the mouse to
scale the select box, and then press Button 2 again.

Note: Select Constrain on the Modes menu to

scale the image proportionally in all directions.

After moving or scaling the image, move the pointer
outside of the select box and press Button 1 to set the
image. Once set, the image is drawn with the colors and
shadowing you selected on the Library panel. With the
pointer outside of the select box, press Button 1 again to
remove the select box. If the select box fills the screen,
press FIO to remove the select box.

Another way to place and scale a library image is to draw
a select box in the shape, size, and position you want the
image to appear before you display the Library panel.
When you draw the image, it is automatically placed and
scaled according to the select box you drew. For more
information about drawing select boxes, see "Selecting

- Areas of the Picture" on page 2-121.
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— Notes for Keyboard Users

• Press the 2 key to move the pointer to the Edit
menu.

• Use the Cursor keys to move the pointer to a new
selection.

• Use the Plus and Minus keys on the numeric
keypad in place of Buttons 1 and 2, respectively.

• Press the 3 key to move the pointer to the Modes
menu.

• Press the 1 key to move the pointer to the File
menu.

• Press the 4 key to move the pointer to the Tools
menu.

• Use the Tab and Shift-Tab keys to move the
pointer in the Library and File Services panels.

• Press Y or N to select YES or NO on the Library
and File Services panels.



Working with th© Drawing Area

Scrolling the Drawing Area
As mentioned at the beginning of this chapter, the
drawing area is the size of your computer screen. Parts of
the Picture Maker screen, such as the menu, palette, icon,
and pattern areas, overlay parts of the drawing area.

You can scroll the drawing area to use the parts that are
obscured by the Picture Maker screen. To scroll the
drawing area, use the Scroll icon as follows;

1. Select the Scroll icon in the icon area.

2. Move the pointer into the drawing area. The pointer
becomes the scroll symbol.

3. Press Button 1 to start scrolling.

4. Move the pointer in the direction you want to scroll
the drawing area. If the drawing area stops scrolling,
you have reached the limit in that direction.

5. Press Button 2 to set the drawing area in place (or
Button 1 to cancel scrolling). Now you can draw and
edit in the portion of the drawing area that was previ
ously obscured.

— Notes for Keyboard Users

• Press F3 to move the pointer to the icon area.

• Use the Cursor keys to move the pointer to a new
selection.

• Use the Plus and Minus keys on the numeric
keypad in place of Buttons 1 and 2, respectively.
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Using the Full Screen
The Full Screen option on the Tools menu lets you
remove the parts of the Picture Maker screen that obscure
the drawing area. You then can draw or edit using the
full screen. To use this option:

1. Select the icon, option, or pattern you want to use.

2. Select Full Screen from the Tools menu. The drawing
area takes up the full screen.

3. If you are using the X,Y Coordinates or Zoom option
with Full Screen, you can move the display box for
these options to another portion of the screen. Move
the pointer to the box and press Button 1. Move the
box to another area of the screen and press Button 2.

4. Draw or edit as needed.

5. To select a different icon, option, pattern, or color,
press the Spacebar, then select what you need. Press
the Spacebar again to resume using the full screen.

6. When you have finished using the full screen, press the
Spacebar, and then select Full Screen again from the
Tools menu.

Note: The Scroll and Microscope icons are not
available while you are using the Full Screen
option.

— Notes for Keyboard Users

• Press the 4 key to move the pointer to the Tools
menu.

• Use the Cursor keys to move the pointer to a new
selection.

• Use the Plus and Minus keys on the numeric
keypad in place of Buttons 1 and 2, respectively.
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Notes for Keyboard Users

To select an icon, option, or pattern, use the key
assigned to the appropriate area or menu as listed
in the section "The Picture Maker Screen" in this
chapter. After making a selection, press the Plus
key to return to the full screen.

Using Two Pages of Drawing Area
Picture Maker lets you store the picture you are currently
working with in memory so you can get another picture
to edit or create a new one. With this ability, you can
quickly move and copy parts of one picture to another.

In effect, you have two "pages" of drawing area to work
with, although only one page is displayed at a time. For
example, you can select Switch Page and use the second
page as a sketch pad. Then, you can use Switch Page
again to quickly copy selected areas into the picture on
the first page.

Note: When working with pictures that use two
different color palettes. Picture Maker defaults to
the palette of the second picture, which may
change the appearance of the first picture.

To use the Switch Page option;

1. Store the picture you are currently working on in
memory by selecting Switch Page from the Tools
menu. The drawing area clears, displaying a blank
second page.

2. Get another picture to work with or start drawing a
new one (refer to "Getting Pictures" on page 2-147
for information about retrieving picture files).

3. To copy a part of the second page to the first, select
an area using the Select icon.
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4. Select Switch Page again to display the original
picture on the first page. Any area you selected on
the second page is displayed on the first page.

5. Save each page as a separate picture.

You also can select an area of a picture before selecting
Switch Page. After you select Switch Page, the selected
area of the first page appears on the second page.

Notes:

1. The Move option only moves a selected area
within a page, not between two pages.
Selected areas are always copied between
pages.

2. The default buffer path is used if Picture
Maker cannot store both pages in memory.

Notes for Keyboard Users

Press the 4 key to move the pointer to the Tools
menu.

Use the Cursor keys to move the pointer to a new
selection.

Use the Plus and Minus keys on the numeric
keypad in place of Buttons 1 and 2, respectively.

Getting a Closer Look: Microscope and Zoom
The Microscope icon and the Zoom option on the Tools
menu let you get a closer look at your picture. When you
use these features, you can change one pixel at a time to
fine tune your pictures.
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Using the Microscope Icon

The Microscope icon lets you magnify a portion of the
drawing area so you can work with individual pixels.

Note: This feature is not available while you are
using the Full Screen option.

To use Microscope:

1. Select the Microscope icon.

2. Move the pointer to the area of the picture you want
to magnify, and then press Button 1. The area is mag
nified. A box in the upper left comer of the drawing
area shows you the same area in normal scale.

Note that the icon area has changed. The available
icons are Eraser, Pencil, and six bmsh shapes for
painting patterns in the magnified area. Select these
icons as you would select icons from the Picture
Maker screen.

4 Eraser Pencil

>Six Brush/
Shapes \

11
•••

Figure 2-18. The Icons Available with Microscope
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3. To use the pencil or paint brushes, select the icon you
want to use. Then, select a pixel you want to change
to the active drawing color or pattern.

Moving the pointer changes all pixels under the
pointer to the active drawing color or pattern. Press
Button 1 to stop changing pixel color as you move the
pointer. To change just one pixel, position the pointer
and press Button 1 twice.

As you change the pixels, the picture in the box in the
upper left corner of the screen changes to show you
the effect of your editing in normal scale.

To restore pixels to the color they were when you
magnified the area, press Button 2. Move the pointer
over the pixels you want to restore. Press Button 2
again to stop restoring pixels. To restore just one
pixel, position the pointer and press Button 2 twice.

While drawing or painting, you can switch to restoring
just by pressing Button 2 (you do not have to press
Button 1 to stop drawing first). The same is true
when restoring and you want to switch to drawing.

Select the Eraser icon to change pixels to the current
background color.

There are two ways you can change the active drawing
color while using Microscope:

• Select a different color from the palette area (or
from the extended palette, if you are using the 320
X 200 —256 or 640 x 480 —256 resolution mode).

• Position the pointer on a pixel with the color you
want as the active drawing color and press the F2
key. That color becomes the active drawing color.

Change the active pattern by selecting a different
pattern from the pattern area. The new pattern
appears in the active pattern box.



4. Change the portion of the picture currently magnified
by moving the pointer to the normal scale box in the
upper left corner of the drawing area and pressing
Button 2. Move the mouse to scroll the part of the
picture into view that you want to magnify. Then,
press Button 2 again. The magnified portion of the
picture changes.

5. To exit Microscope, position the pointer in the normal
scale box, and then press Button 1.

Using the Zoom Option

Select Zoom on the Tools menu to display a magnified
portion of the picture while you edit in normal scale. The
magnified portion, which appears in the line styles area, is
the part of the picture around the pointer. As you edit in
the drawing area, the changes are reflected in the magni
fied portion of the picture. The Zoom option is not avail
able while using the X,Y Coordinates option, or while the
Scroll or Microscope icon is selected.

— Notes for Keyboard Users

• Press F3 to move the pointer to the icon area.

• Use the Cursor keys to move the pointer to a new
selection.

• Use the Plus and Minus keys on the numeric
keypad in place of Buttons 1 and 2, respectively.

• Hold the Shift key down while using the Cursor
keys to draw or paint a continuous line.

• Press F4 to move the pointer to the palette area.

• Press F6 to move the pointer to the pattern area.

• Press F9 to move the pointer to the active pattern
box.
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Use options on the File menu to save, retrieve (get), and
print your pictures. Other options on the File menu let
you remove pictures from your disk, show the picture as
it will appear in your stories, save Picture Maker defaults, -
and return to the Picture Maker Main Menu.

Saving Pictures
Saving a picture stores your work on a diskette or fixed
disk while keeping it in memory so you can continue
working on it. When you make changes to a picture that
has been previously saved, you must save the picture
again in order to keep those changes.

You also can save just a selected area of your picture.
When a select box is present in your picture, saving the
picture saves only the portion of the picture in the select
box. For more information about selecting an area of a _
picture, see "Selecting Areas of the Picture" on ' '
page 2-121.

There are two ways to save a picture: using Quick Save,
and using the File Services panel.

Using Quick Save

You should save your picture periodically during a
drawing session to prevent losing all of your changes if
the power should fail. You can do this quickly by
pressing Alt-F8 while the pointer is in the drawing area,
and while no icon or option is active. The Quick Save
panel appears.

If you are working on a new picture, save it by selecting
Type from the Quick Save panel. A cursor appears in the
Type box, indicating you can type the name of the file.
After typing a filename, press Enter.
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If you are saving an existing picture, select YES to save it
with the name displayed on the Quick Save panel. Or,
save the picture with a different name by moving the
pointer to the picture name, pressing Button 1, and
entering a new name.

If a select box was active when you pressed Alt-F8, a
message informs you that just the select box will be saved.
Select YES to continue, or NO to save the entire picture.

When saving a picture with an existing filename, a
message informs you that the file will be replaced. Select
YES to continue, or NO to cancel.

Note: Quick Save does not let you change the
drive and directory in which you save your picture,
although this information is displayed.

Using the File Services Panei

When you are ready to save all or part of a picture,
follow these steps to use the File Services panel:

1. Select one of the following options from the File
menu:

• Save Picture to save a picture in Storyboard Plus
picture file format

• Save BSave to save a picture in the standard
BSave file format (this option only appears in 320
X 200 - 4 resolution mode)

• Save TIFF to save a picture in the Tag Informa
tion File Format used by many desktop publishing
programs (this option is not available in 320 x
200 —4 resolution mode)

Note: The steps to use these options are the same.
The rest of this procedure assumes you have
selected Save Picture.
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The File Services panel appears.

!•
1 nn

1 File Edit nodes Tools TeMt

C:\STORVBD

.PIC filp; SAVE Picture file

I "fllllnen I VES I I HO

Drive Directory Filenane

< Previous > ENDSTB .PIC

m .PIC

OPENl .PIC

0PEN2 .PIC

< Neu >

(C) IBM

Figure 2-19. The File Services Panel

The box at the top of this panel shows the currently
selected drive and directory. The left side of the middle
box is where you decide which files will be listed in the
Filename box in the lower right portion of the panel.
When saving pictures, .PIC files is highlighted in the
middle portion of the panel, which means only files with
the extension PIC are listed in the Filename box. To list

all files in the current directory, select All files.

The bottom portion of the panel is where you select the
drive, directory, and filename in which to store a picture.
In each of the Drive, Directory, and Filename boxes,
arrows pointing up and down on the right side of the box
enable you to scroll through the list when there are more
entries than those displayed.

When you save pictures, the entry New appears in the
Filename box.

2. Select a filename if you want to replace a previously
saved picture. Select New if you want to save the
picture under a new filename.
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3. If you selected a filename, select YES to save the
picture (or NO to cancel).

If you selected New, the word New disappears and the
line becomes highlighted with a blinking cursor, indi
cating you can enter a filename. Tj^e a name of up
to eight numbers and letters (follow DOS file naming
conventions).

To change the PIC file extension automatically
appended to the filename you enter, press the Period
(.) key after tj^ing the filename. The cursor moves to
the extension field where you can type an extension
for the file.

When you have finished typing a filename, press
Enter.

4. If you are saving a selected area of the picture, a
message reminds you of this fact and asks you to
confirm that you want to continue. Select YES to
continue, or NO to save the entire picture.

If you are saving a picture with an existing filename, a
message informs you that saving the file will overwrite
the file on your disk with the same name. Select YES
to continue, or NO to cancel.

After you save a picture, the name appears in the upper
left comer of the Picture Maker screen. The picture is
saved on your disk, and a copy remains in memory so you
can continue editing.

Getting Pictures
The Get Picture option on the File menu lets you retrieve
a picture file from diskette or fixed disk so you can view,
edit, or print the picture. In addition to Storyboard Plus
picture files, you can retrieve TIFF files (uncompressed
format only) and files in the PCX format.
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Note: In the 256-color resolution modes, a gray
scale is used to display PCX files. In the 16-color
modes, color is used to display PCX files.

To use the Get Picture option:

1. Select Get Picture from the File menu. The File Ser

vices panel appears.

r File Edit Ifedes Tools Tent r«)iBM

CiNSTORVBD

,PIi: IllHi:

CAP flies

TIP files
All files

GET Pictare file

I VES I I HO

Directori)

< Previous >

Filenatte

EHDSTB .PIC

GRAPH .PIC

OPEHl .PIC

0PEH2 .PIC

< Type >

Figure 2-20. The Get Picture File Services Panel

All files in the current directory with the extension
PIC are listed in the Filename box. You also can list

capture files (.CAP), TIFF files (.TIF), or all files in
the current directory by selecting an option from the
middle box of the File Services panel.

2. To get a file from a different directory or drive, select
the directory or drive from those listed in the Drive
and Directory boxes.

3. Select the name of the picture file you want to get
from those listed in the Filename box. Or, select Type
in the Filename box to enter the name of a file.
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4. If you selected the name of a file, select YES to get it
(or NO to cancel). If you selected Type, type the
name of the file and press Enter.

5. Getting a picture replaces any other picture in memory
you may have been creating or editing. If you have
not saved your latest changes to a picture, you see a
message warning you that your latest changes have
not been saved. Select YES to continue, or NO to
cancel getting a file.

After you get a picture, the name of the file appears in the
upper left corner of the Picture Maker screen.

Getting Capture Files

If you get a special type of picture file that contains more
than one image saved by Picture Taker (usually with the
extension CAP or LIB), you also see the Get Capture File
panel where you select the image you want to get.

Get Capture File

Get Picture
Uieu Picture

1 - Gr.dphicL-i
2 - Graphics
3 - Graphics
A - Graphics
5 - Graphics

(c) IBM laaa

Figure 2-21. The Get Capture File Panel

If there are more images in the list than those displayed,
use the arrows to the right of the list to scroll the other
image names into view. After you select an image, you
can retrieve it by selecting Get Picture, or view it by

2-149



selecting View Picture. While viewing an image, you can
scroll through the other images in the capture file by
pressing Button 1. Pressing Button 2 returns you to the
Get Capture File panel.

To leave the Get Capture File panel without getting an
image, select Exit.

Note: Using Picture Maker, you only can get an
image if Graphics follows the image number. Use
Text Maker to retrieve and edit text images.

Showing a Picture
You can display the current picture file by selecting Show
Page on the File menu. This option displays the picture
without the parts of the Picture Maker screen that
obscure the drawing area.

There are no icons or menu options available when the
Show Page option is selected.

To return to the Picture Maker screen, press Button 1 or
Button 2.

Removing Picture Files
Use the Remove Picture option on the File menu to erase
picture files from your disk. To use this option:

1. Select Remove Picture from the File menu. The File
Services panel appears. The picture files in the current
directory are listed in the lower right box of this
panel.

2. To select a picture to remove from a different direc
tory or drive, select the directory or drive from those
listed in the Drive and Directory boxes.

3. Select the name of the picture file you want to remove
from those listed in the Filename box. Or, select Type
in the Filename box to enter the name of a file.

2-150



4. If you selected the name of a file, select YES to get it
(or NO to cancel). If you selected Type, type the
name of the file and press Enter. A message asks you
to confirm that you want to remove the picture.

5. Select YES to remove the picture, or NO to cancel.

Printing Your Picture
Use the Print option on the File menu to print the picture
currently displayed in the drawing area.

Note; If you are running Picture Maker from
5.25-inch diskettes, remember that a file essential
to using the Print option, PRINTER.PDR, is
located on Diskette 3. Before selecting this option,
make sure you insert Diskette 3 in the default
drive.

To use the Print option:

1. Select Print from the File menu. The Print panel
appears. The name of the printer you selected from
the Quick Menu/Setup screen or the Picture Maker
Main Menu is displayed near the top of this panel.

Figure 2-22. The Print Panel

h-'int Picture
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Skip 2 Lines

I Define Print Colorsl
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2. Align your paper in the printer.

3. Use the following options on the Print panel to deter
mine how the picture will print.

Small, Medium, or Turn Page: These options deter-
mine the size and placement of the picture on the
paper. On the left side of the Print panel, a box
appears on a sample page to show you how the
picture will print based on the currently selected
option.

Note: Depending on the printer you have selected,
the Small and Medium options may yield the same
results.

Use Shades or Use Patterns: These options let you deter
mine how the colors in your picture print. You can use
shades or patterns for the colors in your picture. These
options are used with the Define Print Colors option.

Note: For best results when using the Hewlett-
Packard PaintJet' printer, select Use Shades for
pictures with text, shapes, and detailed graphics. ^
Select Use Patterns for digitized pictures.

If you use the IBM Color, IBM Color Jetprinter™,
or Quadram Quadjet^ QJ9000 printer, the Use
Shades and Use Patterns options yield the same
results.

Page Eject or No Page Eject: These options let you deter
mine whether the paper advances to the top of the next
page after the picture prints.

1 Hewlett-Packard PaintJet is a trademark of Hewlett-Packard Corporation.

Color Jetprinter is a trademark of the International Business Machines
Corporation.

2 Quadram and Quadjet are trademarks of Quadram Corporation.
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Skip 2 Lines: This option lets you determine the number
of lines the printer will advance before printing the
picture. Select the arrow pointing up or down to set the
number of lines from 0 to 40. This option is not available
when Turn Page is selected.

4. You can determine how colors print by selecting
Define Print Colors at the bottom of the Print panel.
You see the following panel:

Color prints as

Print Preuieu
Reset Colors

I Use Patterns I

Skip 2 Lines

IDefine Prj^nt ColorsI

Figure 2-23. The Define Print Colors Panel

The colors of the palette in the current resolution
mode appear in the left column on this panel. The
colors they print as appear in the right column.

The Print Preview option lets you print a sample page
to show how colors in your picture will appear. Based
on this printout, you can make color assignments for
printing using the two columns of colors on the
Define Print Colors panel as follows. To cause blue
in your picture to print as white, select white in the
left column. Then, select blue in the right column.
The blue in the right column changes to white.
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After changing colors on the Define Print Colors
panel, you can reset colors to their default settings by
selecting Reset Colors.

When you have finished defining print colors, press
Button 2.

5. Select YES to print the picture (or NO to exit the
Print panel without printing).

6. To cancel a print job once you have started it, press
the Esc key.

7. When printing is finished, select YES to reprint the
picture or NO to return to the drawing area.

If your picture does not finish printing, you may need to
change the printer resolution you are using. To change
printer resolution, refer to the setup procedure "Selecting
a Printer" on page 1-18.

Changing and Saving Defauit Settings
When you first start using Picture Maker, you may notice
that certain choices are automatically made for you. For
example, the same brush shape is used when you select the
Paint icon, and the same font is used when you enter text.

You can change these automatic choices, or defaults,
using the Save Defaults option on the File menu. This
option can save you time if you find yourself making the
same changes to any of the following Picture Maker fea
tures:

• Print Options

• Modes:

— Move vs. Copy
— Transparent vs. Opaque
— Fill Shape vs. Hollow Shape
— Constrain (on or off)
— Grid (on or off)
— Crosshair (on or off)
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- Buffer Fill (on or off)
— Spread (on or off)
- Composite Video (on or off)
— Transparent Color

Tools:

— Brush Shape
— Change Color (on or off)
— Set Shadow (on or off) and shadow settings
— X,Y Coordinates (on or off)
— Zoom (on or off)
— Ruler (on or off)
— Fix Palette (on or off)
— Graph type and parameters
— Library filename
— Digitize options

• Text font filename

• Changes to the extended palette in 256-color resol
ution modes

To use this feature, first set any or all of the above infor
mation. Then, select Save Defaults from the File menu.
If you are using diskettes, make sure you insert Diskette 1
in the default drive.

A box appears that asks you to confirm that you want to
save defaults. Select YES to continue, or NO to cancel.
If you select YES, any new defaults you have set are
saved in a file called STB.DEF. The new defaults take

effect the next time you start Picture Maker from the
Quick Menu/Setup screen or the DOS prompt.

You can repeat this procedure any time you want to
change one or more of the defaults.

2-155



- Notes for Keyboard Users

• Press the 1 key to move the pointer to the File
menu.

• Use the Cursor keys to move the pointer to a new
selection.

• Use the Plus and Minus keys on the numeric
keypad in place of Buttons 1 and 2, respectively.

• Use the Tab and Shift-Tab keys to move the
pointer in the File Services, Get Capture File, and
Print panels.

• Press Y or N to select YES or NO on the File Ser

vices and Print panels.

This chapter described how to use Picture Maker to create
pictures you can use in Storyboard Plus presentations.
"Learning Picture Maker" on page 2-12 is a tutorial that
contains steps you can follow to familiarize yourself with
some of the Picture Maker features discussed in more

detail elsewhere in the chapter.
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About This Chapter

This chapter describes how to use Picture Taker, the
Storyboard Plus module that lets you take pictures of, or
"capture," graphics and text screens used by other pro
grams as they run on your system. You can edit these
pictures with Picture Maker or Text Maker and use them
in your Storyboard Plus presentations.

Picture Taker captures 40- and 80-column text screens (in
text or graphics mode) and medium- and high-resolution
graphic images.

Picture Taker works by attaching a small program to
DOS that can be switched on and off. When the program
is switched on, a screen capture key you select works like
the shutter button on a camera, capturing the screen you
currently are viewing.

Note: Picture Taker may not be able to capture
screens in applications that bypass the Basic
Input/Output System (BIOS) and program the
Graphics Adapter directly.

The section "Learning Picture Taker" on page 3-6 is a
tutorial designed to help you become familiar with using
this module. Before using this tutorial, you should read
the following section "Starting Picture Taker." Picture
Taker reference information begins with the section
"Setting Picture Taker Options" on page 3-10.
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starting Pietyre Taker

Starting from Fixed Disk
If you started Storyboard Plus by entering sbmenu at the
DOS prompt, you can choose Picture Taker from the
Quick Menu/Setup screen. Highlight Picture Taker in the
Quick Menu, and then press Enter.

You also can start Picture Taker directly from the DOS
prompt by typing pt and pressing Enter. Starting the
module from-the DOS prompt bypasses the Quick
Menu/Setup screen.

After you start Picture Taker, you see the Options panel.
These options are discussed in the section "Setting Picture
Taker Options" on page 3-10. To display this panel at
any time while using Picture Taker, follow the procedures
in this section to restart Picture Taker. _

You also can view information about using these options
while the Options panel is displayed. Press the Tab key to
move the cursor to the option you want information
about, and then press Fl. A box appears with text you
can scroll through by selecting the arrow pointing down.
You also can use the PgDn and PgUp keys to view all of
the help information. When you have finished viewing
this information, press Esc.

Starting from Diskette
To start Picture Taker from diskettes:

1. Highlight Picture Taker on the Quick Menu/Setup
screen using the Cursor Down or Up key, and then
press Enter.

A message appears instructing you to insert a program
diskette.
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2. Remove Diskette 1 from drive A and insert Diskette 3,
if you are using 3.5-inch diskettes, or Diskette 4, if
you are using 5.25-inch diskettes.

3. Press Enter. The Picture Taker Options Panel
appears. These options are discussed in the section
"Setting Picture Taker Options" on page 3-10.

To display the Options panel at any time while using
Picture Taker, follow the steps in this section to restart
Picture Taker.

You also can start Picture Taker from the DOS prompt
without displaying the Quick Menu/Setup screen. Here's
how:

1. In drive A, insert Diskette 3, if you are using 3.5-inch
diskettes, or Diskette 4, if you are using 5.25-inch
diskettes.

2. At the DOS A > prompt, type pt and press Enter.
The Picture Taker Options panel is displayed.
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Learning Picture Taker

This section is a tutorial that introduces you to Picture
Taker by taking you step-by-step through its use. You
will start Picture Taker and then "capture" the screen of a
program we have included on your Storyboard Plus
diskettes. You need at least five minutes to complete this
section. Picture Taker reference information begins with
the section "Setting Picture Taker Options" on page 3-10.

This section does not contain all of the information you
may need to know about Picture Taker. For more infor
mation about this module, refer to the Contents at the
beginning of this chapter or to the Index at the back of
this book for the relevant page numbers in this chapter.

Before using this section, make sure you have backup
copies of the Storyboard Plus diskettes and that the
program has been set up for your system. Chapter 1 dis-
cusses backup and setup procedures. Also refer to ' ^
Chapter 1 if you need information about starting
Storyboard Plus.

If you are using this tutorial, make sure you have read the
section "Starting Picture Taker" on page 3-4 before you
continue.

Note: This tutorial assumes that:

• You use a fixed disk.

• All of the files included on the original
Storyboard Plus diskettes are located in the
same default data path as described in
"Storyboard Plus Setup" on page 1-11.

• You use the 320 x 200 —4 resolution mode.
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Activating Picture Taker
1. Highlight Picture Taker on the Quick Menu/Setup

screen and press Enter. You see the Picture Taker
Options panel.

Sate: nn/nn/nn Fictupe Taker ~

I
Pictur-e Taker- Options

Picture laker- active (y/n)?.,[]]]
Keys useti to capture. .Alt-[u
Convert text to graphics....(tiraphic Hode }i/r!)?..[n]
FilenaHP ,[C:\SIO?t'fBD\PICIURE.CftP

Ose the lah keo to Move to the next iten.
Press Fly to accept all iteHS.

I
Version 2.00

Copyright IBM Corporation 1985, 1987. 1989
Copyright wepec Publishing Corporation Ltd. 1985, 1987, 1989

Fl=HeIP Esc=Exit

Figure 3-1. The Picture Taker Options Panel

The options on this panel are discussed later in this
chapter. You do not need to change any of these set
tings for the purpose of this tutorial.

2. Press FIO to accept the option settings displayed on
this panel. A message informs you that you will exit
Picture Taker.

3. Press Y to continue. You return to the Quick
Menu/Setup screen.

Taking a Picture
1. Press Esc to exit the Quick Menu/Setup screen and

return to the DOS prompt. A message informs you
that you will exit the screen.

2. Press Y to continue. The DOS prompt is displayed.
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3. Enter the following at the DOS prompt:

st doodle

This command starts a program that was included
with Storyboard Plus. The program displays the fol
lowing picture on the screen.

You will capture this picture with Picture Taker.

4. When the picture appears on the screen, press the
A!t-C key combination. After a moment, you hear
three short beeps that indicate Picture Taker has cap
tured the picture that appears on your display.

5. Press Esc to remove the picture and return to the DOS
prompt.

6. Enter sbmenu to return to the Quick Menu/Setup
screen.



Working with the Captured Picture
Because the screen you captured is a graphics screen, you
can use Picture Maker to view and edit the file.

1. Highlight Picture Maker on the Quick Menu/Setup
screen and press Enter. The Picture Maker Main
Menu is displayed.

2. Select Draw from the Picture Maker Main Menu. The

Picture Maker screen is displayed.

3. Select File at the top of the Picture Maker screen (if
using the keyboard as your input device, press 1). The
File menu appears.

4. Select Get from the File menu. The File Services

panel is displayed.

5. Select All files in the center of this panel.

6. Select PICTURE.CAP from the list of files in the
^^*1^ lower right portion ofthe File Services panel. This

file contains the picture you just captured with Picture
Taker.

7. Select YES to get the PICTURE.CAP file. The
picture you captured is displayed on the Picture
Maker screen. Now you can edit the picture as
described in Chapter 2, "Picture Maker."

8. Exit the Picture Maker screen by selecting Main Menu
from the File menu.

9. Press Esc to return to the Quick Menu/Setup screen.
A message informs you that you are exiting Picture
Maker.

10. Press Y to continue.

This concludes the Picture Taker tutorial. The rest of this
chapter contains reference information and instructions
for using Picture Taker.
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S©liirig Pi©tur© Tater Options

Picture Taker options let you determine how the program
works. Use the Tab key to move the cursor to an option
you want to change. You can follow the directions in the
section "Starting Picture Taker" on page 3-4 to display
the Options panel and change these options at any time
while using Storyboard Plus.

The following sections describe each option on the Picture
Taker Options panel. You also can get information about
these options while the Options panel is displayed by
pressing the F1 key. After pressing Fl, a box appears
that displays information about the option where the
cursor is located. To scroll through the information in
the box, select the arrow pointing down. You also can
scroll using the PgDn and PgUp keys. When you have
finished viewing this information, press Esc.

Picture Taker Active

Select this option to switch Picture Taker on and off.
When Picture Taker is active (on), the capture key you
select on the Options panel works like the shutter button
on a camera. Then, while using an application, pressing
the capture key takes a picture of the screen and saves it
in a file.

When Picture Taker is inactive (off), the capture key is
restored to its normal operation although Picture Taker
remains in memory. To remove Picture Taker from
memory, restart your computer.

Keys Used to Capture
Use this option to select the key you press with the Alt
key to capture screens. The key can be any letter or
number key (other than those on the numeric keypad).
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In addition to this capture key combination, the Print
Screen key and the Ctrl-Alt-/ (Slash) key combinations
are always active. If you cannot use the Alt key combina
tion for any reason, try these capture keys instead.

Convert Text to Graphics
This option lets you capture 40- or 80-column text screens
in graphics mode so you can use Picture Maker to add
graphics to the screens. This ability also eliminates the
need to switch between text and graphics modes when
using Story Editor and Story Teller.

You can select the resolution mode in which to capture
text screens. Type the number of the resolution mode you
want to use according to the following table:

Type: To use:
1 320 x 200-4

2 320 x 200-256

3 640 x 200-16

4 640 x 350-16

5 640x480-16

6 640 x 480-256

To capture text screens in text mode, make sure n appears
between the brackets for this option.

Note: Text screens you convert to graphics in the
320 X 200 - 4 and 320 x 200 - 256 resolution modes
should be in 40-column format. If you convert an
80-column text screen in these resolution modes,
only half of the screen is captured.
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Filename

Select this option to enter the drive, directory, and
filename for storing pictures you capture.

Follow DOS file naming conventions when entering the
filename. If you do not enter a drive and directory.
Picture Taker stores the picture file in the drive and direc
tory that are current when you start Picture Taker. If
you do not specify a file extension. Picture Taker adds a
.CAP file extension to the filename.

If you stop a Picture Taker session and later start a new
session with the same drive, directory and filename, pic
tures are added to the end of the file created during the
first session.

Taking Pictures

When you press the capture key to capture a screen,
Picture Taker responds in one of three ways:

3 short beeps
Picture has been taken.

1 short heep
DOS is currently running and the picture will
be taken when the currently active DOS
command has completed. DOS may be waiting
for you to press one or more keys and then the
three short beeps will follow.

High-low sound
A high-low "chirp" sound will be heard if an
error has occurred. Errors can result from

problems such as a diskette or disk that is full,
a write-protected or improperly inserted
diskette, a diskette drive door that is open, or a
bad or unformatted diskette.
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Notes:

1. Picture Taker does not capture host system
screens or pictures displayed in native 3270
mode.

2. If you get incorrect results when trying to
capture graphics screens, the program you are
using may have bypassed the BIOS. Although
the purpose of the BIOS is to provide an inter
face between the system and hardware devices,
some programs do not use the BIOS. When
trjdng to capture screens from these programs.
Picture Taker may not be able to determine the
current display mode.

3. Some programs use a screen resolution of 640
by 480 pixels and offer a selection of more
than 64 colors. When you use the 640 x
480— 16 resolution mode, the colors may vary
in pictures you capture from these programs.

Retriewing the Captured Pictures

Each time you capture a screen, it is added to the end of
the file you named when you set the Picture Taker
options. Because this is a single DOS file, the DIREC
TORY command does not show the number of pictures in
the file. You may wish to keep track of the screens you
have captured and the order in which you captured them.

You can use the Get Picture option in Picture Maker to
view and edit graphics screens you have captured. When
more than one screen is stored in a capture file, each
screen is given a sequential number. Once you have
edited a screen using Picture Maker, it cannot replace the
original picture in the capture file. You should use the
Save Picture option to save it as a new picture.
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Note: When you are taking pictures with the
Picture Taker program, we recommend that Fix
Palette be switched on in the Tools menu of

Picture Maker.

Captured text screens cannot be retrieved by Picture
Maker, but they can be viewed and edited in Text Maker.
Use the Get option in Text Maker to view captured text
screens.

When more than one text screen is stored in a capture file,
each is given a sequential number. For example, when
using Text Maker or Story Editor, you would enter
PICFILE.CAP 3 to get the third captured screen in
PICFILE.CAP.

Once a text screen from a captured file has been modified
by Text Maker, it cannot replace the original screen in the
capture file. You should use the Save option to save it as
a new text screen.

Ciiapt©r Summary

This chapter described how to start Picture Taker, how to
set options that let you control how the program works,
and how to capture screens and use them with other
Storyboard Plus modules. A tutorial instructed you how
to capture a screen and display it using Picture Maker.
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This chapter describes how to use Text Maker, the
module that lets you create and edit text screens for use in
your Storyboard Plus presentations. With Text Maker,
you can create text screens from scratch, or you can edit
text screens you have captured from other applications
using Picture Taker. For example, you can edit a screen
you have captured from a spreadsheet program.

The section "Learning Text Maker" on page 4-6 is a tuto
rial designed to help you become familiar with some of
Text Maker's features. Before using this tutorial, you
should read the following section "Starting and Exiting
Text Maker." Text Maker reference information begins
with the section "Switching between 80- and 40-Column
Display" on page 4-14.

You also can get information about Text Maker while
using it by pressing the F1 key. After pressing Fl, a box
appears that displays information about the option or
feature you are currently using. To scroll through the
information in the box, use the PgDn and PgUp keys.
When you have finished viewing this information, press
Esc.

Note: The keyboard is your input device while
using Text Maker. The mouse is not used with
this program.
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starting and Exiting Text Maker

Starting from Fixed Disk
If you started Storyboard Plus by entering sbmenu at the
DOS prompt, you can choose Text Maker from the Quick
Menu/Setup screen. When this screen first appears, the
Picture Maker selection is highlighted. Use the Cursor
Up or Down key to highlight the Text Maker selection,
then press Enter to display the Text Maker Main Menu.

You also can start Text Maker directly from the DOS
prompt by typing tm and pressing Enter. Starting the
module in this manner displays the Text Maker Main
Menu without first displaying the Quick Menu.

Starting from Diskette
To start Text Maker from diskettes:

1. Highlight Text Maker on the Quick Menu/Setup
screen using the Cursor Down or Up key, and then
press Enter.

A message appears instructing you to insert a program
diskette.

2. Remove Diskette 1 from drive A and insert Diskette 3,
if you are using 3.5-inch diskettes, or Diskette 4, if
you are using 5.25-inch diskettes.

3. Press Enter. The Text Maker Main Menu appears.

4. If you have two diskette drives, insert a formatted
diskette for storing your work in drive B. If you have
one diskette drive, remove the diskette from drive A
and insert a formatted diskette for storing your work.
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You also can start Text Maker from the DOS prompt
without displaying the Quick Menu/Setup screen. Here's
how:

1. In drive A, insert Diskette 3, if you are using 3.5-inch
diskettes, or Diskette 4, if you are using 5.25-inch
diskettes.

2. At the DOS A > prompt, type tm and press Enter.
After a few moments, a message asks you to insert
Diskette 1 in drive A.

3. Remove the diskette from drive A and insert Diskette

1.

4. Press Enter. Another message asks you to insert the
TM Program diskette (this is the first diskette you
inserted).

5. Remove Diskette 1 from drive A and insert the Text
Maker program diskette.

6. Press Enter. The Text Maker Main Menu is dis

played.

7. If you have two diskette drives, insert a formatted
diskette for storing your work in drive B. If you have
one diskette drive, remove the diskette from drive A
and insert a formatted diskette for storing your work.

Exiting Text Maker
To exit the module from the Text Maker Main Menu,
press the Esc key. A message asks you to confirm that
you want to exit the program. Press Y to exit, or press
Enter to keep the Text Maker Main Menu displayed. If
you press Y, the Quick Menu/Setup screen or the DOS
prompt is displayed, depending on how you started Text

^ Maker.
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Learninig Text I

This section is a tutorial designed to introduce you to
some of Text Maker's features. You will create a text

screen that you can use in another tutorial section later in
this manual. You need at least 10 minutes to complete
this section. Text Maker reference information begins
with the section "Switching between 80- and 40-Column
Display" on page 4-14.

This section does not contain all of the information you
may need to know about features you will use. For more
information about Text Maker features, refer to the Con
tents at the beginning of this chapter or to the Index at
the back of this book for the relevant page numbers in
this chapter. You also can get information about Text
Maker while using it by pressing the F1 key.

Before using this section, make sure you have backup
copies of the Storyboard Plus diskettes and that the
program has been set up for your system. Chapter 1 dis
cusses backup and setup procedures. Also refer to
Chapter 1 if you need information about starting
Storyboard Plus.

In this chapter, make sure you have read the section
"Starting and Exiting Text Maker" on page 4-4 before
you continue.

Starting Text Maker
1. Highlight the Text Maker selection on the Quick

Menu/Setup screen by pressing the Cursor Up or Down
key.

2. Press Enter to select Text Maker. When the Text

Maker Main Menu appears. Create or Edit is high
lighted.
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Esc=Exit

3. Start using Text Maker by pressing Enter while Create
or Edit is highlighted. The Text Maker screen is dis
played.

Entering Text
At the bottom of the Text Maker screen you see informa
tion about modes and commands you are using. This hne
is called the status line:

Fl°Kelp -F-B MAIN COtWANO MODE Esc=Quit

The status hne shows you the current foreground color
(F) and background color (B). The message MAIN
COMMAND MODE indicates Text Maker is ready for
you to issue a command.

1. Press X. In the upper right comer of the screen you
see this:

X= 1Y= 1
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This message shows you the current location of the
cursor on the Text Maker screen (column 1, row 1).
As you move the cursor with the Cursor keys, the X
and Y values change to show you the current column
and row location of the cursor.

2. To enter text, press T. Note that the status line now
looks like this:

Fl=Help - -F-B TEXT Esc=Quit

V

The message TEXT reminds you that you are using
the Text command.

3. Move the cursor with the Cursor Right and Down
keys so that X = 22 Y= 9 is displayed in the comer of
the screen.

4. Type the following text on the screen (do not press f""^.
Enter at the end):

Following is a brief demonstration of what

If you press Enter, you end the Text command. If this
happens, press T again.

5. After typing this line, move the cursor down one line,
and then left so X = 35 and Y = 10. You can use the

Tab and Shift-Tab keys to quickly move the cursor
right and left on the screen.

6. Type the following text:

Storyboard Plus

7. Move the cursor down and to the left so that X = 32

andY = 12.

8. Type the following:

can do. Prepared by



9. Move the cursor down one more line and type your
name so it is centered under the other text.

10. To make the text "Storyboard Plus" more noticeable,
let's insert a blank line before it. Move the cursor to

Storyboard Plus and press Alt-I. The text moves
down one line.

11. Insert another blank line after the Storyboard Plus
line. Move the cursor to can do. Prepared by and
press Alt-I again.

12. Press Enter to end the Text command.

Changing Foreground and Background Colors
In this section you will add color to the text screen you
have begun.

1. Press F7 to select a new foreground color (the color of
text or other characters on the screen). You see the
Color/Character Table. The current foreground color
is indicated by the blinking cursor above the color
bar.

none blank eevftf*

*Jabcdef
^hijklwoj^tuv
ImEffioob iduniisScriigii binking cursor

5i><Pj7S

foreground

BLINK none on off

background

ri=HelP Esc=Quit

2. Select a new foreground color by pressing F7 or F8
until the cursor is over the color of your choice.
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3. Press F9 to select a new background color. A
blinking cursor indicates that none is the current back
ground color.

4. Select a new background color by pressing F9 or FIO
until the cursor is under the color of your choice.

5. Press Enter to remove the Color/Character Table and
return to the Text Maker screen.

Note that the new colors you selected are indicated on
the status line. Also note that the text you typed is
still white on a black background. Changing current
foreground and background colors does not automat
ically change existing colors on your text screen.
However, any new text you type appears in the new
colors.

Using the Erase Command
You can change existing colors to the current foreground
and background colors using the Erase command. The
Erase command uses the current character selected in the
Color/Character Table. To keep the text you have
already entered, you must select none as the current char
acter with which to erase.

1. Press F5 to display the Color/Character Table with
the cursor in the Character portion of the table. The
current character is blank.

2. Press F5 to select none as the current character.

3. Press Enter to remove the Color/Character Table and
return to the Text Maker screen.
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4. Move the cursor so X = 21 and Y = 8.

5. Press E. Note that ERASE appears on the status line,
indicating that you are using the Erase command.
Also note that a box in the current background color
appears at the cursor position. The cursor appears in
the current foreground color.



6. Move the cursor down and to the right so X = 64 and
Y = 15. The area encompassed by the cursor move
ment changes to the current foreground and back
ground colors.

7. Press Enter to end the Erase command.

Drawing Boxes
Let's draw a box around the color block you have created
on the screen. But first, let's change the foreground and
background colors again, this time using a feature that
lets you change colors without displaying the
Color/Character Table.

1. Move the cursor so X = 20 and Y= 7.

2. Press Alt-K. The letter I (for Immediate Palette)
appears on the status line. Now as you press F7
through FIO, you cycle through the foreground and
background colors, as displayed by the color of F and

/^^S, B on the status line.

3. Press F7 or F8 to change the current foreground color.
Press F9 or FIO to change the current background
color.

4. Now press B to start drawing a box in the new fore
ground and background colors.

5. Move the cursor down and to the right so X = 65 and S"
Y = 16. A box is drawn around the color block you
created. Note that the character used to draw the box

is a single Une.

6. Press Alt-B to display other choices for the style of
box you just drew.

7. Use the Cursor Right and Left keys to select a dif
ferent box style, then press Enter.

8. When you have finished selecting a box style, press
Enter to end the Box command. MAIN COMMAND

MODE appears on the status Une.
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Altering Colors
Another way to change colors is to use the Alter Colors
feature. This feature lets you change all of one color to
another color.

1. Press Alt-A to change all of one color to another
everjwhere the color appears on the screen. A color
bar and command line appear.

2. Change all of the black on the screen (color A) to
light blue (color D) by typing this command on the
command line:

(bad)

In this command, the b indicates you are altering a
background color. The letter a represents the existing
color, black, that you want to alter. The d indicates
the new color you want to use instead of black.

3. Press Enter. The black is changed to light blue.
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Saving the Text Screen
1. To save the text screen you have been working on,

press Esc. You return to the Text Maker Main Menu.

2. Select Save on the Text Maker Main Menu,

the Save File box:

You see

)ate: nn/nn/nn Text Rakep

MclP Esc=6{it

The default drive and directory are shown in the box.

3. Type CREDITS in the Save File box and press Enter.
A message confirms that the file CREDITS.TXM has
been saved (TXM is an extension Text Maker adds to
the filename).

4. Press Enter to continue. You return to the Text

Maker Main Menu.

This concludes the Text Maker tutorial. You can use the

text screen you created here in the Story Editor tutorial,
"Learning Story Editor" in Chapter 5.
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Switching between 80° and 4i°Columri Display

Select Displays on the Text Maker Main Menu to switch
between 80-column and 40-column display formats (the
default format is 80-column). Use 40-column format for
creating text screens for composite video. After you select
this option, a message informs you of the format you just
switched to. Press Enter to continue.

If you switch from 80-column to 40-column format while
editing a screen, Text Maker preserves the right half of
the screen (columns 41 through 80) even though this
portion is not displayed. When you switch back to
80-column format, the right half of the screen is restored.

Note: The right half of the screen is preserved
unless you save the screen in 40-column format. If
you save an 80-column screen in 40-column
format, the right half of the screen is lost.

Retriewing a Screen to Edit

To edit a text screen you already have created with Text
Maker or captured with Picture Taker, first select Get on
the Text Maker Main Menu. A box appears where you
enter the name of the file containing the text screen.

The default drive and directory you specified when you
set up Storyboard Plus are shown in this box. To get a
file from a different drive or directory, backspace over the
information and include a drive and path with the
filename of the text screen you want to edit.
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For example, if this appears in the Get File box:

A:\

but you want to get the MARCH.TXM file from the
REPORTS subdirectory on drive C, use the Backspace
key to erase A:\, then enter:

c: \reports\niarch.txin

If you are retrieving one screen from a capture or library
file (a file with the extension CAP or LIB), specify the
screen number after the name of the file. For example:

scrnfileJib 5

retrieves the fifth screen in the library named SCRNFILE.

Once you have retrieved the screen, select Create or Edit
on the Text Maker Main Menu. Refer to the next section

for information about using this option.

Creating and Editing Text Screens

To create or edit a text screen, select Create or Edit from
the Text Maker Main Menu. The Text Maker screen

appears. Note the cursor in the upper left corner of this
screen. The cursor's color is the same as the foreground
color where the cursor is located. If you change the fore
ground color from white to yellow, the cursor also
becomes yellow.
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At the bottom of the screen you see information about
Text Maker modes and commands you are using. This
line is called the status line:

Fi=Help - -F-B MAIN COMMAND MODE Esc=Quit

The status line shows you the current foreground color
(F) and background color (B). The message MAIN
COMMAND MODE indicates Text Maker is ready for
you to issue a command.

The status line also indicates you can press F1 to receive
further information contained elsewhere in this chapter.
After you press Fl, a box appears with text you can scroll
through using the PgDn and PgUp keys. When you have
finished viewing this information, press Esc.

To use the last line of the Text Maker screen in the screen

you are creating or editing, suppress the display of the
status line by pressing Alt-X. Press Alt-X again when you
want to redisplay the status line.

Creating text screens involves using Text Maker com
mands and function keys. These commands and keys,
which are summarized on the Quick Reference Card, are
described in the following sections.

Using Color, Characters, and Blinking Text
Each position on the Text Maker screen has three proper
ties: foreground color, background color, and blink
setting. The foreground color is used for characters you
tj^e and lines you draw. The background color is the
color in front of which a character appears.
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through FIO or Alt-J. Pressing one of these keys displays
the Color/Character Table.

none Hank gBHik*
•Xi.ttwflByiiW.-

Sfhijklmopqpstuv

fopegpoand:

none
A

liackgpound:

MellL

*'abcdef

Figure 4-1. The Color/Character Table

cursor

BLINK none on off

EscrQuit

Setting Foreground and Background Colors

To set the foreground color using the Color/Character
table, use the F7 and F8 keys. If the cursor is not in the
Color portion of the Color/Character table, pressing one
of these keys moves the cursor to the color bar over the
current foreground color.

Press F7 to move the cursor left over the color bar; press
F8 to move the cursor to the right. Position the cursor
over the new color you want to use as the foreground
color. Press Enter. The Text Maker screen appears with
the foreground color indicated on the status line.

Use F9 and FIO to set the background color. These keys
work in a similar fashion as when you select foreground
color, except only the first seven colors in the color bar
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are available. After you press Enter to select the back
ground color, the Text Maker screen appears with the
background color indicated on the status line.

You also can set the foreground and background colors
without displaying the Color/Character Table by pressing
Alt-K. The letter I (for "Immediate Palette") appears at
the beginning of the status line. With the letter I dis
played, use the F7 or F8 key to cycle through the fore
ground colors, and F9 or FIO to cycle through the
background colors. To resume using the Color/Character
Table, press Alt-K again.

You can make the current foreground and background
colors the same as those at the cursor position by pressing
Alt-S. The status line changes to reflect the new settings.

Selecting None for Foreground/Background: If you
select none as the foreground or background color. Text
Maker commands which ordinarily use the current fore-
ground and background color to change your text screen
instead leave the existing foreground or background color
unchanged.

For example, if black is the current background color,
using the Erase command will erase characters on a red
background and change the background to black.
However, if you select none as the current background
color, the Erase command will let you erase the characters
but retain the red background.

Selecting none for both foreground and background is
handy for changing just text on screens that use several
foreground and background colors. The text you type
automatically appears in the correct foreground color
against the correct background color.
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Altering Colors

You can change one color to another on all or a selected
area of the screen by following these steps:

1. In command mode on the Text Maker screen, press A
to change a color in an area of the screen you will
select. Or, press Alt-A to change one color everywhere
on the screen to another color.

2. If you pressed A to change color in a selected area,
move the cursor to expand the select box on the
screen, and then press Enter.

A command line appears at the bottom of the screen
where you enter your color changes. Follow this
format when entering color changes:

(bxx)(fjcjc)

where b stands for background and f stands for fore-
ground. The first x represents the color you want to
change; the second x is the color you want to change
it to. Colors are assigned letters as shown on the
screen.

You don't have to change background and foreground
colors at the same time, and you can make more than
one change in a command. For example, the fol
lowing commands are valid:

(fba) Changes foreground (f) from blue (b) to
black (a)

(bba) Changes background (b) from blue (second
b) to black (a)

(fbacd) Changes foreground (f) from blue (b) to
black (a) and from green (c) to cyan (d)
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If you are making the same change in foreground and
background color, you can use one command without
parentheses, as follows:

ba

This command changes blue to black, in both fore
ground and background.

3. After you enter a color change command, you see the
color updated on the screen.

Changing Border Color

You can change the border color of the Text Maker
screen by pressing F3 or F4. These keys cycle through the
16 choices. The border color you choose while creating or
editing a screen is not saved with the screen.

Note: You may not be able to cycle through the
border colors while using the Enhanced Graphics
Adapter (EGA), depending on the EGA switch
settings.

Selecting Characters

You can select characters in the upper portion of the
Color/Character Table by pressing F5 or F6. Selected
characters are used with the Box, Draw, and Erase com
mands.

If the cursor is not in the Character portion of the
Color/Character Table, pressing F5 or F6 moves the
cursor to the current selection. Once the cursor is in the
Character Table, pressing F5 moves it backward and
pressing F6 moves it forward. Ctrl-F5 and Ctrl-F6 move
the cursor up one line and down one line, respectively.
Select a character by pressing Enter.
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Notes:

1. To display a more readable Character Table,
change to 40-column format as described in
"Switching between 80- and 40-Column
Display" on page 4-14.

2. The third character in the last line is a solid
block of the foreground color. The fourth
through seventh characters are blocks that are
half foreground and background colors.

3. To select a character without displaying the
Color/Character Table, press Alt-K. Then use
F5 or F6 to cycle through the characters in the
table. Press Alt-K again to resume use of the
Color/Character table.

Selecting None: If you select none as the character. Text
Maker commands which ordinarily write the current char-
acter on the screen leave the existing characters
unchanged.

This option is handy when you want to change just the
foreground and/or background colors on the screen, and
not the text. For example, if you select none and use the
Erase command, text on the screen is not changed.
However, the area you erase is updated with the current
foreground and background colors.

Selecting Blank: Select blank for use with the Erase or
Draw command to erase part of the screen with the
current background color.

Selecting a Blink Setting

^,1^ Press Alt-J to select a blink setting from the Color/ Char
acter Table. The cursor appears above the current blink
setting on the right side of the Color/Character Table.
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Use the Cursor Right or Left key to move the cursor over
a new blink setting, and then press Enter.

If you select none as a blink setting, commands that
change color or text on the screen leave the existing blink
settings unchanged.

You can make the current blink setting the same as the
setting at the cursor position by pressing Alt-S. The
status line changes to reflect the new setting.

Entering Text
Press T (for the Text command) to type or edit text on
the Text Maker screen. Note that the status line indicates
you are using the Text command.

While typing and editing, use the following keys to move
the cursor and edit text.

Key

Cursor keys

Insert

Delete

Backspace

Home

End

Ctrl-

4-22

Action

Move the cursor up, down, right, and left.

Changes the cursor to a block, indicating
you can insert characters. Press Insert
again to exit insert mode.

Deletes the character at the cursor posi
tion, moving any characters to the right of
the cursor left one space.

Moves the cursor to the left, erasing any
characters one at a time.

Moves the cursor to the beginning of the
current line.

Moves the cursor to the end of text on the

current line.

Same as Home.



Ctrl—* Moves the cursor to the end of the current
line.

Ctrl-Home, -End, -PgUp, -PgDn
Move the cursor to the four corners of the
Text Maker screen.

Shift-*- or -*• Moves the cursor four positions to the left
or right on the current line.

Shift-t or 4 Moves the cursor up or down two lines.

Tab Moves the cursor right to the next tab
position on the current line.

Shift-Tab Moves the cursor left to the previous tab
position on the current line.

Ctrl-Enter Moves the cursor to the beginning of the
next line.

When you have finished typing text, press Enter to keep
what you have typed. To finish without keeping what
you have typed, press Esc.

Drawing with the Cursor Keys
You can draw using the Cursor keys by following these
steps:

1. Press D (for the Draw command) in command mode
at the Text Maker screen. A message after DRAW on
the status line indicates the character that will be used
to draw as you move the cursor.

2. Select a different character to draw with by pressing
the Minus key. Pressing this key cycles through these
choices:

• Single line
• Double line

Dotted line

The character selected in the Color/Character
Table.
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3. Use the Cursor keys to draw with the character indi
cated on the status line. The character appears in the
current foreground and background colors.

4. Use F7 through FIO at any time to change current
colors in the Color/Character Table.

To use a character from the Color/Character Table,
press F5 or F6. Then, position the cursor under the
character you want to use and press the Minus key.
Continue to press the Minus key until you see the
character you selected on the status line.

5. Press Enter when you are finished drawing (or Esc to
cancel what you just drew).

You also can use the Draw command to erase. Make the

current background color the same as the area you want
to erase and select Blank as the character with which to

draw.

Drawing Boxes
You can draw boxes in the current foreground and back
ground colors, and with a frame that you select, by fol
lowing these steps:

1. Move the cursor where you want to start drawing a
box.

2. Press B (for the Box command) while in command
mode at the Text Maker screen. A select box with the

current frame character appears at the cursor position.

3. To change the frame of the box, press the Minus key
to cycle through the choices until you see the frame
you want. You also can press Alt-B to display all of
the choices. With the choices displayed, move the
cursor to the frame you want, and then press Enter.
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The first frame choice is the character selected in the
Color/Character Table. To choose another character
from the table, press F5. Move the cursor to a new
character, and then press Enter.

4. Use the Cursor keys to expand the select box to the
correct dimensions.

5. Press Enter when you have finished drawing the box
(or Esc to cancel drawing the box).

Erasing All or Part of the Screen
Text Maker's Erase command clears all or part of the
screen using the current foreground color, background
color, and character settings. To use this command:

1. Move the cursor to one comer of the area you want
to erase, and then press E (for the Erase command).
Or, to erase the entire screen, press Alt-E.

If you press E, a select box appears in the current
character and color settings. If you press Alt-E, the
entire screen is cleared using the current settings.

2. If erasing part of the screen, use the Cursor keys to
extend the select box. You can change the current
character and color settings by pressing Alt-K and
using keys F5 through FIO as described in "Setting
Foreground and Background Colors" on page 4-17.
Selecting a character other than blank results in the
select box being filled with the character of your
choice.

3. Press Enter when you have finished expanding the
select box and changing color and character settings.
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Cutting and Pasting
You can cut an area of the screen and paste multiple
copies of the area to other parts of the screen. Here's
how:

1. Move the cursor to a corner of the area to cut.

2. Press C (for the Cut command). A select box appears
at the cursor position.

3. Use the Cursor keys to expand the select box and
encompass the area you want to cut.

4. Press Enter to cut the area.

5. Move the cursor to the position where you want to
paste the cut area.

6. Press P (for the Paste command). A copy of the cut
area appears on the screen.

7. Use the Cursor keys to position the copy where you
want to paste it.

8. Press Enter to paste the copy in its new position.

To move a cut area, the steps are similar except that you
erase the area you cut before pasting it. Following are
the steps for moving a cut area.

1. Set the current character and colors in preparation for
erasing the area after you cut it.

2. Move the cursor to one comer of the area you want
to cut.

3. Press C.

4. Expand the select box to encompass the area you want
to cut.

5. Press C again. Pressing C instead of Enter cuts the
area but keeps the select box displayed.

6. Press E to erase the area in the select box.
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7. Press Enter to end erasing.

8. Move the cursor to the position where you want to
paste the cut area.

9. Press P. The area you cut appears on the screen.

10. Move the area into position, and then press Enter to
paste the area on the screen.

Areas you cut can be pasted on other screens. First save
the current screen, and then use the Get option on the
Text Maker menu to retrieve another text screen. Paste

the area on the new screen as described in this section.

Inserting and Deleting Lines
You can insert and delete lines in your text screen. To
insert lines:

1. Move the cursor to the line below where you want to
insert a new line.

2. Press Alt-I (for the Insert command). A line is
inserted, moving lines below it down one line. The
last line is removed from the screen.

To delete lines from the screen, follow these steps:

1. Move the cursor to the line you want to delete.

2. Press Alt-D (for the Delete command). The line is
removed from the screen. All lines below the deleted

line are moved up.

Undoing Your Work
You can undo the last change you made to the screen by
pressing U (for the Undo command) while in command
mode. To restore the change you undid, press U again.

You also can clear the entire screen to black by pressing
Alt-U. Pressing U restores the screen.
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Displaying Screen Coordinates
You can display the current cursor position by line and
column number by pressing X (for the X,Y Coordinates
command) while in command mode. As you move the
cursor, its coordinate position is updated in the upper
right comer of the screen. Press X again to remove the
coordinate display.

To save a screen you have created or edited, press Esc to
leave the Text Maker screen and return to the Text Maker

Main Menu.

Select Save from the Text Maker Main Menu. You see

the Save File box:

}ate: nn/nn/nn Text Hakep

Esc=Exit

Figure 4-2. The Save File Box

The default drive and directory are shown in the box.
Save your screen by typing a filename in the box. If you
do not specify an extension. Text Maker adds TXM as
the extension of your file. To specify no extension,
include a period at the end of the filename.
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To save a screen in a different drive or directory, use the
Backspace key to erase the information shown, then type
a new drive or directory with your filename.

After you press Enter, you see one of two messages. If
you are saving a screen with a new filename, a message
confirms that the file has been saved. Press Enter.

If you are saving the screen with a name that already
exists in the drive and directory you specified, a message
informs you that saving the screen will overwrite (replace)
the existing file on disk. Press Y to continue, or press
Enter to cancel saving the file.

If you press Y, the screen is saved in the file you specified.
The screen also remains in memory so you can continue
editing it.

Note: If you have edited a screen from a library
file, you should save the screen in a different file.
Text Maker does not treat a changed library
screen as part of the library file from which it
came.

Bemoving Screens

You can permanently remove a screen from disk by
selecting Remove on the Text Maker Main Menu. A box
appears where you enter the name of the screen to
remove. Enter the correct drive and directory if they are
different from the displayed default drive and directory.

After entering a filename, a message warns you that the
file will be removed from disk. Press Y to continue, or
Enter to cancel removing the file. If you press Y, a
message informs you that the file has been removed.
Press Enter to continue.
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Working witli Screen Libraries

Text Maker includes a library of text screens you can view
and use by pressing F2 at the Text Maker screen. Press
F2 again to cycle through the available screens in the file.
Press U to exit the library screen and return to the Text
Maker screen.

While viewing a library screen, you can cut an area to be
pasted in the screen you are creating or editing. First cut
the area as described earlier in this chapter, exit the
library screen, and paste the area in the screen you are
working on.

You also can create your own screen libraries. To create
a library, save a screen that you want to include in the
new library with a new filename and the extension LIB.
To add more screens to the new library, use the same
library name and extension. Screens are added at the end
of the library file.

To use a new library while creating or editing text screens,
choose the Select Library Name option on the Text Maker
Main Menu. A box appears where you enter the name of
the library. Enter the correct drive and directory if they
are different from the displayed default drive and direc
tory. Now when you create or edit a screen and press F2,
the new library is used.

Chapter StJinniarf

This chapter described how to use Text Maker to create
and edit text screens for use in your Storyboard Plus pres
entations. "Learning Text Maker" on page 4-6 takes you ^
step-by-step through the creation of a text screen you can
use in other tutorial sections of this manual.
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This chapter describes how to use Story Editor, the
module that lets you create stories.

The section "Learning Story Editor" on page 5-14 is a
tutorial designed to help you become familiar with some
of Story Editor's features. Before using this tutorial, you
should read the following sections "Starting and Exiting
Story Editor," "The Story Editor Screen" on page 5-7 ,
and "Using the Story Table" on page 5-10. Story Editor
reference information begins with the section "Labeling
Story Lines" on page 5-32.

If you are using the keyboard as your input device, look
for boxes labeled "Notes for Keyboard Users." These
boxes contain information about the keys you use instead
of mouse buttons when using Story Editor.

You also can get more information about Story Editor
while using it by moving the pointer to a story table
column, command, parameter, or other menu option and
pressing the F1 key. After pressing Fl, a box appears
that displays information about the option or feature you
are currently using. To scroll through the information in
the box, select the arrow pointing down. You also can
scroll using the PgDn and PgUp keys. When you have
finished viewing this information, press Esc or Button 2.

Starting from Fixed Disk
If you started Storyboard Plus by entering sbmenu at the
DOS prompt, you can choose Story Editor from the
Quick Menu/Setup screen. Use the Cursor Up or Down
key to highlight Story Editor in the menu, and then press
Enter to display the Story Editor Main Menu.
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You also can start Story Editor directly from the DOS
prompt by typing se and pressing Enter. Starting the
module in this manner displays the Story Editor Main
Menu without first displaying the Quick Menu/Setup
screen.

The first selection on the Story Editor Main Menu takes
you to the Story Editor screen. The other selections on
this menu let you set up your input device and printer as
you did in the section "Storyboard Plus Setup" on
page 1-11. You can use these selections to change this
information just for the current Story Editor session. The
next time you use Story Editor, the information again is
set according to the selections you made by pressing F2 at
the Quick Menu/Setup screen.

Starting from Diskette
To start Story Editor from diskettes:

1. Highlight Story Editor on the Quick Menu/Setup
screen using the Cursor Down or Up key, and then
press Enter.

A message appears instructing you to insert a program
diskette.

2. Remove Diskette 1 from drive A and insert Diskette 3,
if you are using 3.5-inch diskettes, or Diskette 5, if
you are using 5.25-inch diskettes.

3. Press Enter. The Story Editor Main Menu appears.

4. If you have two diskette drives, insert a formatted
diskette for storing your work in drive B. If you have
one diskette drive, remove the program diskette from
drive A and insert a formatted diskette for storing
your work.
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You also can start Story Editor from the DOS prompt
without displaying the Quick Menu/Setup screen. Here's
how:

1. In drive A, insert Diskette 3, if you are using 3.5-inch
diskettes, or Diskette 5, if you are using 5.25-inch
diskettes.

2. At the DOS A > prompt, type se and press Enter.
After a few moments, a message asks you to insert
Diskette 1 in drive A.

3. Remove the diskette from drive A and insert Diskette

1.

4. Press Enter. Another message asks you to insert the
SE Program diskette (this is the first diskette you
inserted).

5. Remove Diskette 1 from drive A and insert the Story
Editor program diskette.

6. Press Enter. The Story Editor Main Menu is dis
played.

7. If you have two diskette drives, insert a formatted
diskette for storing your work in drive B. If you have
one diskette drive, remove the program diskette from
drive A and insert a formatted diskette for storing
your work.

Note: To eliminate diskette swapping when
starting Story Editor from the DOS prompt, use
the DOS COPY command to copy the STB.CLR
and STB.PRO files from Diskette 1 to Diskette 3

or Diskette 5. If in the future you change setup
information from the Quick Menu/Setup screen,
you must copy these files again to Diskette 3 or

^ Diskette 5.
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The first selection on the Story Editor Main Menu takes
you to the Story Editor screen. The other selections on
this menu let you set up your input device and printer as
you did in the section "Storyboard Plus Setup" on
page 1-11. You can use these selections to change this
information just for the current Story Editor session. The
next time you use Story Editor, the information again is
set according to the selections you made by pressing F2 at
the Quick Menu/Setup screen.

Exiting Story Editor
To exit the module from the Story Editor Main Menu,
press Button 2. A message asks you to confirm that you
want to exit the program. Press Button 1 to exit, or press
Button 2 to keep the Story Editor Main Menu displayed.
If you press Button 1, the Quick Menu/Setup screen or the
DOS prompt is displayed, depending on how you started
Story Editor.
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— Notes for Keyboard Users

Press Esc to exit Story Editor from the Story Editor
Main Menu. Press y to continue, or press Enter to
keep the Story Editor Main Menu displayed.

Story Editor lets you display pictures created in resolution
modes that are lower than the current resolution mode

(the current resolution mode is displayed with the first
option on the Story Editor Main Menu). If you are using
the 640 X 480— 16 resolution mode, you also can display
pictures created in the 640 x 480 —256 resolution mode.

Note, however, that your stories run most efficiently when
the pictures you display have been created in the current
resolution mode.



The Story Editor Screen

With the Edit Story selection highlighted on the Story
Editor Main Menu, pressing Button 1 (or the Enter key)
displays the Story Editor screen. The parts of this screen
have been labeled in the following figure.

• File Edit tlodes Run (c) IBM 19BS j

NO^ •liiiliBCOmND PRRfltlETERS TltlE UfilT

1
2 /xStory Last Line 8 8

story talile

storynonitor

biittoii/fienory status

nenory Used: 8 X

Editing Keys
F2 Edit Drive\Path

Ifllt-F2 Set Story Driye\Path
F3 Copy Data Fron fibove

fllt-I Insert Line
fllt-E Erase Line
filt-B nark Block
fllt-C Copy Block
Alt-D Delete Block
fllt-U Unnark Block

Figure 5-1. The Story Editor Screen

Note: Throughout this chapter, you are instructed
to select something on this screen. "Selecting"
means to move the arrow, or pointer, on the screen
until the tip of the pointer touches an object.
Then you press Button 1. Unless otherwise indi
cated, making a selection involves pressing Button
1. When you are required to press Button 2, you
are explicitly instructed to do so.

Following is a brief description of each part of the Story
Editor screen.
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Screen Area Description

Story table The story table is where you enter infor
mation about your story. The story table
is discussed in more detail in the next

section, "Using the Story Table."

Menu area Each word in the menu area represents a
separate menu you can display by selecting
the word. For example, selecting File dis
plays the File menu. With a menu dis
played, you can select any option from
that menu.

Story monitor The story monitor lets you preview your
story as you create it.

Button and memory status area
Buttons 1 and 2 often are used in oper
ations where the buttons have an active or

inactive state. The button status boxes

indicate these states as follows:

kttoii status uenory status

lleHory Used: (8 f.

Buttons 1ani 2
inactive

Button 1

active

Button 2

active

Figure 5-2. Button Status Boxes

Next to the button status boxes is an indication of the

percentage of memory your story has used.



To return to the Story Editor Main Menu from the Story
Editor screen, select Main Menu from the File menu.

— Notes for Keyboard Users

Making a selection involves moving the pointer with
the Cursor keys until the tip of the pointer touches an
object you want to select. Then press the Plus key on
the numeric keypad in place of Button 1 on the mouse.
When you are instructed in this chapter to press
Button 2, press the Minus key on the numeric keypad.

Use the following keys to display the menus at the top
of the Story Editor screen.

Menu Key
File Alt-1

Edit Alt-2

Modes Alt-3

Run Alt-4

Pressing one of these keys displays the menu options
and moves the pointer from the current position to the
selected menu. To choose a menu option, highlight
your choice using the Cursor Up or Down key, and
then press the Plus key. The pointer returns to the
story table. If you make a selection by mistake, press
the Esc key to exit the selection.
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You create your story using the story table. This table
contains all of the information about your story,
including the picture files to be used. Each line in the
story table represents one step in the story. The high
lighted line in the story table is called the current story
line. You use the pointer to select the area, or column, on
the current story line in which to enter information.

story table coIunhs
•

w LABEL connAND PARAttETERS TirtE UAIT

—

T 5 p.f p-f 1 ill11 "1
/*Story Last Line

• •
current story line

story lines

Figure 5-3. The Story Table

The number of lines your story can have varies depending
on the number of labels, comments, and directory
locations of the files used by your story. On the average,
a story can contain 450 story lines. The line numbers are
displayed on the left side of the story table.

You can scroll the story table to see all lines by moving
the pointer above or below the current story line and
pressing Button 1. This scrolls the story table up or down
one line. You also can scroll continuously to the begin
ning or end of the story by moving the pointer above or
below the current story line and pressing Button 2. To
halt continuous scrolling, press Button 2 again.
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You also can use the following keys to scroll the story
table.

Key Action

PgUp Displays the previous five or 11 lines of your
story, depending on the resolution mode you are
using.

PgDn Displays the next five or 11 lines of your story,
depending on the resolution mode you are using.

Home Goes to the first line of the story.

End Goes to the last line of the story.

When you select a column in the current story line, a list
appears of the possible entries in that column on the
current story line. You select the entry just as you would
select an item from a menu.

When you enter information on the last line of a story,
another line is automatically added to the story table.
There always is one blank line between the current story
line and the last line of the story.

If you edit an existing story to make a new one, you see
many lines in the story table that represent the steps in
the existing story. Any of this information can be
changed to create a new story. To change a line, scroll
the story table so the line becomes the current story line.

As you become more familiar with creating and editing
stories, you can save time by pointing to a column on the
current story line and typing information from the key
board. As soon as you type a unique letter. Story Editor
completes the entry for you.
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For example, you can select the COMMAND column,
and then select /DISPLAY from the command list to
enter the /DISPLAY command on the current story line.
Or, you can move the pointer to the COMMAND column
and type /d. The /DISPLAY command appears on the
current story line.

While typing in the story table in this manner, you can
use the following keys;

Key Action

t, I Scroll the story table up and down.

Tab Move pointer one column to the right.

Shift-Tab Move pointer one column to the left.

Alt-I Inserts a line before the current story line.

Alt-E Erases the current story line.

Alt-B Marks the current story line.

Alt-C Copies the marked block of lines before
the current story line.

Alt-D Deletes a marked block of story lines.

Alt-U Unmarks a block of lines.

Shift-<- Moves the pointer to the beginning of the
current story line.

Shift—* Moves the pointer to the end of the
current story line.

These key assignments are shown in the story monitor for
your convenience. For more information about inserting,
deleting, marking, and copying story lines, refer to the
section "Editing Stories" on page 5-80.

5-12



Notes for Keyboard Users

Use the following keys to move the pointer in the
story table.

Key

ta

Y

N

PgUp
PgDn

Tab

Shift-Tab

Shift-<-

Sbift-H^

Action

Move the pointer one column in the
direction of the arrow.

Scroll the story one line in the direction
of the arrow.

Confirms selection.

Exits panel without executing selection.
Displays previous panel selection lines.
Displays additional panel selection
lines.

Moves pointer one column to the right.
Moves pointer one column to the left.
Moves the pointer to the beginning of
the current story line.
Moves the pointer to the end of the
current story line.
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Learning Story Editer

Story Editor has several special features that help you
make attractive presentations. For example, you can
select any of several picture-to-picture transition methods
that allow one picture to dissolve into another.

This section is a tutorial designed to introduce you to
some of these features. You will be given the option of
using pictures you created in the section "Learning Picture
Maker" on page 2-12, or, if you did not use this section,
pictures that have been included with the other
Storyboard Plus files. You need at least 20 minutes to
complete this section. Story Editor reference information
begins with the section "Labeling Story Lines" on
page 5-32.

This section does not contain all of the information you
may need to know about features covered in this tutorial.
For more information about Story Editor features, refer
to the Contents at the beginning of this chapter or to the
Index at the back of this book for the relevant page
numbers in this chapter. You also can get information
about Story Editor while using it by pressing the F1 key.

Before using this section, make sure you have backup
copies of the Storyboard Plus diskettes and that the
program has been set up for your system. Chapter 1 dis
cusses backup and setup procedures. Also refer to
Chapter 1 if you need information about starting
Storyboard Plus.

In this chapter, make sure you read the sections "About
This Chapter" on page 5-3, "Starting and Exiting Story
Editor" on page 5-3, "The Story Editor Screen" on
page 5-7, and "Using the Story Table" on page 5-10,
before getting started.
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Note: This tutorial assumes that:

• You use a fixed disk.

• All of the files included on the original
Storyboard Plus diskettes are located in the
same default data path as described in
"Storyboard Plus Setup" on page 1-11.

• You use the 320 x 200 —4 resolution mode.

If any of these assumptions are not true for you,
steps may be added or missing from the tutorial or
your screen may differ slightly from the screens
shown in this book.

Starting Story Editor
1. Select Story Editor on the Quick Menu/Setup screen.

When the Story Editor Main Menu appears, Edit
Story is highlighted. The resolution mode you
selected when you set up Storyboard Plus is displayed
next to Edit Story.

2. Select Edit Story. The Story Editor screen is dis
played.

File Edit nodes Ran (c) IBM 1SB9

NO. LABEL

/»(Story Last Line

EDIT LINE

nenory Used:

PRRAnETERS TINE UAIT

Editing Kegs
F2 Edit Drive\Path
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Retrieving a Story to Edit
1. Select Get Story from the File menu.
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The File Services panel appears for you to select a
story. Look for the box labeled Filename on the File
Services panel.
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2. Select TUTORIAL.SH~ from the list of files in the
Filename box.

3. Select YES on the File Services panel to get the story
named TUTORIAL.SH~. The story is displayed in
the story table.

Editing a Story
Now you are ready to use the story table to edit the
TUTORIAL.SH~ story. Because you are building on an
existing story, lines 2, 3, 11, 12, and 13 already have been
completed. You will be entering information on line 1
and lines 4 through 10 of the story.

1. Select the PARAMETERS column by moving the tip
of the pointer to the PARAMETERS column on the
current story line and pressing Button 1. A list of
parameters for the /DISPLAY command appears.
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2. Select Input Name from the list of parameters. A
blinking asterisk appears in the PARAMETERS
column of the current story line.
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3. If you used the Text Maker tutorial to create a file
called CREDITS.TXM, type CREDITS.TXM in the
PARAMETERS column and press Enter.

If you did not create this file, type CREDITS2.TXM
and press Enter.

4. Select the WAIT column on the current story line to
determine how long the text screen will be displayed.

5. Select Input Wait Delay from the WAIT options. A
blinking asterisk appears in the WAIT column.

6. Type 4 and press Enter.

Editing Lines 4 through 8 of the Story
Now you will start displaying pictures created with
Picture Maker.

1. Move line 4 to the current story line by positioning
the tip of the pointer below the current story line and
pressing Button 1 three times (the pointer changes to
an arrow pointing down). Line 4 scrolls to the current
story line.
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2. Select the COMMAND column on the current story
line. A list of commands is displayed.
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3. Select /CLEAR from the command list. This
command clears all or part of a picture displayed in a
story.

4. Select the PARAMETERS column on the current
story line. The parameter used with the /CLEAR
command, Get Color, is displayed. This parameter
lets you select the color with which to clear the
picture.
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5. Select Get Color. The Get Color panel appears.
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6. Select the color white from the Graphics column on
the right side of the panel. (If you are not using the
320 X200- 4 resolution mode, the Get Color panel
displays onecolumn of colors. Select white from this
column.)

7. Select the TIME column on the current story line to
enter the amount of transition time needed to go from
one screen to the next.

8. Select FAST.



9. Select the METHOD column on the current story line.
A list of dissolve methods is displayed.
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10. Select CHECKER from the METHOD column. Note

that NONE automatically appears in the DIR and
LINE columns. Some dissolve methods, such as
CHECKER, do not use these columns, which let you
determine the direction of the dissolve and whether a

line is used.

This completes line 4 of your story.

11. Scroll line 5 to the current story line.

12. Select the COMMAND column on the current story
line.

13. Select /DISPLAY from the list of commands.

14. Select the PARAMETERS column on the current

story line. The parameters for the /DISPLAY
command appear.

15. Select Get Existing Name from the list of parameters.
The File Services panel is displayed.
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16. If you are using pictures you created from the Picture
Maker tutorial, select PC2.PIC from the Filename
box. If you are not using pictures you created, select
PC2A.PIC.
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17. Select YES to get the file.

18. Select the WAIT column on the current story line.

19. Select Input Wait Delay. A blinking asterisk appears
in the WAIT column.

20. Type 2 and press Enter.

21. Select the METHOD column on the current story line.

22. Select FADE from the METHOD column. FADE is

another dissolve method that does not use the DIR

and LINE columns.

23. Make sure that FULL appears in the AREA column.

This completes line 5 of your story.

24. Scroll line 6 to the current story line.
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25. Repeat step 12 through step 16 on page 5-22, except
select PC3.PIC from the File Services panel (or
PC3A.PIC, if you did not use the Picture Maker tuto
rial).

26. Move the pointer to the WAIT column, but do not
press Button 1.

27. Press F3 to use the WAIT value from the previous
story line. The WAIT value 2 appears in the WAIT
column on the current story line.

28. Select the METHOD column on the current story line.

29. Select REPLACE from the METHOD column.

30. Select the DIR column on the current story line.

31. Select LEFT from the DIR column.

32. Make sure that FULL appears in the AREA column.

This completes line 6 of your story.

33. Scroll line 7 to the current story line.

34. Repeat step 12 through step 16 on page 5-22, except
select PC4.PIC from the File Services panel (or
PC4A.PIC, if you did not use the Picture Maker tuto
rial).

35. Move the pointer to the WAIT column, but do not
press Button 1.

36. Type 4 in the WAIT column. The pointer disappears,
and 4 appears in the WAIT column. This is a short
cut to entering information in the story table. Press
Enter.

37. Select the METHOD column on the current story line.

38. Select PUSH from the METHOD column.

39. Select the DIR column on the current story line.

40. Select RIGHT from the DIR column.
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41. Make sure that FULL is in the AREA column.

This completes line 7 of your story.

42. Scroll line 8 to the current story line.

43. Select the COMMAND column on the current story
line.

44. Select /CLEAR from the list of commands.

45. Select the PARAMETERS column on the current
story line.

46. Select Get Color from the PARAMETERS column.

47. Select the color white from the Graphics column on
the right side of the Get Color panel.

48. Select the METHOD column on the current story line.

49. Select WEAVE from the METHOD column. NONE
appears in the DIR and LINE columns.

50. Make sure that FULL is in the AREA column.

This completes line 8 of your story.

Lines 9 and 10—Displaying Partial Pictures
On lines 9 and 10, you will display parts of a picture to
achieve a special effect.

1. Scroll line 9 to the current story line.

2. Select the COMMAND column on the current story
line.

3. Select /DISPLAY from the COMMAND column.

4. Select the PARAMETERS column on the current
story line.

5. Select Get Existing Name from the PARAMETERS
column.
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6. Select GRAPH.PIC from the File Services panel (or
GRAPH2.PIC, if you did not use the Picture Maker
tutorial).

7. Move the pointer to the WAIT column, type 3, and
press Enter.

8. Select the METHOD column on the current story line.

9. Select EXPLODE from the METHOD column.

10. Select the AREA column on the current story line.

11. Select PART from the AREA column.
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Selecting PART allows you to have certain pictures
"develop" on your display screen as a series of partial
pictures. As with full pictures, each line in the table
represents one step in the resulting show, so each partial
picture must be on a separate line in the story.
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13. Select Set on Monitor. This allows you to use a select
box to define the coordinates or location of the partial
picture and the location where you want the partial
picture to be displayed.

14. Move the pointer into the story monitor area but
outside the select box.

15. Press Button 1. The pointer becomes a crosshair.



16. Position the crosshair in the story monitor area as
shown and press Button 1.
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17. Move the mouse to stretch the select box and sur
round the title of your graph.

18. Press Button 2 to fix the select box to the screen.

19. Move the pointer inside the select box and press
Button 1. The previous picture appears as background
behind the select box.

20. Press Button 2. The coordinates in the TO SCREEN
column change to reflect the partial picture you just
defined (the title of the graph).

This completes line 9 of your story.

21. Scroll line 10 to the current story line.

22. Select the COMMAND column on the current story
line.

23. Select /DISPLAY from the COMMAND column.
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24. Move the pointer to the PARAMETERS column.

25. Press F3. The filename you selected for the PARAM
ETERS column on line 9 is entered in the PARAME

TERS column on line 10.

26. Move the pointer to the WAIT column, type 4, and
press Enter.

27. Select the METHOD column on the current story line.

28. Select EXPLODE from the METHOD column.

29. Select the LINE column.

30. Select No Line from the LINE column. NONE

appears in the line column, indicating that no border
will be used with the picture as it "explodes" onto the
screen.

31. Select the AREA column on the current story line.

32. Select PART from the AREA column.

33. Select the TO SCREEN column.

34. Select Set on Monitor.

35. Move the pointer into the monitor area but outside
the select box and press Button 1. The pointer
becomes a crosshair.
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36. Position the crosshair as shown and press Button 1.
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37. Move the mouse to stretch the select box and sur

round the graph.

38. Press Button 2 to set the select box to the screen.

39. Move the pointer inside the select box and press
Button 1. Again the previous full picture appears as
background to the select box.

40. Press F5 to see the graph title you previously selected.

41. If you wish, reposition the graph in relation to the
title by moving the pointer inside the select box and
pressing Button 1 again. Then, move the graph.

42. Press Button 2. The coordinates in the TO SCREEN

column are updated to reflect the partial picture of the
graph you just created, and its new position on the
screen.

When you view your story, the title of the graph will
appear first, and then the graph will appear (the title
remains on the screen).
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Accessing Picture Maker from Story Editor
If your text is too close to the graph and you are having
difficulty surrounding the area with the select box, you
can return to Picture Maker from Story Editor to move
the text away from the graph.

1. Select Modes from the Story Editor menu area.

2. Select Picture Maker. The Picture Maker screen

appears.

3. Select File from the Picture Maker menu area.

4. Use the Get Picture option to retrieve the
GRAPH.PIC (or GRAPH2.PIC) file.

5. Move the text away from the graph using the Move
option and the Select icon.

6. Use the Save Picture option on the File menu to save
the picture file.

7. Select Story Editor from the File menu in Picture
Maker to return to Story Editor.

Running a Story
Now that you have defined how you want to present a
story, you can run it to see how it looks.

1. Press the Home key to return to the first line of the
story.

2. Select Modes from the Menu area.

3. Select Full Screen from the Modes menu.

4. Select Run from the Menu area.

5. Select Run Story from the Run menu.

The story is shown on the full screen. When the last line
of the story is reached and there is no command, such as
GOTO, to start the story over again, you return to the
Story Editor screen.
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Saving Your Story
Before exiting the Story Editor program, be sure to save
your story. You can save your story using the Save Story
option on the File menu, which displays the File Services
panel. You also can use Quick Save by following these
steps:

1. Press Alt-F8. The Quick Save panel appears.
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The name of the story you have been working on,
TUTORIAL.SH~, appears on this panel.

2. To save your story under a different name, move the
pointer to TUTORIAL.SH~ and press Button 1. The
story name disappears. A blinking cursor indicates
you can type a new name.

3. Type TUTOR and press Enter. Your story is saved in
the current drive and directory under its new name.

This concludes the Story Editor tutorial. You can use the
story you created here in the Story Teller tutorial,
"Learning Story Teller" on page 6-3.
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The LABEL column lets you assign a label to a story line.
Labels are used by some Story Editor commands to
control the flow, or "plot," of your story. To work with
labels, point to the LABEL column on the current story
line and press Button 1. The LABEL options are dis
played.
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Figure 5-4. The LABEL Options

The first option on this menu lets you type a label on the
current story line. You also can move the pointer to the
LABEL column and start typing a label directly onto the
current story line without displaying the LABEL options.
When you have finished typing a label, press Enter or the
Tab key to move to the next column.

The following sections discuss how to use the LABEL
options to type, remove, and go to labels in your story.
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Inputting a Label
To input a label on the current story line, select Input
Label from the Label options. A blinking asterisk
appears in the LABEL column on the current story line.

Type a label of up to five characters. The label must not
already be used on another story line in the same story.
Pressing any character key or the Spacebar blanks out the
current entry. You can use the Cursor Left and Right,
Insert, Delete, Spacebar, and Backspace keys while typing
a label or editing an existing label. To exit without
entering a label, press Esc.

Press Enter after typing a label. The label appears in the
LABEL column on the current story line. To input a
label on another line, scroll the story table so the line
becomes the current story line, then repeat the steps in
this section.

Removing a Label
To remove the label from the current story line, select No
Label from the Label options. The label is removed from
the line. To remove a label from another line in the
story, scroll the story table so the line becomes the current
story line, and then select No Label again from the Label
options.
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Goto Label

This option allows you to immediately go to any labeled
line in your story. To use this option, select Goto Label
from the Label options. The Goto Label panel appears.
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To scroll through the Goto Label panel, select the arrow
pointing down or up. Then, select the label of the line
you want to go to. The story table scrolls to the line with
the label you chose.

To exit the Goto Label panel without making a selection,
press Button 2.

St©rf Editor Commands and Parameters

The COMMAND column lets you use Story Editor com
mands that serve several purposes in your story. They
enable you to do the following;

• Display and clear pictures and screens
• Control the flow of your story
• Use music, voice, and sound effects in your stories
• Run other programs from within your story
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• Use moving figures called sprites
• Lock the keyboard while a story is running
• Print the pictures in a story
• Deactivate a story line
• Insert comments in your story

You can view a list of commands by moving the pointer
to the COMMAND column on the current story line and
pressing Button 1.
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Figure 5-6. Story Editor Commands

To enter a command on the current story line, select a
command from the list. Or, move the pointer to the
COMMAND column and start typing the command,
beginning with /. As soon as Story Editor recognizes the
command you want to use, the rest of the command
appears on the current story line. Refer to "Using the
Story Table" on page 5-10 for more information about
typing information in the story table.

You also can move the pointer to the COMMAND
column on the current story line and press F3 to use the
command from the previous story line. The command is
entered on the current story line.
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The following sections describe how to use the Story
Editor commands. These sections also describe how to

use the parameters that are associated with most of the
commands. After selecting a command, you can view its
parameters by selecting the PARAMETERS column on
the current story line. As with commands, you also can
point to the PARAMETERS column and type informa
tion directly onto the current story line.

With the pointer in the PARAMETERS column, pressing
F3 enters the filename or parameter from the PARAME
TERS column of the last story line that used the same
command.

Displaying images
The /DISPLAY and /SHOW commands enable you to
display all or part of a file created with Picture Maker,
Picture Taker, or Text Maker.

Pictures or screens you display using the /DISPLAY
command remain on the screen until another command,
such as another /DISPLAY command, removes them.
With the /SHOW command, a picture or screen is
removed when the next story line is executed. The only
dissolve method available with the /SHOW command is
FADE.

You can use the /DISPLAY command with the dissolve
method NONE to change all or part of a picture before
displajdng it on the screen. The altered picture can be
displayed on a following story line using another
/DISPLAY command or the /SHOW command.

After you select /DISPLAY or /SHOW, additional
columns appear on the Story Editor screen. The options
in these columns determine how /DISPLAY and /SHOW
commands are used. Refer to "Additional Story Table
Columns" on page 5-65 for more information.
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Switching Resolution Modes, Display Modes, and Palettes

Story Editor lets you display pictures created in resolution
modes that are lower than the current resolution mode

(the mode displayed with the first option on the Story
Editor Main Menu). If you are using the 640 x 480- 16
resolution mode, you also can display pictures created in
the 640 X 480 - 256 resolution mode.

Pictures created in 320 x 200 —256 resolution mode can be

displayed in a 16-color resolution mode, but distortion
may occur.

Note that your stories run most efficiently when the pic
tures you display have been created in the current resol
ution mode.

After you display a graphics screen, Story Editor is in
graphics mode. After displaying a text screen, the
program is in text mode. The /DISPLAY and /SHOW
commands are the only commands that let you switch
between graphics and text modes. As the first step in
switching modes, the screen is cleared to black.

While in text mode, commands such as /CLEAR and
/COLOR execute in text mode until you use the
/DISPLAY or /SHOW command to display a graphics
image. The /SPRITE command is ignored while the story
is in text mode.

To display a picture that uses a different palette than the
previous picture, use the /SHOW command or use the
/CLEAR command before displaying the picture. If you
are using a 256-color resolution mode, you can use the
BLEND dissolve method as an alternative.
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Selecting the Image to Display

Select the image you want to use with a /DISPLAY or
/SHOW command by moving the pointer to the PARAM
ETERS column and typing the name of the file. Or,
select the Get Existing Name or Input Name parameter
from the PARAMETERS column. You can view the file

you select using the View Picture parameter. The fol
lowing sections describe how to use these parameters.

Get Existing Name Parameter

After you select Get Existing Name from the PARAME
TERS column, the File Services panel appears.

The box at the top of this panel shows the currently
selected drive and directory. The left side of the middle
box is where you decide which files will be listed in the
Filename box in the lower right portion of the panel.

When using Get Existing Name, .PIC files is highlighted
in the middle portion of the panel, which means only files
with the extension PIC are listed in the Filename box. To

list just capture files, select .CAP. To list just text files,
select .TXM. To list all files in the current directory,
select All files.

The bottom portion of the panel is where you select the
drive, directory, and name of the file to get. In each of
the Drive, Directory, and Filename boxes, arrows
pointing up and down on the right side of the box enable
you to scroll through the list when there are more entries
than those displayed.

Select the name of the file you want to get from those
listed in the Filename box. Or, select Type in the
Filename box to enter the name of a file.
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If you selected the name of a file, select YES to get it (or
NO to cancel). If you selected Type, type the name of the
file and press Enter.

Note: Before pressing Enter, type a period (.)
after the filename to type a new file extension.

The File Services panel is removed. The filename you
selected or entered appears in the PARAMETERS
column. If the file is located in a different drive or direc

tory than the current story, the file's path is displayed in a
box in the lower left portion of the screen.

Using the Get Capture File Panel: Selecting a file that
contains more than one image displays the Get Capture
File panel.

Current

EDIT L

• O'

Get Capture File

Get Picture
Uieu Picture

2 - Text

Figure 5-7. The Get Capture File Panel

To preview images before retrieving them, select the image
from the numbered list on the Get Capture File panel. If
there are more pictures in the list than those displayed,
select the arrows pointing down and up to scroll through
the list. Then select View Picture.

5-39



To view successive images in the file, press Button 1 while
previewing an image. The next image in the file is dis
played. Press Button 2 to return to the Get Capture File
panel.

Note: Text files can display only on a full screen.
Even if Monitor mode is selected, the text image
will still display on the full screen.

To retrieve an image, select the image from the list. Then
select Get Picture. You return to the Story Editor screen.
The filename and image number you selected appear in
the PARAMETERS column.

To exit the Get Capture File Panel without selecting an
image, select Exit. You return to the Story Editor screen.

Input Name Parameter

This parameter allows you to type a filename directly into
the PARAMETERS column without using the File Ser-
vices panel. When you use this parameter. Story Editor
assumes that the picture is in the same drive and directory
as the story you are editing. You can use this parameter
and then change the drive and directory of the picture as
described in "Changing the Drive and Directory of a File"
on page 5-84.

After you select this parameter, a blinking asterisk
appears on the story line. Type a filename. To change
the file extension, tj^e a period (.), then the new exten
sion. If the file contains more than one image, type a
hyphen (-) and the image number after the filename.

Pressing any character key or the Spacebar blanks out the
current entry. You can use the Cursor Left and Right
keys. Insert, Delete, Spacebar, and Backspace while typing
the filename or editing the current entry. To exit without
entering a filename, press Esc.
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Press Enter when you have finished typing the filename.
The filename appears on the story line next to the
asterisk.

View Picture Parameter

Selecting this parameter displays the picture or screen you
have selected to use with a /DISPLAY or /SHOW
command. The picture appears in the monitor area or on
the full screen, depending on the option you select from
the Modes menu.

This parameter is helpful when you are not certain you
have selected the correct file. Viewing a picture or screen
in this manner does not alter the information on the

current story line.

If you are viewing the picture on the full screen, press
Button 1 to return to the Story Editor screen.

Changing image Coiors

Using the /COLOR Command

Select /COLOR to change the color of all or part of the
picture displayed on the screen. The picture is not
removed, but a color you choose is changed to another
color. You can change two colors with one /COLOR
command by selecting the Get 2 Colors parameter.

/COLOR can be used with dissolve method NONE to
alter one or more partial picture areas before any action is
seen on the screen. The altered picture can be displayed
using the /DISPLAY or /SHOW command on a following
line in the table.

After you select /COLOR, additional columns appear in
the lower left corner of the Story Editor screen. The
options you choose in these columns determine how the
/COLOR command is used. Refer to "Additional Story
Table Columns" on page 5-65 for more information.
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Followingis a description of the parameters for this
command.

Get 1 Color Parameter: Get 1 Color allows you to
choose a color on all or part of the screen to replace with
another color of your choice.

After you select this parameter, the From Color panel
appears.

FroH Color

DRRK GRAY

L.GREEH

L.RED
BLUE

L.BLUE
BROUN

YELLOU
nfiGENIfl

CYRH
L.CYflH
UHITE

Graphics

(C) IBM 1SB9

PftRflnETERS TiriE URIT

Editing Keys
F2 Edit DriveNPath

t-F2 Set Story Drive\Path
F3 Copy Data Fron Above

It-I Insert Line
llt-E Erase Line
It-B nark Block
It-C Copy Block
It-D Delete Block
It-U UnHark Block

Figure 5-8. The From Color Panel (320 x 200-4 resolution mode)

Select the color you want to replace from this panel. If
you are using the 320 x 200—4 resolution mode, select the
color from the left column for displaying a screen in text
mode. Select a color to replace from the right column for
displaying a graphics picture. If you are using a resol
ution mode other than 320 x 200 - 4, you select the color
to replace from just one column of 16 colors. The
number of the color you select is entered in the PARAM
ETERS column, and the To Color panel appears.

Select the color you want to replace the first color. The
color number appears in the PARAMETERS column.

5-42



Get 2 Colors Parameter: The Get 2 Colors parameter is
similar to Get 1 Color, but you can select two colors to
be replaced. The From Color and To Color panels
appear twice.

Using the /PALETTE Command

This command lets you change the palette used to display
pictures in 320 x 200 —4 resolution mode. It only appears
in the command list if you are using this resolution mode.
This command should be on the story line that precedes
the line in which a file is displayed.

The palette colors set with this command remain in effect
until you use another /PALETTE command.

Following is a description of the parameters you can use
with the /PALETTE command.

Get Palette Colors Parameter: After you select this
parameter, the Get Palette panel appears. Use the fol
lowing table to select from the four palettes listed on the
panel.

Palette # Colors
1 White, cyan, magenta
2 Brown, green, red
3 Light white, cyan, magenta
4 Yellow, green, red

After you select a palette, the palette number appears in
the PARAMETERS column of the Story Editor screen.

By default, the background color is black. To change this
color, select a new background color using the Get Back
ground Color parameter.
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Get Background Color Parameter: After you select this
parameter, the Background Color panel appears. Select
the background color you want to use. The color name
appears in the PARAMETERS column of the Story
Editor screen.

Use PM Palette Parameter: Use PM Palette instructs
Story Editor to use the color palette that was used when
the picture file was created in Picture Maker.

After you select this parameter, PM .PALETTE appears in
the PARAMETERS column.

Clearing the Screen
Use the /CLEAR command to clear all or part of the
picture displayed on the screen. To select the color to use
for clearing the screen, use the Get Color parameter.

After you select this parameter, the Get Color panel
appears.

Run (c) IBM 19B9 ]
Get Color 1

TeHt Graphics PARAHETERS TIDE UAIT |
1 1 BLGCK 1 1•m !
2 1
3 L.GRflY
4 GREEN 41 1 Th TT1|5 L.GREEN
6 RED B
7 L.RED Editing KeysH
B BLUE F2 Edit Drive\Path |
9 L.BLUE t-F2 Set Story Drive\Path 1

10 BROUN F3 Copy Data Fron Above 1
11 VELLOU ilt-I Insert Line H
12 mCENTfl llt-E Erase Line H
13 llt-B nark Block |
14 1 CYAN llt-C Copy Block 1
15 1 L.CYAN llt-D Delete Block i
16 1 liHlTE It-U Unnark Block !

Figure 5-9. The Get Color Panel (320 x 200 - 4 resolution mode)
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Select the color you want to use with the /CLEAR
command from this panel. If you are using the 320 x
200 —4 resolution mode, select the color from the left
column for displaying a screen in text mode. Select a
color from the right column for displaying a graphics
picture. If you are using a resolution mode other than
320 X200 —4, you select the color from just one column
of 16 colors. The number of the color you select is
entered in the PARAMETERS column.

If you do not select a color using the Get Color param
eter, black is used to clear the picture.

/CLEAR can be used with dissolve method NONE to
alter one or more partial picture areas before any action is
seen on the screen. The altered picture can be displayed
using the /DISPLAY or /SHOW command on a following
line in the table.

After you select /CLEAR, additional columns appear in
the lower left comer of the Story Editor screen. The
options you choose in these columns determine how the
/CLEAR command is used. Refer to "Additional Story
Table Columns" on page 5-65 for more information.

Branching to Other Story Lines
The /GOSUB and /GOTO commands let you branch to
other lines within your story. Story Editor allows up to
10 levels of branching using these commands.

Use the /GOSUB command to start a subroutine begin
ning with the line you choose in the PARAMETERS
column. The subroutine continues until a /RETURN
command is found. The /RETURN command causes the
story to return to the story line that follows the /GOSUB
command.
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Use the /GOTO command to go to a story line you
specify. /GOTO is commonly used to go back to the
beginning of a story so that the story runs continuously,
or to go back to a story menu screen.

For both of these commands, you use the Get Existing
Label or Input Label parameter to indicate the story line
you want to branch to. After you select the Get Existing
Label parameter, the Get Label panel appears.

File Edit nodes

HO. LRBEL Get Lebel

EDIT LINE

Henory Used

Figure 5-10. The Get Label Panel

PflRRnETERS
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fllt-B nark Block
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Rlt-D Delete Block
fllt-U Unnark Block
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Select the label of the story line you want to branch to
from this list. To scroll through the list of labels in this
panel, select the arrows pointing down and up. The label
you select from the Get Label panel appears in the
PARAMETERS column. To exit the Get Label panel
without selecting a label, press Button 2.

If you select the Input Label parameter, a blinking asterisk
appears in the PARAMETERS column. Type the label
of the line you want the story to go to and press Enter.
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While typing, use the Cursor Left and Right, Insert,
Delete, Spacebar, and Backspace keys to edit. To cancel
entering a label, press Esc. After you enter the label, the
label appears in the PARAMETERS column.

Reading input from the Keyboard
The /INPUT command allows your story to read input
from the keyboard.

Use the following parameters with this command to
specify the number of keystrokes needed before the story
continues.

0 (no wait)

With this parameter, input from the keyboard is read
without stopping the story. After you select this param
eter, 0 is entered in the PARAMETERS column on the
current story line.

1 Keystroke

This parameter tells the story to halt until one key is
pressed (the default if no parameter is chosen for the
/INPUT command). After you select this parameter, 1 is
entered in the PARAMETERS column on the current

story line.

input Number

This paraineter tells the story to halt until the number of
keys you specify are pressed. You can specify up to 15
keystrokes.

After you select Input Number, a bhnking asterisk
appears in the PARAMETERS column. Type the
number of keys you want the viewer to press before the
story continues. You can edit your entry using the
Cursor Right and Left, Insert, Delete, Spacebar, and
Backspace keys.
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Press Enter when you have finished typing a number. The
number appears in the PARAMETERS column on the
current story line. To continue without typing a number,
press Esc.

Note: Regardless of the parameter you use, the
story continues if the Enter key is pressed before
any other keys have been pressed.

Conditional Execution of Story Lines
After using an /INPUT command, you can use an /IF
command on a following story line to determine how the
story proceeds if a specific key is pressed.

If the keys pressed while the story runs match the keys
you specify with the /IF command, the story branches to
the line or subroutine with the label you enter in the
PARAMETERS column, or to the end of the story if you
select the END parameter.

After you select /IF, a blinking asterisk appears in the
COMMAND column next to the command. Type one or
more keys (up to 15) you want the story viewer to press,
or type $ to accept any keystroke. Then press Enter.

After using an /INPUT command, you can use an
/IFNOT command on a following story line to determine
how the story proceeds if a specific key is not pressed.

If the keys pressed while the story runs do not match the
keys you specify with the /IFNOT command, the story
branches to the line or subroutine with the label you enter
in the PARAMETERS column, or to the end of the story
if you select the END parameter.
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After you select /IFNOT, a blinking asterisk appears in
the COMMAND column next to the command. Type
one or more keys (up to 15). The keys you type prevent
the /IFNOT command from being carried out if they are
pressed. You also can tj^e $ to keep the story running
until any key is pressed. Then press Enter.

Following is a description of the parameters you use with
the /IF and /IFNOT commands.

GOSUB Label Parameter

The GOSUB Label parameter instructs the story to go to
a story subroutine beginning on the line with the label
you select. This occurs if the input from the keyboard
matches the input required by the command. After the
subroutine is ended with a /RETURN command, the
story continues with the line following the GOSUB Label
parameter.

After you select this parameter, a blinking asterisk
appears in the PARAMETERS column next to GOSUB.
Type the label of the hne you want the story to go to and
press Enter. Or, press Ait-F3 to select a label from the
Get Label panel. To scroll through the list of labels in
this panel, select the arrows pointing down and up.

The label you enter or select from the Get Label panel
appears in the PARAMETERS column. To exit the Get
Label panel without selecting a label, press Button 2.

GOTO Label Parameter

The GOTO Label parameter instructs the story to go to
the story line with the label you specify. This occurs if
the input from the keyboard matches the input required
by the command.
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After you select this parameter, a blinking asterisk
appears in the PARAMETERS column next to GOTO.
Type the label of the line you want the story to go to and
press Enter. Or, press Alt-F3 to select a label from the
Get Label panel. To scroll through the list of labels in
this panel, select the arrows pointing down and up.

The label you enter or select from the Get Label panel
appears in the PARAMETERS column. To exit the Get
Label panel without selecting a label, press Button 2.

END Parameter

The END parameter instructs the story to end if the input
from the keyboard matches the input required by the
command.

After you select this parameter, END appears in the
PARAMETERS column on the current story line.

Using Music, Sound Effects, and Voices
You can play back music and sound effects and use voices
in your stories if you have the following additional
options installed with your system:

• For music and sound effects: the IBM Music Feature

and a speaker

• For voices: the IBM Voice Communications Option
or the IBM Personal System/2 Speech Adapter with a
microphone and speaker

Refer to the documentation for the IBM Music Feature,
the IBM Voice Communications Option, and the IBM
Personal System/2 Speech Adapter for installation
instructions.
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Playing Music with Your Stories

Use the /MUSIC ON command to play back music flies.
The picture currently displayed on the screen remains
while the file you choose in the PARAMETERS column
begins to play. The story then proceeds to the following
lines while the music plays.

If the music file is finished before the story ends, the
music file repeats. To switch off the music file before the
story ends, use the /MUSIC OFF command.

Several music files are supplied with Storyboard Plus:

BLUES.ESQ ROCK.ESQ.
POP.ESQ JAZZ.ESQ

Use the Get Existing Name or Input Name parameter to
select the music file you want to use. Refer to "Get
Existing Name Parameter" on page 5-38 or "Input Name
Parameter" on page 5-40.

Notes:

1. This command allows you to play back, but
not create, music files.

2. To use this command, you must run the
KAPI.EXE file before you start Story Editor.
This file is located on Diskette 1.

3. If you are running Story Editor from 5.25-inch
diskettes, remember that music files are located
on Diskette 1. Insert Diskette 1 before you try
to view or select music files.
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Using Sound Effects in Your Stories

Use the /SOUND EFFECTS command to play back
sound effects files. The picture currently displayed on the
screen remains while the file you choose in the PARAME
TERS column begins to play. The story then proceeds to
the following lines while the sound effects are played.
Once the sound effects file is played, it does not repeat.

Several sound effects files are supplied with Storyboard
Plus:

ALARM.ESQ BEACH.ESQ
BIGBEN.ESQ CHOPPER.ESQ
DRUMS.ESQ KNOCK.ESQ
PHONE.ESQ RACING.ESQ
WATER.ESQ WHISTLE.ESQ

Use the Get Existing Name or Input Name parameter to
select the sound effects file you want to use. Refer to
"Get Existing Name Parameter" on page 5-38 or "Input
Name Parameter" on page 5-40.

Notes:

1. This command allows you to play back, but
not create, sound effects files.

2. To use this command, you must run the
KAPI.EXE file before you start Story Editor.
This file is located on Diskette 1.

3. If you are running Story Editor from 5.25-inch
diskettes, remember that sound effects files are
located on Diskette 1. Insert Diskette 1 before

you try to view or select sound effects files.
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Using Voices

Use the /SPEAK command to play back the files created
when you select Record Voice from the File menu. Refer
to the section "Using Voice Files with Your Stories" on
page 5-94 for more information about recording and
using voice files.

Use the Get Existing Name or Input Name parameter to
select the voice file you want to use. Refer to "Get
Existing Name Parameter" on page 5-38 and "Input
Name Parameter" on page 5-40 for information about
using these parameters. The picture currently displayed
on the screen remains while the file you select plays back.
Once the voice file is played, the story proceeds to the
next line.

To use this command, you must have the IBM Voice
Communications Option or the IBM Personal System/2
Speech Adapter installed with a microphone and speaker.

Note: If you are using the IBM Voice Communi
cations Option, you must run VOICE.BAT before
starting Story Editor. The VOICE.BAT file is
located on the same diskette as Story Editor.
Also, the following files supplied with the IBM
Voice Communications Option must either be in
the directory with Story Editor or be accessed
using the DOS PATH or APPEND command:

VCAPIDRV.COM

APIDIR.AIC

BASEPC.AIC

BASESP.AIC

BATCMD.AIC

VOINSP.AIC

VOOTPC.AIC

VIINSP.AIC

VIOTSP.AIC

V20TSP.AIC

V30TPC.AIC

V40TSP.AIC
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Running Other Stories and Programs from within Your
Story

You can branch to another story, DOS program, or
memory-resident program while running your story. The
following sections describe the commands that enable you
to do this.

Branching to Another Story

Use the /TELL and /CALL commands to branch the
current story to another story, using any specified drive
and directory, and to start the new story. The specified
drive and directory also set the drive and path for all files
used by the new story.

These commands let you join stories to make large presen
tations. They also let you combine stories that use pic
tures created in different resolution modes.

The difference between /TELL and /CALL is that control
does not return to the story containing the /TELL
command. Using /CALL, the line following the /CALL
command is executed after the /CALLed story is run.

The story you branch to with the /CALL command runs
until an /END command or the end of the story is
reached, at which time control returns to the main story.
You can /CALL stories that in turn /CALL other stories,
but once an /END command or the end of a story is
encountered, control returns to the main story.

To see the results of these commands, you must use Story
Teller. Story Editor skips lines with these commands
when you run or step through the story.

Use the Get Existing Name or Input Name parameter to
select the story you want to branch to. Refer to "Get
Existing Name Parameter" on page 5-38 or "Input Name
Parameter" on page 5-40.
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Branching to a DOS Program

The /EXEC command is used to exit your story, connect
to DOS, call another DOS program, execute it, and return
to the story line following the /EXEC command. You
enter the name of the .EXE or .COM file you want to
execute in the PARAMETERS column.

Note: Memory-resident programs cannot be exe
cuted with the /EXEC command. Use the /INT
command to branch to memory-resident programs.

If you do not want the screen cleared when branching to
the other program, select the Input Comment command to
display a blinking asterisk after the /EXEC command in
the COMMAND column. Then, tj'pe $ after the asterisk
and press Enter.

Use the Get Existing Name or Input Name parameter to
select the DOS program you want to execute. Refer to
"Get Existing Name Parameter" on page 5-38 or "Input
Name Parameter" on page 5-40.

Branching to a Memory-Resident Program

The /INT command lets you interrupt your story to
access a memory-resident .COM program through a speci
fied software interrupt. The .COM program must be
loaded before Story Editor or Story Teller is started, and
must return to the interrupted program. DOS reserves
interrupts 60 through 67 for user software.
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To specify the interrupt and register values to use with
this command, select Input Parameters from the PARAM
ETERS column. You see the /INT Parameters panel.
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Figure 5-11. /INT Parameters Panel

The interrupt and register values can be expressed
decimally (000 to 255) or hexadecimally (OOh to FFh).
You enter only register values for the registers you need.

To start entering register values, move the pointer to a
register field on the /INT Parameters panel and press
Button 1. A blinking asterisk appears, indicating you can
start typing a register value. While typing, you can use
the Cursor Right and Left, Insert, Delete, Spacebar, and
Backspace keys to edit.

Press Enter when you have finished typing the value. The
blinking asterisk appears in the next field on the panel.
When you have finished entering register values, press
Button 1 or Enter, if you just tj^ed a value in the last
field on the panel. To exit a register field without saving
a value you typed, press Esc.
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Press Button 2 to remove the /INT Parameters panel. The
interrupt parameters appear in the PARAMETERS
column.

The /INT command optionally loads registers AX, BX,
CX, and DX with values and issues a branch to the inter
rupt specified. Registers AX, BX, CX, DX, SI, DI, DS,
ES, and the Flags register are saved and need not be
restored. The interrupt processing program must leave
the stack pointer (SP) and stack segment (SS) registers in
the same state they were before leaving Story Editor or
Story Teller.

Using Sprites
Sprites are "canned" action figures you can use in your
stories. To use a sprite, select the /SPRITE command for
the current story Une.

^ To select a sprite, use the Get Existing Name parameter
to choose one of the sprite files. These files have an SPR
extension. See "Get Existing Name Parameter" on
page 5-38 for more information about this parameter.

You will notice from the sprite filenames that two ver
sions of each sprite have been included with Storyboard
Plus. One version is designed for use in the 640 x
350—16, 640 X 480— 16, and 640 x 480 —256 resolution
modes. These files begin with the letter H (for "high
resolution"). Although you can use any sprite file in these
modes, the high-resolution sprites look the best.
However, high-resolution sprites are slower and take up
more room on disk than lower-resolution sprites.
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When you select the /SPRITE command, additional story
table columns appear. These columns are used to enter
additional information to control the movement of the
sprite. Under the column headings is a highlighted line.
This Une is an extension of the current story line.
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Alt-D Delete Block
Alt-U Unnark Block

Figure 5-12. Additional Columns of the /SPRITE Command

The following sections describe these columns.
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Notes:

1. If you are running Story Editor from 3.5-inch
diskettes, remember that sprite files are located
on Diskette 1. Insert Diskette 1 before you try
to view or select sprite files. If you are
running Story Editor from 5.25-inch diskettes,
sprite files are located on Diskette 5 and
Diskette 6.

2. Story Editor ignores the /SPRITE command if
you are working in text mode. If the last
screen you displayed was a text screen, use the
/DISPLAY or /SHOW command with a
graphics screen to switch to graphics mode
before using the /SPRITE command.



The SPRITE ACTION Column

This column lets you determine the sprite's action when
movement across the screen ends. The options in this
column vary depending on the sprite being used. Select
this column to display the options for the sprite you
selected using the Get Existing Name parameter. To
choose a sprite action, select an option from the list.

DIR

Select this column to display the possible directions from
which the sprite appears as it moves to the location you
chose. To choose a direction, select one of the displayed
options.

POSITION

This column lets you set the final position of the sprite on
the screen. You have four options for entering the
sprite's position:

• Set on Monitor

• Set on Full Screen

• Input Position
• Go to Background

Using Set on Monitor and Set on Fail Screen: These
options allow you to use a select box to determine the
final location of a sprite.

To set the sprite's position on the screen using these
options:

1. Select Set on Monitor or Set on Full Screen from the

POSITION menu. A select box appears on the story
monitor or full screen with the last picture listed in the
PARAMETERS column as background. If no full
screen picture is found, the background is black. The
select box represents the sprite's position.

2. To use the current select box location for the sprite
position, move the pointer outside of the select box
and press Button 2.
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To change the sprite's position, move the pointer
inside the select box and press Button 1. Move the
select box to a new location on the story monitor or
full screen. To display the sprite, press F4. When you
are satisfied with the sprite's location, press Button 2.
The coordinates in the POSITION column change to
reflect the sprite's position.

Using input Position: Use this option to type coordinates
for the sprite's location.

Story Editor accepts coordinates in four-pixel increments
on the X axis in the 320 x 200 resolution modes. Story
Editor accepts coordinates in eight-pixel increments on the
X axis in all other resolution modes. If a value not

matching a four- or eight-pixel increment is entered. Story
Editor rounds to the next lower odd pixel.

Story Editor accepts coordinates in one-pixel increments
on the Y axis.

After you select Input Position, a blinking asterisk appears
in the POSITION column. Type the X axis coordinate.
Press the Tab key, and then type the Y axis coordinate.
Press Enter when you have finished. The coordinates
appear in the POSITION column. To exit input mode
without making a change, press Esc.

Using Go To Background: Selecting this option changes
the sprite to the background color of the next picture dis
played. This is how you remove the sprite from the
screen.

If you use two sprites in succession without removing the
first sprite with the Go To Background option, the second
sprite appears at the ending position of the first sprite,
regardless of the option you selected in the DIR column.
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— Notes for Keyboard Users

• Press the Tab key to move the pointer to the addi
tional story table columns.

• Select an option from the SPRITE ACTION
column by entering the number associated with the
option.

• Move the pointer in the story monitor or full
screen using the Cursor keys. The pointer moves
in four-pixel increments in the 320 x 200 resolution
modes and eight-pixel increments in all other resol
ution modes. To move the pointer in single-pixel
increments, press Shift and a Cursor key.

Locking the Keyboard
The /LOCK ON command disables all keys on the key
board except those you specify with the /INPUT
command. /LOCK ON is useful for stories that run unat
tended.

The /LOCK OFF command re-enables all keys after a
/LOCK ON command.

Printing Pictures in a Story
Use the /PRINT command with the Run & Print Story
option on the Run menu. Any time you want to print a
screen, select /PRINT on the story line that follows the
line displaying the screen.

The /PRINT command is ignored when Step Story and
Run Story are selected. /PRINT is always ignored in
Story Teller.
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When you select Run & Print Story, the screens you select
with the /PRINT command are printed as the story is
run. Story Editor uses Picture Maker' default settings on
the Print panel for the Shades, Print Eject, and Define
Print Colors options, unless you have saved different
Picture Maker defaults.

The story proceeds as rapidly as possible, stopping only to
print the pictures you specify. Any information in the
TIME and WAIT columns is ignored.

Use the following parameters with the /PRINT command:

Small Causes a small version of the image to print.

Medium Causes a medium-sized version of the image
to print.

Turn Page Causes an enlarged version of the image to be
printed sideways on the paper.

Note: Depending on the printer you have selected,
the Small and Medium parameters may yield the
same results.

Inserting Comments in Your Story
The Input Comment command allows you to enter a
comment on the story line. Comments can be used to
identify what's happening on a particular line. If a
command is used on a story line, the comment appears
next to the command.

After you select Input Comment, a blinking asterisk
appears on the story line. Start typing your comment.
Pressing any character key or the Spacebar blanks out the
current entry. You can use the Cursor Left and Right
keys. Insert, Delete, Spacebar, and Backspace while typing
your comment or editing the current entry. To exit
without entering a comment, press Esc.

Note: Comments cannot begin with a slash (/).
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Press Enter when you have finished typing the comment.
The comment appears on the story line next to the
asterisk.

Deactivating a Story Line
The /* command allows you to deactivate the story line
by removing the command on the line. Any comments
you may have entered remain on the story line.

Ending a Story
Select the /END command to stop the story immediately.
This command is commonly used with story menus where
one of the choices is to end the story. It is also used as
the last line in a story to separate the story from any sub
routines that may follow.

CoBitrelling th© Timiiig Between images

The TIME column lets you set the transition time needed
between the images in your story. Select this column to
display the available options.

File Edit nodes Run (C) IBM 19B9
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To use the same TIME option as the previous story line,
move the pointer to the TIME column and press F3.

You also can point to the TIME column and type infor- _
mation directly onto the current story line. Refer to •
"Using the Story Table" on page 5-10 for more informa
tion about tj^ing in the story table.

Entering a Transition Time
Select Input Action Time from the TIME column to enter
a transition time in seconds. After you select this option,
a blinking asterisk appears. Type a number from 0.1 to
60, and then press Enter.

To exit input mode without entering a time, press Esc.

Choosing FAST, MED, or SLOW
The other three options in the TIME column enable you
to select a relative transition time that is approximately
the same among IBM PC and Personal System/2 models.
These transition times are faster for partial displays.

After you select one of these options, the option name
appears in the TIME column.

0 WAIT Coiymn

The WAIT column lets you select the amount of time a
picture is displayed before the next dissolve begins. Move
the pointer to the WAIT column and press Button 1 to see
the WAIT options.

Move the pointer to the WAIT column and press F3 to
use the WAIT value of the previous story line.

You also can point to the WAIT column and type infor
mation directly onto the current story line. Refer to
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"Using the Story Table" on page 5-10 for more informa
tion about typing in the story table.

Input Wait Delay
Select Input Wait Delay to enter a display time in seconds.
A blinking asterisk appears. Type a number from 0.1 to
999, and then press Enter. The time you enter appears in
the WAIT column.

To exit input mode without entering a WAIT value, press
Esc.

No Wait (0)
Select 0 from the WAIT options to enable a story to
proceed immediately after a picture is displayed. After
you select this option, 0 appears in the WAIT column on
the current story line.

The Key Option
Select Key from the WAIT options to instruct the story to
wait until a key is pressed before the story continues.
After you select this option. Key appears in the WAIT
column on the current story line.

Additional Story Table Columns

After you select the /CLEAR, /COLOR, /DISPLAY, or
/SHOW command, additional Story Table columns
appear on the Story Editor screen. These columns let you
select additional information required by these commands.

As with the other story table columns, you can point to a
column and press Button 1 to select an option from a list.

i'*^\ Or, you can move the pointer to the column and tjqje
information directly onto the current story line. Refer to
"Using the Story Table" on page 5-10 for more informa
tion about typing in the story table.
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Following is a description of each of the additional story
table columns.

Selecting Dissolve Method and Direction
The METHOD and DIR columns enable you to select the
dissolve method and direction used to present each picture
in the story. The direction options available depend on
the method you select. Some dissolve methods do not
have associated directions. In this case, NONE is dis
played in the DIR column.

To select a dissolve method, move the pointer to the
METHOD column and press Button 1. A list of dissolve
methods is displayed. To select a method from the list,
move the pointer to the method and press Button 1.

Following is a description of each dissolve method and
associated direction options.

NONE ' ^
With NONE as the dissolve method, a picture is loaded
into memory but not displayed. The value in the WAIT
column is applied. This allows you to use Story Editor
commands to modify the picture on following story table
lines before the picture is displayed.

There are no direction options with this dissolve method.

CRUSH

With this dissolve method, the new picture overlays the
old picture in two directions simultaneously. Direction
options for this method are:

OUT-V The new picture overlays the old picture from
the center to the top and bottom.

IN-V The new picture overlays the old picture from
the top and bottom to the center.
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OUT-H The new picture overlays the old picture from
the center to the right and left.

IN-H The new picture overlays the old picture from
the right and left to the center.

EXPLODE

The new picture overlays the old picture simultaneously in
four directions. Direction options for this method are:

OUT-V and OUT-H

The new picture starts in the center.

IN-V and IN-H

The new picture starts at the edges.

FADE

The old picture fades in random groups of one, two, or
four pixels as the new picture appears. There are no
direction options for this method.

PUSH

The new picture pushes out the old picture in one of four
directions. Direction options for this method are;

UP

DOWN

LEFT

RIGHT

REPLACE

The new picture overlays the old picture in one of four
directions. Direction options for this method are:

UP

DOWN

LEFT

RIGHT
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INSTANT

The new picture is displayed as quickly as possible on the
screen. Any information in the TIME column is ignored.
This is the method you should use when creating ani
mation sequences as described in the section "Creating
Animation Sequences" on page 5-76.

BLEND

This method, which is similar to FADE, is designed for
the 256-color resolution modes. First, the colors of the
old picture are changed to the background color of the
new picture. Then, the new picture is displayed.

This method works only in Full Screen mode. If you are
using a resolution mode other than 320 x 200—256 or 640
X 480 - 256, the FADE method is used instead.

SPLIT

The new picture is revealed as the old picture is split and
pushed off the screen. Direction options for this method
are:

OUT-V The old picture is pushed from the center to the
top and bottom.

IN-V The old picture is pushed from the top and
bottom to the center.

OUT-H The old picture is pushed from the center to the
right and left.

IN-H The old picture is pushed from the right and
left to the center.

STRIPES

Stripes of the new picture overlay the old picture in the
selected direction. Direction options for this method are: ^ ^
UP and DOWN

Horizontal stripes overlay the old picture
moving up or down.
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LEFT and RIGHT

Vertical stripes overlay the old picture moving
left or right.

WEAVE

The old picture is pushed out horizontally in two
directions simultaneously, and replaced by the new
picture. There are no direction options for this method.

DIAGONAL

The new picture diagonally overlays the old picture.
Direction options are:

UP The new picture overlays the old picture from
the lower right to the upper left.

DOWN The new picture overlays the old picture from
the upper left to the lower right.

RIGHT The new picture overlays the old picture from
the upper right to the lower left.

LEFT The new picture overlays the old picture from
the lower left to the upper right.

CHECKER

The new picture replaces the old picture using upwardly
expanding boxes. There are no direction options for this
method.

The LINE Column

Some dissolve methods use a line between the old picture
and the new picture while the transition is taking place.
The LINE column allows you to select the color of that
line. You may also choose not to use a line.

The LINE options are used with the following dissolve
methods:

• DIAGONAL

• EXPLODE

• CRUSH
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• SPLIT

• PUSH

• REPLACE

Move the pointer to the LINE column and press Button 1
to display the LINE options. Following is a description
of each option.

Get Line Color

This option lets you select the color for the line. Black is
used if no color is selected. After you select this option,
the Line Color panel is displayed. Select the color you
want to use for the line.

No Line

To use no line color with a dissolve method, select No
Line from the LINE options. NONE appears in the
LINE column on the current story line.

The AREA Column

This column lets you determine whether a full screen
display or a partial screen display should be used for your
pictures. The FULL and TRANSPARENT FULL
options are used for full screen displays. The PART and
TRANSPARENT PART options are used for partial dis
plays.

When FULL or PART is used, the original background
of the picture is maintained. The TRANSPARENT
FULL and TRANSPARENT PART options allow one
color to be designated as transparent, enabling a portion
of the previous picture to "show through" the new
picture. The transparent color used by Story Editor is the
same as that selected as the transparent color in Picture
Maker.

To define which part of a picture you want to use in a
partial display, use the FROM PICTURE and TO
SCREEN columns described in the next section.
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Defining a Partiai Picture with the FROM PICTURE and
TO SCREEN Columns

The FROM PICTURE and TO SCREEN columns are

used when either PART or TRANSPARENT PART is

selected in the AREA column. The information you enter
in these columns determines which part of a picture will
be displayed, and where it will appear on the screen.

For graphics screens, the values in these columns repre
sent X,Y coordinates measured in pixels, as shown in the
following figure.

FROn PICTURE TO SCREEN

69- 391253-193 67- 39

npper left corner lower right corner
of partial picture of partial picture

screenlocation of

partial picture's
upper leftcorner

Figure 5-14. Coordinates in the FROM PICTURE and TO SCREEN
Columns

In each of the three pairs of coordinates, the first number
is the X value measured in pixels from the left side of the
screen. The second number is the Y value in pixels meas
ured from the top of the screen.

Note: The TO SCREEN coordinates are used

with the /DISPLAY and /SHOW commands, but
not with the /CLEAR and /COLOR commands.
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The possible X,Y values for the supported resolution
modes are as follows:

Resolution

Mode

X Axis Values Y Axis Values

320 X 200 1 to 320 1 to 200

640 X 200 1 to 640 1 to 200

640 X 350 1 to 640 1 to 350

640 X 480 1 to 640 1 to 480

For 80-column and 40-column text screens, X refers to the
character column starting at the left side of the screen (1
to 80 or 1 to 40), and Y refers to the line starting at the
top of the screen (1 to 25).

You can enter these coordinates using the Set on
Monitor, Set on Full Screen, or Input Coordinates option.
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Figure 5-15. FROM PICTURE TO SCREEN Options
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Note: When displaying partial text screens, use
Set on Monitor or Set on Full Screen. These

options are more accurate than Input Coordinates
because coordinates you enter may be rounded by
the program.

Entering Coordinates using Set on Monitor or Set on Fuii Screen

These options allow you to use a select box to enter coor
dinates for the partial picture you want to display or
alter. Set on Monitor lets you set the coordinates in the
story monitor area of the Story Editor screen. Set on Full
Screen allows you to set the coordinates on the full
screen.

To use these options:

1. Select either Set on Monitor or Set on Full Screen

from the FROM PICTURE TO SCREEN menu. The

picture you indicated in the PARAMETERS column
is displayed with a select box.

2. To use the select box to define your partial picture,
move the pointer outside of the select box and press
Button 1. The select box is removed, and the pointer
changes to a crosshair.

3. Position the crosshair at the upper left comer of the
partial picture you want to display and press Button 1.

4. Expand the select box to encompass the area you want
to use as the partial picture, and then press Button 2.

5. If you are just changing the FROM PICTURE coor
dinates, press Button 2 again. The new coordinates
appear in the FROM PICTURE column. Otherwise,
continue with the next step.

6: Move the pointer inside the select box and press
Button 1. The previous full picture in the PARAME
TERS column appears as background. If no full
picture is found, the background is black.
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7. To leave the picture in the same screen location, move
the pointer outside the select box and press Button 2.

8. If you want to select another area in which to display
the partial picture, move the pointer inside the select
box and press Button 1.

9. Move the select box to the new location.

10. If you want to view the partial screen image in the
new position, press F4. To view the other partial pic
tures used in your story, press F5. Press F5 repeatedly
to display successive partial pictures.

11. When you are satisfied with the position of the partial
picture, press Button 2. The coordinates appear in the
TO SCREEN column.

— Notes for Keyboard Users

Use the Cursor keys to move the pointer in the story
monitor or full screen areas. The pointer moves in
four-pixel increments in the 320 x 200 resolution
modes, and in eight-pixel increments in all other resol
ution modes. To move the pointer in single-pixel
increments, press Shift and a Cursor key.

Entering Coordinates with the Input Coordinates Option

Use this option to type the screen coordinates of the
upper left comer of the partial picture that will be altered
or displayed.

In the FROM PICTURE and TO SCREEN columns of

the table. Story Editor accepts coordinates in four-pixel
increments on the X axis in the 320 x 200 resolution

modes. Story Editor accepts coordinates in eight-pixel
increments on the X axis in all other resolution modes.

If values not matching the four- or eight-pixel increments
are entered. Story Editor rounds them up or down as
shown in the following table.
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Resolution

Mode

FROM

PICTURE 1st

X and TO

SCREEN

Values

FROM

PICTURE 2nd

X Value

320 X 200 Rounds to next

lower odd pixel
(1, 5, 9, ...317)

Rounds to next

higher even
pixel (4, 8, 12,
...320)

640 X 200, 640
X 350, 640 X
480

Rounds to next

lower odd pixel
(1, 9, 17, ...633)

Rounds to next

higher even
pixel (8, 12,
...640)

Story Editor accepts coordinates in one-pixel increments
on the Y axis.

To enter coordinates in the FROM PICTURE and TO

SCREEN columns:

1. Select the Input Coordinates option from the FROM
PICTURE TO SCREEN columns.

The columns are divided into six areas. The first two

areas are where you enter the coordinates of the upper
left corner of the partial picture. The Tab and
Shift-Tab keys move the blinking asterisk between
these areas. Pressing any number key blanks out the
area where the blinking asterisk is located.

2. At the blinking asterisk, type the coordinates of the
upper left comer of the area that will be altered or
displayed on the screen.

3. Press the Tab key to move the blinking asterisk to the
next area. This area is where you type the coordinates
of the lower right corner of the partial picture.
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4. Type the coordinates of the lower right corner of the
partial picture.

5. Press the Tab key. The blinking asterisk moves to the
TO SCREEN column. This column lets you deter-
mine the partial picture's location by entering new
coordinates for the upper left corner of the partial
picture.

6. If you do not want to change the location of the
partial picture, press F9 to use the first set of coordi
nates in the FROM PICTURE column.

To change the partial picture's location, type new
coordinates for the upper left corner of the partial
picture.

7. Press Enter to set the coordinates. The coordinates
appear in the FROM PICTURE and TO SCREEN
columns.

8. If you want to exit input mode without making a
change, press Esc.

Creating Animation Sequences

Story Editor can be used to create three types of ani
mation sequences with graphics screens (screens in text
mode cannot be used):

• Movement across the screen using one image, such as
a car moving across the screen

• Movement across the screen using a series of images,
such as a bird flying and flapping its wings

• Stationary animation, such as a flag waving

Story Editor automatically inserts the story lines needed
for the animation sequence as you use the /SHOW
command, and displays a select box to enter coordinates
in the FROM PICTURE and TO SCREEN columns.
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Note that if the select box outline changes to a dash/dot
style (normally the box is made of dashes), the area you
have surrounded is too large to use in an animation
sequence. In this case, reduce the area you have selected
until the box outline changes back to dashes. The area
you can surround before the select box outline changes to
the dash/dot style is determined by the color and resol
ution mode you select by pressing F2 at the Quick
Menu/Setup screen.

If you continue using an area that is too large, the
program defaults to a standard /SHOW command, which
takes longer to execute.

Following is a discussion of creating each type of ani
mation sequence.

Movement Across the Screen Using One Image

To create an animation sequence that has one image
moving across the screen:

1. Select /SHOW from the Commands menu.

2. Enter the picture filename in the PARAMETERS
column.

3. Enter 0 in the TIME column.

4. Enter 0 in the WAIT column.

5. Select either PART or TRANSPARENT PART from
the AREA column.

6. Select either Set on Monitor or Set on Full Screen
from the FROM PICTURE TO SCREEN columns.

A select box appears on the screen with the picture
you selected in the PARAMETERS column.

7. If the select box is outlining the partial area you want
to use in your animation sequence, go to step 11. If
you want to select a partial area to use in your ani
mation sequence, continue with the next step.
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8. Move the pointer outside the select box but within the
screen area and press Button 1. A crosshair pointer
appears on the screen.

9. Move the pointer to the upper left corner of the area ^,-1,.
you want to display and press Button 1.

10. Move the select box until it encloses the area you
want to display and press Button 2.

11. Move the pointer inside the select box and press
Button 1. The last full picture in the PARAMETERS
column is displayed as background behind the select
box. If no full picture is found, the background is
black.

12. To begin your animation sequence, move the pointer
inside the select box and press Button 1.

13. Move the select box and press Button 2 every time
you would like the image displayed in your animation
sequence. Each time you press Button 2, a new line is
added to your story.

14. To end an animation sequence, press Button 1.

Movement Across the Screen Using a Series of Images

When creating this tj'pe of animation sequence, all of the
images you want to use must be in the same file.

To create an animation sequence that has a series of
images moving across the screen:

1. Perform the steps in "Movement Across the Screen
Using One Image" on page 5-77.
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2. Scroll the story table so the current story line contains
the picture you want to change.

3. Select either Set on Monitor or Set on Full Screen

from the FROM PICTURE TO SCREEN columns.

A select box appears on the screen with the picture
you specified in the PARAMETERS column.



4. Move the pointer outside the select box but within the
screen area and press Button 1. A crosshair pointer
appears on the screen.

5. Move the pointer to the upper left corner of the area
you want to display and press Button 1.

6. Move the select box until it encloses the area you
want to display and press Button 2.

7. Move the pointer outside the select box and press
Button 2. The FROM SCREEN column is updated
without changing the TO SCREEN coordinates.

8. Continue following these steps until you have made all
of the necessary changes to the animation sequence.

Stationary Animation

To create an animation sequence that involves an object
remaining in the same position on the screen, follow each
of the steps in the two other animation procedures, except
keep the select box stationary while pressing Button 2 to
insert story lines.

Note: If you are creating stationary animation
and you are using the PART option from the
AREA column, we recommend that you use the
/DISPLAY command and the INSTANT method
for better performance.
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Editimg Stories

The Edit menu at the top of the Story Editor screen con
tains options that enable you to insert, delete, and copy
lines or blocks of lines in your story. To display the Edit
menu, select Edit at the top of the Story Editor screen.
The following sections discuss using each option on this
menu.

In addition to using these options, you can quickly edit a
story by typing over information or by selecting new com
mands and parameters from menus to change the current
story line. The keys you can use to edit the story are dis
played on the story monitor. Refer to "Using the Story
Table" on page 5-10 for more information about entering
commands and parameters in the story table.

Inserting Story Lines
To insert blank lines above the current story line, follow
these steps:

1. Select Insert Line from the Edit menu. "INSERT

LINE" appears in the lower left portion of the Story
Editor screen.

2. Move the pointer to the current story line and press
Button 2. A blank line is inserted before the current

story line. To insert more lines, press Button 2 as
many times as needed.

3. When you are finished inserting lines, press Button 1
while the pointer is on the current story line.

Deleting Story Lines
Follow these steps to delete the current story Une:

1. Select Delete Line from the Edit menu. "DELETE

LINE" appears in the lower left portion of the Story
Editor screen.
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2. Move the pointer to the current story Une and press
Button 2. The current story line is deleted. The next
line moves up to become the current story line. To
delete successive lines, press Button 2 as many times as
needed.

3. When you are finished deleting lines, press Button 1
while the pointer is on the current story line.

Marking Blocks of Lines
The Mark Block option on the Edit menu lets you copy,
delete, or print a section of your story. To mark a block
of story lines:

1. Select Mark Block from the Edit menu. "MARK

BLOCK" appears in the lower left portion of the
Story Editor screen.

2. Scroll the story table so the first line of the block you
want to mark is the current story line.

3. Move the pointer to the current story Une and press
Button 2 to mark the first line of the block. The line

number is highlighted.

4. Scroll the story table so the last line of the section to
be marked is the current story line.

5. Move the pointer to the current story line and press
Button 2 to mark the block. The line numbers within

the block are highlighted.

6. After you have marked a block, move the pointer to
the current story line and press Button 1 to exit Mark
Block mode.
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Copying a Block
Copy Block is used to copy a marked block of lines
before the current story line. To copy a marked block:

1. Select Copy Block from the Edit menu. "COPY
BLOCK" appears in the lower left portion of the
Story Editor screen.

2. Move the pointer to the current story line and press
Button 2. You can copy the block to other areas by
scrolling the story table and repeating this step.

3. When you have finished copying a block, move the
pointer to the current story line and press Button 1.

Deleting a Block
The Delete Block option lets you remove a marked block
of lines from your story. To delete a marked block:

1. Select Delete Block from the Edit menu. A box

appears that asks you to confirm that you want to
delete the block.

2. Select YES to delete the marked block, or NO to
cancel deleting the block.

Note: Once lines are deleted, they cannot be
retrieved unless you have previously saved your
story.

Unmarking a Block
To unmark a block of story lines, select Unmark Block
from the Edit menu. The highlighting is removed from
the line numbers in the block.

Clearing the Story Table
The Start New Story option on the Edit menu lets you
clear the story table so you can start a new story. If you
have created or edited a story, make sure you save it
before using this option.
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To begin a new story, select Start New Story from the
Edit menu. A box appears asking you to confirm that
you want to start a new story. Select YES to start a new
story, or NO to cancel.

Using Picture Maker whiie Editing a Story
While editing a story, you may want to make changes to
one or more pictures used in the story. Rather than
exiting Story Editor and starting Picture Maker, you can
go directly to the Picture Maker screen by selecting
Picture Maker on the Modes menu.

After selecting this option, the Picture Maker screen is
displayed. You can get a picture to edit or create a new
picture. Refer to Chapter 2, "Picture Maker" for infor
mation about creating and editing pictures.

When you have finished using the Picture Maker screen,
select Story Editor from the Picture Maker File menu.
You return to the Story Editor screen, where you can
continue editing your story.

Notes:

1. To use the Picture Maker option, the default
buffer path must be set to a fixed disk (see the
setup procedure "Setting the Default Buffer
Path" on page 1-13). The Picture Maker
option is not available if you use a diskette-
based system. Instead, exit Story Editor to use
Picture Maker.

2. If you are running Storyboard Plus from
diskettes, you see messages that instruct you to
insert the PM Program Diskette or the SE
Program Diskette. Diskette 2 is the PM
Program Diskette. Diskette 3 is the SE
Program Diskette for 3.5-inch drives; Diskette
5 is the correct diskette for 5.25-inch drives.
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Changing the Drive and Directory of a Fiie
Several Story Editor commands require a filename in the
PARAMETERS column. For example, the /DISPLAY
command requires the name of the picture to be dis
played. When you select one of these commands, a box
appears in the lower left portion of the Story Editor
screen with the message Current Story Drive\Path.

This message indicates that, unless you specify otherwise
with the File Services panel, the file you select to use with
the command is located in the same directory as the story
you are currently editing. If you select the file from a dif
ferent drive or directory using the File Services panel, that
drive and directory are displayed in the box.

There may be times when you need to change the drive
and directory of a file. For example, if you change the
name of a picture using the Input Name Parameter, but
the new picture is located in a different directory than the
original picture. Story Editor will not be able to locate the
picture.

In these cases, you can easily change the drive and direc
tory of the file on the current story line by pressing F2, or
by pointing to the Current Story Drive\Path box and
pressing Button 1. A blinking asterisk appears in the box,
which indicates you can type the drive and directory
where the file is located (for example, D:\PM\REPORTS).
Then, press Enter. To change a file's drive and directory
back to the Current Story Drive\Path, press Alt-F2.

You can follow this procedure whenever you need to
change the drive and directory of a file referenced on the
current story line.
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Viewing Yoyr Story

The options on the Run menu enable you to view your
story. You can choose to step through your story one
line at a time, or to run it without stopping.

Using the Story Monitor or the Fuii Screen
You also can choose to run your story so it appears on
the story monitor or on the full screen. To make this
choice, select the Modes menu on the Story Editor screen.
Select Monitor to run your story on the story monitor, or
Full Screen to run your story using the full screen.

Monitor mode is helpful for viewing each line in the story
table as the story runs (the story table is not displayed
when you use Full Screen mode). However, pictures on
the story monitor are not of the same quality as when you
run the story on the full screen. Also, text screens cannot
be displayed in Monitor mode, although you see a repre
sentation of these files.

Step Story and Run Story Options
The Step Story option lets you view your story as it runs
one line at a time. The story begins at the current story
line. After each line executes, press Enter to continue.

The Run Story option lets you view your story without
interruption starting at the current story line.

After selecting either of these options, you can use the fol
lowing keys while your story is running:

Key Action

Esc Stops the story and returns to the story
table at the end of the current action.

Shift-Esc Stops the story immediately.
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Enter Executes the next line of the story when in
Step Story mode.

F5 When running in Run Story mode,
switches to Step Story mode.

F6 When running in Step Story mode,
switches to Run Story mode.

FIO Freezes the story; pressing any key resumes
the story.

Spacebar Skips current WAIT period.

Minus (-) Backs up the story to the last picture, or
to the previous line with a period in the
label field.

Plus ( +) Resumes the story from where it was
backed up.

Printing Pictures as the Story Runs
The Run & Print Story option lets you view your story
and print the screen image any time a /PRINT command
has been entered on a following story line. WAIT periods
are ignored when you use this option.

If there is a marked block of lines in your story, only the
/PRINT commands in the block are executed.

Clearing the Monitor
Select Clear Monitor on the Run menu to clear the

current picture displayed on the story monitor.
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Saving, Retrieving, and Merging Your Stories

The File menu on the Story Editor screen contains
options you use to save, retrieve, and merge your stories.
Options on this menu also enable you to remove, print,
and copy stories and to record voice files.

Saving Stories
There are two ways to save a story: using Quick Save,
and using the File Services panel.

Using Quick Save

You should save your story periodically during an editing
session to prevent losing all of your changes if the power
should fail. You can do this quickly by pressing Alt-F8
from the Story Editor screen. The Quick Save panel
appears.

If you are working on a new story, save it by selecting
Type from the Quick Save panel. A cursor appears in the
Type box, indicating you can type the name of the file.
After typing a filename, press Enter.

If you are saving an existing story, select YES to save it
with the name displayed on the Quick Save panel. Or,
save the story with a different name by moving the
pointer to the story name, pressing Button 1, and entering
a new name.

When saving a story with an existing filename, a message
informs you that the file on disk with the same name wiU
be replaced. Select YES to continue, or NO to cancel.

Note: Quick Save does not give you the opportu
nity to change the drive and directory in which
you save your story, although this information is
displayed.
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Using the File Services Panel

1. Select Save Story on the File menu. The File Services
panel appears.

EDIT L

•Qi He

File Edit nodes Run

CiNSTORVBD

Directory

< Previous >

SAUE Story file

I fill files I I YES I I HO I

Filenane

TUTORIAL. SH

< Heu >

(oiBMiirai

Figure 5-16. The File Services Panel

The box at the top of this panel shows the currently
seleeted drive and directory. The left side of the
middle box is where you decide which files will be
listed in the Filename box in the lower right portion
of the panel. When saving a story, .SH~ files is high
lighted in the middle portion of the panel, which
means only files with the extension SH~ are listed in
the Filename box. To list all files in the current direc

tory, select AH files.

The bottom portion of the panel is where you select
the drive, directory, and filename in which to save the
story. In eaeh of the Drive, Directory, and Filename
boxes, arrows pointing up and down on the right side
of the box enable you to scroll through the list when
there are more entries than those displayed.
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2. If you are editing a story and you want to update the
original with your changes, select the name of the file
from the Filename box.

If you want to create a new file for the story, select
New from the Filename box. Then type a name for
the file, following DOS file naming conventions.

3. If you selected a filename, select YES on the File Ser
vices panel to save the story. If you selected New,
press Enter.

The story is saved using the filename you selected or
entered.

Getting Stories
1. Select Get Story from the File menu. The File Ser

vices panel appears. All files in the current directory
with the extension SH~ are listed in the Filename box

(to list all files in the current directory, select All files
in the middle box of the File Services panel).

2. To get a file from a different drive or directory, select
the drive or directory from those listed in the Drive
and Directory boxes.

3. Select the name of the story file you want to get from
those listed in the Filename box. Or, select Type in
the Filename box to enter the name of a file.

4. If you selected the name of a file, select YES to get it
(or NO to cancel). If you selected Type, type the
name of the file and press Enter. The name of the file
appears in the upper left comer of the Story Editor
screen.
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Merging Stories
You can merge a story with one you are currently cre
ating or editing by following these steps.

1. Select Merge Story from the File menu. The File Ser
vices panel appears so you can select the story to
merge. All files in the current directory with the
extension SH~ are listed in the Filename box (to list
all files in the current directory, select All files in the
middle box of the File Services panel).

2. To get a file from a different drive or directory, select
the drive or directory from those listed in the Drive
and Directory boxes.

3. Select the name of the story file you want to merge
from those listed in the Filename box. Or, select Type
in the Filename box to enter the name of a file.

4. If you selected the name of a file, select YES to get it
(or NO to cancel). If you selected Type, type the _
name of the file and press Enter. You return to the
Story Editor screen. "MERGE FILE" appears in the
lower left part of the screen.

5. Scroll the story table so that the line you want to
follow the merged story is the current story line.

6. Move the pointer to the current story line and press
Button 2. The story you selected is inserted before the
current story line. You can scroll the story table and
merge the story again by repeating this step.

Note: The original merged story file is not
changed or affected in any way by merging it in
the story you are creating or editing.
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Removing a Story
Use the Remove Story option on the File menu to erase
story files from your disk. To use this option:

1. Select Remove Story from the File menu. The File
Services panel appears. The story files in the current
directory are listed in the lower right box of this
panel.

2. To select a story to remove from a different directory
or drive, select the directory or drive from those listed
in the Drive and Directory boxes.

3. Select the name of the story file you want to remove
from those listed in the Filename box. Or, select Type
in the Filename box to enter the name of a file.

4. If you selected the name of a file, select YES to
remove it (or NO to cancel). If you selected Type,
type the name of the file and press Enter. A message
asks you to confirm that you want to remove the
story.

5. Select YES to remove the story, or NO to cancel.

Printing Your Story
Use the Print Story option on the File menu to print the
story you are currently creating or editing. If there is a
marked block of lines in the story, only those lines are
printed.

To use the Print Story option:

1. Select Print Story from the File menu. A box appears
that instructs you to press Enter to start printing and
Esc to stop printing.

2. Make sure your printer is switched on and ready, and
that the paper is adjusted properly.

3. Press Enter to start printing. To halt printing at any
time, press Esc.
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Copying a Story and Related Files
You can copy the current story and the files and parame
ters referenced in the story to another drive or directory
using the Copy Story & Files option on the File menu.
Files referenced by the /CALL and /TELL commands are
not copied.

Note: Before copying a story to diskettes, make
sure you have enough formatted diskettes to hold
the story and all picture files used in the story.

To use the Copy Story & Files option:

1. Select Copy Story & Files on the File menu. The File
Services panel appears.

2. Select the drive and/or directory where you want to
copy the story and its associated files. To display
other drives or directories not shown in the Drive and

Directory boxes, select the arrows pointing down and
up on the right side of these boxes.

3. To copy the story with its current filename, select YES
on the File Services panel. To copy the story with a
new name, select New in the Filename box. Type a
new name for the story, and then press Enter.

The story and all files referenced in the story are copied
to the drive and directory you specified on the File Ser
vices panel. The path associated with each referenced file
is changed to the new drive and directory.

5-92



Saving Story Editor Defaults
When you first start using Story Editor, the Monitor
option rather than the Full Screen option is always
selected on the Modes menu. If you use the Full Screen
option more often than the Monitor option, you may
wish to have Full Screen rather than Monitor selected

every time you start Story Editor. You can do this using
the Save Defaults option on the File menu.

To use the Save Defaults option, first make sure Full
Screen is selected on the Modes menu. If you are running
Story Editor from diskette, also remove the Story Editor
diskette and insert Diskette 1. Then, select Save Defaults
on the File menu. A box appears asking you to confirm
that you want to save defaults. Select YES to continue,
or NO to cancel.

If you select YES, the Full Screen option is selected the
next time you start Story Editor.

— Notes for Keyboard Users

Press Alt-1 to move the pointer to the File menu.
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The Record Voice option on the File menu allows you to
record a voice and to create a file that can be played back
with your story. To use this option, you must have a
microphone, speaker, and either the IBM Voice Commu
nications Option or the IBM Personal System/2 Speech
Adapter installed on your system. Refer to the documen
tation for the IBM Voice Communications Option and
the IBM Personal System/2 Speech Adapter for installa
tion instructions.

If you are using the IBM Voice Communications Option,
you must run VOICE.BAT before starting Story Editor.
Also, the following files must either be in the directory
with Story Editor or be accessed using the DOS PATH or
APPEND commands:

VCAPIDRV.COM VIOTSP.AIC

APIDIR.AIC V2INSP.AIC

BASEPC.AIC V20TSP.AIC

BASESP.AIC V3INSP.AIC

BATCMD.AIC V30TSP.AIC

VOINPC.AIC V4INSP.AIC

VOOTPC.AIC V40TSP.AIC

VIINSP.AIC

To create and use voice files, select Record Voice on the
File menu. The Record Voice panel appears. The fol
lowing sections discuss how to use the options on this
panel.
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Recording a Voice
To record a voice:

1. Select a sampling rate from the Record Voice panel.

The slower sampling rates yield poorer quality, but
use less memory. Some experimentation may help you
decide which rate to use.

2. Select Recording from the Record Voice panel.

3. If you are using the Voice Communications Option,
press Enter to start recording and Esc to end.

4. If you are using the IBM Personal System/2 Speech
Adapter, a panel appears that allows you to choose
the length of your recording. The length options vary,
depending on the sampling rate selected. Select a time
from this panel to begin recording.

5. When the recording is complete, the Record Voice
panel appears.

Playing Back a Recording
Select Playback on the Record Voice panel to hsten to the
recording currently in memory.

If you are using the IBM Voice Communications Option,
press F7 to decrease volume and F8 to increase it.

To stop playback, press Esc.
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Saving a Recording
To save the recording currently in memory:

1. Select Save Voice File on the Record Voice panel.
The File Services panel appears. The voice flies in the
current directory are listed in the lower right box of
this panel.

2. To save the recording in an existing file in a different
directory or drive, select the directory or drive from
those listed in the Drive and Directory boxes.

3. If you want to update an existing voice file, select the
name of the file from the Filename box.

If you want to create a new voice file, select New from
the Filename box. Then enter a name for the file fol

lowing DOS file naming conventions.

4. Select YES on the File Services panel. The recording
is saved using the filename you selected or entered.
Also, the recording remains in memory for playing
back or recording over.

Getting a Voice File
The Get Voice File option lets you retrieve a voice file for
playing back or recording over. To use this option:

1. Select Get Voice File on the Record Voice panel. The
File Services panel appears. All files in the current
directory with the extension SPK are listed in the
Filename box (to list all files in the current directory,
select All flies in the middle box of the File Services

panel).

2. To get a file from a different drive or directory, select
the drive or directory from those listed in the Drive ^
and Directory boxes. ' ^

3. Select the name of the voice file you want to get from
those listed in the Filename box. Or, select Type in
the Filename box to enter the name of a file.
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4. If you selected the name of a file, select YES to get it
(or NO to cancel). If you selected Type, type the
name of the file and press Enter. The voice file is

_ loaded into memory.

Exiting the Record Voice Panei
To exit the Record Voice panel, select Exit. You return
to the Story Editing screen.

Note: If you want to save the recording in
memory, make sure you do so before exiting the
Record Voice panel.

This chapter described how to use Story Editor to create
your stories. "Learning Story Editor" on page 5-14 is a
tutorial that contained steps you can follow to familiarize
yourselfwith some of the Story Editor features described
in more detail elsewhere in the chapter.

Notes for Keyboard Users

Press Alt-1 to move the pointer to the File menu.
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About This Chapter

This chapter describes how to use Story Teller, the
module that lets you present stories you have created with
Story Editor. Using Story Teller is similar to running
stories within Story Editor, except that Story Teller
branches to other stories you specify using the /TELL and
/CALL commands.

The following section "Learning Story Teller" is a tutorial
designed to help you become familiar with this module.
Story Teller reference information begins with the section
"Distributing Story Teller with Your Stories" on
page 6-5.

Learning Story Teller

This section is designed to introduce you to Story Teller.
You need 10 minutes to complete this section.

Note that this section does not contain all of the informa

tion you may need to know about Story Teller. For more
information about this module, refer to the Contents at
the beginning of this chapter or to the Index at the back
of this book for the relevant page numbers in this chapter.

Before using this section, make sure you have backup
copies of the Storyboard Plus diskettes and that the
program has been set up for your system. Chapter 1 dis
cusses backup and setup procedures. Also refer to
Chapter 1 if you need information about starting
Storyboard Plus.

m-
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Showing a Story from the Quick Menu/Setup Screen
In this section you will use Story Teller to show the story
you created using Story Editor. If you did not create a
story using the section "Learning Story Editor" in
Chapter 5, you can show a story that has been included
with your other Storyboard Plus files. ^

1. Use the Cursor Down key to highlight Story Teller on
the Quick Menu/Setup screen.

2. Press Enter to select Story Teller. You see this
message:

STORY_NAME:

3. If you created a story using the section "Learning
Story Editor" in Chapter 5, type TUTOR.

If you did not create a story, type TUTOR2.

4. Press Enter. The story begins on your display.

5. While the story is running, use the following keys to
control the presentation. Press: ^

To back up to the previous picture in the story.

+ To return to the point where you started backing
up. The story waits until you press any key to
continue.

F5 To present the story one step at a time. Press F5
again to present the next step.

F6 To resume the normal running of the story.

FIO To pause the story. Press any key to resume the
story.

6. When the story finishes, you return to the Quick
Menu/Setup screen.
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Showing a Story from the DOS Prompt
You also can use Story Teller to show a story directly
from the DOS prompt.

1. Press Esc to exit the Quick Menu/Setup screen. A
message informs you that you are exiting.

2. Press Y to exit. The DOS prompt is displayed.

3. If you created a story using the section "Learning
Story Editor" in Chapter 5, type sf tutor.

If you did not create a story, type st tutor!.

4. Press Enter. The story begins on your display. After
the story finishes, you return to the DOS prompt.

This concludes the Story Teller tutorial.

You can make additional copies of only the Story Teller
module so you can distribute and show your stories, pro
vided each diskette copy is labeled as follows;

CONTAINS

IBM Story Teller program (ST.EXE)
© Copyright IBM Corp. 1985, 1986, 1987, 1989
All Rights Reserved
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starting from Fixed Disk
If you started Storyboard Plus by entering sbmenu at the
DOS prompt, you can choose Story Teller from the Quick
Menu/Setup screen. Use the Cursor Up or Down key to
highlight Story Teller in the menu, and then press Enter.

After you select Story Teller from the Quick Menu, a
message prompts you to enter the name of the story to
present. Type the story name, preceded by a drive and
directory, if necessary, and then press Enter. Although
Story Editor and Story Teller use the SH~ file extension
to distinguish story filenames, you do not need to include
this extension when entering the story name.

While typing the filename, you can use the Cursor Right
and Left, Insert, and Delete keys to edit your entry. To
cancel entering a filename, press Esc.

You also can start Story Teller directly from the DOS
prompt by entering:

St filename

where filename is the name of the story file. If you do not
include the story filename in this command, a message
prompts you to enter the filename. Include a drive and
directory with the filename, if necessary.

Note: If Story Teller is in a subdirectory, make
sure you change to that directory before entering
the st command.
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starting from Diskette
To start Story Teller from diskettes:

1. Highlight Story Teller on the Quick Menu/Setup
screen using the Cursor Down or Up key, and then
press Enter.

A message appears instructing you to insert a program
diskette.

2. Remove Diskette 1 from drive A and insert Diskette 3,
if you are using 3.5-inch diskettes, or Diskette 4, if
you are using 5.25-inch diskettes.

3. Press Enter. A message prompts you to enter the
name of the story to present. If your story and its
pictures are located on a different diskette than the
one you are using, you can switch diskettes before
entering the filename.

Type the story name, preceded by a drive and direc-
tory, if necessary, and then press Enter. Although
Story Editor and Story Teller use the SH~ file exten
sion to distinguish story filenames, you do not need to
include this extension when entering the story name.

While typing the filename, you can use the Cursor
Right and Left, Insert, and Delete keys to edit your
entry. To cancel entering a filename, press Esc.
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You also can start Story Teller directly from the DOS
prompt. First, insert Diskette 3, if you are using 3.5-inch
diskettes, or Diskette 4, if you are using 5.25-inch
diskettes. Then, enter:

st filename

where filename is the name of the story file. If you do not
include the story filename in this command, a message
prompts you to enter the filename. Include a drive and
directory with the filename, if necessary. If your story
and its pictures are located on a different diskette than
the one you are using, you can switch diskettes before
entering the filename.

Controlling th© Presentation

Using the Keyboard
You can use the following keys while Story Teller is
running to control the presentation of your story.

Key Action

F5 Causes the story to be presented one step at a
time. Press F5 to continue stepping.

F6 Resumes normal running of a story.

FIO Pauses the story. Press any key to resume.

Spacebar Skips the current WAIT period.

Esc Stops the story after the current picture is dis
played. You are asked if you want to continue.
Pressing Y continues the story; pressing N stops
Story Teller and returns to DOS.

Causes Story Teller to back up to the previous
picture or to the previous story line with a
period in the LABEL column, and then waits
until you press any key to continue.
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/ Entering a slash (/) followed by a label causes
the story to immediately branch to the line in
the story containing that label. The label name
entered does not display. If the label cannot be
found, a beep sounds.

+ Returns either to the point in the story where
you began backing up (using the - key), or to
the point where you first took a direct branch
using the / key. The story waits until you press
any key to continue.

Using a Joystick
You also can control the presentation of your story using
the two buttons on a joystick connected to the IBM
Game Control Adapter card. Pressing Button A advances
the presentation when a keystroke is required to continue.
Pressing Button B backs up the presentation in the same
manner as using the - key.

If you use an IBM PS/2 mouse, you can control the pres
entation with Buttons 1 and 2 as if they were joystick
Buttons A and B.

Using Other Devices
Any device that closes a contact between pins 2 and 4 of
the IBM Game Control Adapter card will have the same
effect as using Button A on a joystick. Similarly, closing
a contact between pins 5 and 7 has the same effect as
using Button B.

Buttons and momentary switches can be used for this
purpose. However, a convenient device is the Kodak
EC-1 Remote Control for Kodak Carousel slide projec-
tors. To use this device, you need to construct an adapter
that connects the five-pin plug on the EC-1 to the 15-pin
D-Shell Connector on the IBM Game Control Adapter
card, as described in Appendix E, "Constructing a
Remote Control Adapter" on page E-1.
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This chapter described how to use Story Teller to present
stories you create with Story Editor. The section
"Learning Story Teller" discussed step-by-step how to
show a story. The story could be one you created in a
previous tutorial, or a story supplied with the Storyboard
Plus programs.
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Appendix Ao Messages

Following are alphabetical lists of messages grouped by
Storyboard Plus module. Included with each message is
an explanation of what has occurred, and what, if any
thing, you should do when you see the message.

PSctuire Maker amd SSory Editor

Block not found.

Return to story editing?

Cause: You have tried to copy or delete a block of lines
and there is no block marked.

What to do: Mark the block of lines you want to copy or
delete.

Cannot access .CLR/.PRO file
Press ESC to continue

Cause: A file containing setup information required to
run Picture Maker/Story Editor cannot be found. This
file can be found on Diskette 1.

What to do: Refer to the sections "Starting and Exiting
Picture Maker" on page 2-4 and "Starting and Exiting
Story Editor" on page 5-3 for information about starting
these modules. If you are running Storyboard Plus from
fixed disk, you may need to use the DOS COPY
command to copy the STB.CLR or STB.PRO file to the
directory containing the other Storyboard Plus program
files.
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Picture Maker and Story Editor Messages

Cannot create file. RETRY?

Cause: Picture Maker/Story Editor attempted to store a
picture on a disk and was unsuccessful. The probable
cause is that the directory is full.

What to do: The best solution is to store the picture on a
blank, formatted diskette. If you are storing your pictures
on a fixed disk, create a new directory or erase files from
your existing directory.

Cannot display image nnn. Image created
in resolution mode mode.

Press Button 1 for next image
or press Button 2 to exit.

Cause: You have selected an image to get or view from
the Get Capture File panel, but Picture Maker/Story
Editor cannot display the image. The image was created
in a higher graphics resolution, or if you are using Picture
Maker, the image may have been created in text mode.

What to do: Press Button 1 to move to the next image or
Button 2 to return to the Get Capture File panel.

Cannot find digitize card.
Return to Digitize panel?

Cause: You have selected YES on the Digitize panel, but
the required digitize card cannot be found. Picture Maker
requires special equipment to use the Digitize function.
This equipment is either not installed in your computer or
the jumpers are not set correctly on the digitize card.

What to do: Refer to "Creating Pictures with a Video
Camera" on page 2-118 for more information about
required equipment and jumper settings.
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Picture Maker and Story Editor Messages

Cannot find DIGITIZE.PDR file.

Return to drawing area?

Cause: Picture Maker cannot find the DIGITIZE.PDR
file, which is required for the Digitize option. The file

—I may have been erased or renamed, or it may be on a dif
ferent program diskette, if you are using a diskette-based
system and you have switched diskettes.

What to do: If you are running Storyboard Plus from
diskettes, insert Diskette 2, if you are using 3.5-inch
drives, or Diskette 3, if you are using 5.25-inch drives, in
the default drive and select NO. If you are running
Storyboard Plus from fixed disk, select YES to return to
the drawing area. Then, use the DOS COPY command to
copy the file from Diskette 2 or 3 to the directory from
which you are trjdng to run Picture Maker.

Cannot find Disk Buffer file. /Picture and/
Font Editor/Switch Page data will be lost. Continue?

Cause: You started to use the Font Editor or Switch

Page option, but Picture Maker could not find the buffer
file—probably because it is located on a different diskette.

What to do: If you have switched diskettes, reinsert the
diskette containing the buffer file and press YES to con
tinue.

Cannot find FILENAME.EXT me. RETRY?

Cause: The file you entered cannot be found.

What to do: Check to see that you entered the filename
correctly. To retype the filename, select NO. If the
filename is correct and you are using a diskette-based
system, the file may be on a different diskette. Switch
diskettes and then select YES to retry.
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Picture Maker and Story Editor Messages

Cannot find

LABEL label.

Return to Story Editor?

Cause: Story Editor cannot find the label you have
entered.

What to do: Select YES to return to story editing.
Check to see if you have entered the correct label.

Cannot find OTHERPRN.PDR file.

Return to drawing area/story editing?

Cause: Picture Maker/Story Editor cannot find the
OTHERPRN.PDR file, which is required for printing
when Other is selected as the printer.

What to do: To return to the drawing area or Story
Editor screen, select YES.

A-4

Cannot find PM.HLP file.

Press any key to return to Drawing Area.

Cause: You have pressed the F1 key for help, but Picture
Maker cannot find the PM.HLP file, which contains the
Help information. The file may have been erased or
renamed, or it may be on a different program diskette, if
you are using a diskette-based system and you have
switched diskettes.

What to do: Check the Storyboard Plus Diskette 2 for
the PM.HLP file. Copy the file to the directory from
which you are trying to run Picture Maker. If you are
using a diskette-based system, insert Diskette 2 in the
default drive. Then, press F1 again.



Picture Maker and Story Editor Messages

Cannot find PRDJTER.PDR file.

Return to drawing area/story editing?

Cause: Picture Maker/Story Editor cannot find a file that
is required for printing. The file may have been erased or

_ renamed, or it may be on a different program diskette, if
you are using a diskette-based system and you have
switched diskettes.

What to do: To return to the Picture Maker or Story
Editor screen, select YES. Use the DOS COPY command
to copy the file from Diskette 2, if you use 3.5-inch drives,
or Diskette 3, if you use 5.25-inch drives, to the directory
or diskette from which you are trying to run Picture
Maker/Story Editor.

Cannot find ROMAN.FAC file. RETRY?

Cause: The ROMAN.FAC font file cannot be found.

The file may have been erased or renamed, or it may be
on a different program diskette, if you are using a
diskette-based system and you have switched diskettes.

What to do: If you are running Storyboard Plus from
diskettes, insert Diskette 2 in the default drive and select
YES to continue. If you are running the program from
fixed disk, select NO. Use the DOS COPY command to
copy the font file from Diskette 2 to the directory from
which you are trying to run Picture Maker.
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Picture Maker and Story Editor Messages

Cannot find SE.HLP file.

Press any key to return to story editing

Cause: You have pressed the FX key for help, but Story
Editor cannot find the SE.HLP file, which contains the
Help information. The file may have been erased or
renamed, or it may be on a different program diskette, if
you are using a diskette-based system and you have
switched diskettes.

What to do: Check the Storyboard Plus Diskette 3, if
you use 3.5-inch diskettes, or Diskette 5, if you use
5.25-inch diskettes, for the SE.HLP file. Copy the file to
the directory from which you are trying to run Picture
Maker. If you are using a diskette-based system, insert
Diskette 3 or 5 in the default drive. Then, press FX again.

Cannot gain access to the card.
Hardware or software missing.
Return to story editing?

Cause: You have tried to use the Record Voice option or
the /SPEAK, /SOUND EFFECTS, or /MUSIC ON
command and you do not have the correct hardware or
software installed in your system.

What to do: To use the Record Voice option or the
/SPEAK command, you must have the IBM Voice Com
munications Option or the IBM Personal System/2 Speech
Adapter installed in your system. If you are using the
IBM Voice Communications Option, you must run the
VOICE.BAT file before you start Story Editor.

To use the /SOUND EFFECTS or /MUSIC ON
command, you must have the IBM Music Feature
installed in your system and you must run KAPI.EXE
before starting Story Editor.
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Picture Maker and Story Editor Messages

Cannot get file.

Cause: The second line of this message contains more
information about why Storyboard Plus could not retrieve
a file. Find the second line of the message in this list for
more information.

Cannot get file. File created
in resolution mode.

Return to story editing?

Cause: Story Editor cannot display the picture file you
have selected in the resolution mode you are using. The
message displays the resolution mode in which the picture
file was created.

What to do: Select YES to return to story editing. Refer
to "Resolution Modes and Story Editor Performance" on
page 5-6 for information about the compatibility of resol
ution modes when using Story Editor.

Cannot print picture.
Printer is not ready. RETRY?

Cause: You tried to print but your printer is not ready.

What to do: Switch off your printer, and then make sure
it is properly loaded with paper and connected to your
computer. Switch the printer back on and make sure it is
online. Then, select YES to retry printing.

Cannot print story.
Printer is not ready. RETRY?

Cause: You tried to print but your printer is not ready.

What to do: Switch off your printer, and then make sure
it is properly loaded with paper and connected to your
computer. Switch the printer back on and make sure it is
online. Then, select YES to retry printing.
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Picture Maker and Story Editor Messages

A-8

Cannot read disk.

Cause: The second line of this message contains more
information about why Storyboard Pius could not read
the disk. Find the second line of the message in this list
for more information. _

Cannot use this option.
Default buffer path is a diskette.

Cause: You tried to use the Picture Maker option in
Story Editor, but your default buffer path is a diskette
drive.

What to do: Select YES to return to story editing. If you
have a fixed disk, change your default buffer path by
pressing F2 at the Quick Menu/Setup screen. If you do
not have a fixed disk, exit Story Editor to use Picture
Maker.

Disk is fuU. RETRY?

Cause: Picture Maker/Story Editor attempted to store
your picture or story on a disk and found that not
enough space was available.

What to do: If you are using a diskette-based system,
insert a formatted diskette with some available space on it
in the default drive, and then select YES to retry. If you
are using a fixed disk, select NO. Remove unnecessary
files from the disk to create more available space.

Disk is write-protected. RETRY?

Cause: Picture Maker/Story Editor attempted to write to
a write-protected diskette.

What to do: Make sure that the diskette is not write-

protected and select YES to retry. Select NO to return to
the File Services panel.



Picture Maker and Story Editor Messages

Drive is not ready. RETRY?

Cause: The drive door is open.

What to do: Make sure that a diskette is inserted in the

drive and close the door. Then select YES to retry.

File about to be removed. Continue?

Cause: Picture Maker/Story Editor is about to erase the
highlighted filename from the disk.

What to do: Select YES to remove the file from the disk,
or NO to return to the File Services panel.

File about to be replaced. Continue?

Cause: Picture Maker/Story Editor is about to save the
picture in a file that already exists.

What to do: Select YES to save the picture or story and
overwrite the existing contents of the selected filename, or
NO to return to the File Services panel.

File is not in .ESQ format. RETRY?

Cause: The file you are trying to retrieve for use with the
/MUSIC ON or /SOUND EFFECTS command is not in
the .ESQ format acceptable to Story Editor.

What to do: Select NO to continue.

File is not in .FAC format. RETRY?

Cause: The font file you are trying to retrieve is not in a
format acceptable to Picture Maker. The only font
format acceptable to Picture Maker other than its own is
the PC Storyboard format.

What to do: Select NO to continue.
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Picture Maker and Story Editor Messages

File is not in .LBR format. RETRY?

Cause: The library file you are trying to retrieve is not in
the format acceptable to Picture Maker.

What to do: Select NO to continue.

File is not in .PIC format. RETRY?

Cause: The picture file you are trying to retrieve is not in
a format acceptable to Picture Maker/Story Editor.
Acceptable formats other than its own are: PC
Storyboard .PIC, BSAVE, Drawing Assistant 1.0 .ART
and .PIC, Graphing Assistant 2.0, .PCX format, and
TIFF (uncompressed).

What to do: Select NO to continue.

File is not in .SH~ format. RETRY?

Cause: The story file you are trying to retrieve is not in a
format acceptable to Story Editor. The only valid format
other than its own is the PC Storyboard format.

What to do: Select NO to continue.

File is not in .SPK format. RETRY?

Cause: The file you are attempting to retrieve for use
with the /SPEAK command is not in the .SPK format
acceptable to Story Editor.

What to do: Select NO to continue.

File is not in .SPR format. RETRY?

Cause: The file you are trying to retrieve for use with the
/SPRITE command is not in the .SPR format acceptable
to Story Editor.

What to do: Select NO to continue.
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Picture Maker and Story Editor Messages

File not removed.

Cause: The second line of this message contains more
information about why Storyboard Plus did not remove
the file. Find the second line of the message in this list
for more information.

File not saved.

Cause: The second line of this message contains more
information about why Storyboard Plus did not save the
file. Find the second line of the message in this list for
more information.

I/O error. RETRY?

Cause: A problem has been encountered with the disk
drive, the disk controller, or the diskette.

What to do: If the diskette drive door is open, close it. If
the drive door is not open, try using a new diskette. If
the error persists, take the disk drive to your dealer for
testing.

Label cannot be found.

Continue?

Cause: The label you have entered cannot be found.

What to do: Select NO to continue.

Memory is full.
Return to story editing?

Cause: You tried to insert a Une, copy a block of lines,
or merge a story into the story table and the story table is
full.

What to do: If you need to add more lines to a story,
delete unneeded lines or create a second story and use the
/TELL command to join the two stories together.
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Picture Maker and Story Editor Messages

Only .EXE and .COM files are allowed.
Continue?

Cause: You are using the /EXEC command and have
selected a file that is not a .EXE or .COM file.

What to do: Check to see if you have selected the correct
filename. Select YES to return to the Get .EXE File Ser

vices panel and select a new filename.

Picture will be added to the file. Continue?

Cause: Picture Maker adds the picture being saved to the
end of the selected file. Picture Maker recognizes this file
as one that has been created in the Picture Taker program
with multiple images under the same filename.

What to do: Select YES to add this picture to the
selected filename, or select NO to return to the File Ser
vices panel.

Saving select box only. Continue?

Cause: Picture Maker saves only the portion of the
picture framed by the select box.

What to do: Select YES if you want only the portion of
the picture framed by the select box to be saved, or select
NO to save the entire picture.

Switch Page content will he erased
to use Digitize. Proceed?

Cause: The second picture you are working with using
the Switch Page option will be lost if you use the Digitize
option.

What to do: Select YES to use the Digitize option, or
NO to cancel.
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Picture Maker and Story Editor Messages

The graphics mode you selected
cannot he supported with your
graphics hardware. Picture Maker/Story Editor has
selected another mode for you.
Press Enter to continue.

Cause: The graphics mode you selected cannot be sup
ported with your hardware. In this message, "graphics
hardware" can be replaced with "system memory" or
"graphics hardware & system memory." Picture
Maker/Story Editor automatically places the program in
the next lower resolution mode supported by your system.

What to do: Refer to "Choosing a Resolution Mode" on
page 1-20 for information about resolution modes and
required equipment.

This iahel exists already.
Continue?

Cause: The label you entered already exists in the story.

What to do: If you would like to change the label you
entered, select NO. If you would like to continue editing
the story without changing the label, select YES.

You are about to exit Picture Maker/Story Editor
Exit (y/n)? [n]

Cause: You pressed Button 2 or Esc at the Picture Maker
or Story Editor Main Menu.

What to do: Press Button 1 or Y to exit, or press Button
2 or Enter to cancel exiting Picture Maker or Story
Editor.
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You are about to exit the program
without saving your latest changes.
Exit (y/n)? [n]

Cause: You pressed Button 2 or Esc at the Picture Maker
or Story Editor Main Menu, but you have not saved your
work on the Picture Maker or Story Editor screen.

What to do: Press Button 1 or Y to exit, or press Button
2 or Enter to cancel exiting Picture Maker or Story
Editor. To save your work before exiting, first return to
the Picture Maker or Story Editor screen by selecting the
first option on the main menu.

You don't have necessary graphics
hardware to run the program.

Cause: Your computer does not have the necessary
graphics hardware to run the program.

What to do: Refer to "Choosing a Resolution Mode" on
page 1-20 for information about resolution modes and
required equipment.

You have selected COM«

for the DOS Device Name

and the card cannot he found.

Cause: A serial card is not located on the COM port that
you selected. You may have selected the wrong serial
port or the wrong input device.

What to do: First, check to make sure you selected the
correct input device. If you have, use the Input Device
Setup option and select the correct serial port.
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Picture Maker and Story Editor Messages

You have selected COM«

for the Printer Port

and the card cannot be found.

Cause: A serial card is not located on the COM port that
you selected. You may have selected the wrong serial
port or the wrong printer.

What to do: First, check to make sure you selected the
correct printer. If you have, use the Printer Port option
and select the correct serial port.

You have selected LPT«

for the Printer Port

and the card cannot be found.

Cause: A parallel card is not located on the printer port
that you selected. You may have selected the wrong
printer port or the wrong printer.

What to do: First, check to make sure you selected the
correct printer. If you have, use the Printer Port option
and select the correct printer port.

You have selected the Other option and the
external device driver cannot he found.

Cause: The external device driver required by your input
device has not been installed.

What to do: Exit Picture Maker/Story Editor and install
the external driver for your input device. Then restart the
program.
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Picture Maker and Story Editor Messages

You need more memory to run the program.

Cause: Your computer does not have enough memory to
run the module.

What to do: Refer to Appendix G, "Storyboard Plus
Product Support and License Information" on page G-1
for information about what you need to use Storyboard
Plus.
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PicSyire Taker

Drive is not ready.

Cause: The diskette drive door is open.

What to do: Ensure that a diskette is inserted into the

drive and close the door.

Drive I/O error.

Cause: A problem was encountered with the disk drive,
the disk controller, or the diskette.

What to do: If the diskette drive door is open, close it. If
the drive door is not open, try using a new diskette. If
the error persists, take the disk drive to your dealer for
testing.

Drive\path\filenanie you have selected
is not in DOS format.

Cause: The drive, directory, or filename you have entered
is not correct.

What to do: Check to make sure you correctly entered
the drive, directory, and filename.

Drive\path you have selected cannot
be found.

Cause: You entered a drive or directory that Picture
Taker cannot find.

What to do: Check to make sure you entered the drive
and directory correctly.
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TexS Maker

Cannot change library.

Cause: The second sentence of this message contains
more information about why Storyboard Plus could not
change the library. Find the second line of the message in
this list for more information.

Cannot create file.

Cause: Text Maker tried to store a text screen on a disk

and was unsuccessful. The probable cause is that the
directory is full.

What to do: If you are using a diskette-based system,
store the text screen on a blank, formatted diskette. If
you are storing your text screens on a fixed disk, create a
new directory or erase files from your existing directory.

Cannot get file.

Cause: The second line of this message contains more
information about why Storyboard Plus could not get the
file. Find the second line of the message in this list for
more information.

Disk is full.

Cause: Text Maker tried to store your screen on a disk
and found that not enough space was available.

What to do: If you have unnecessary files on the disk,
free some space by removing them. Otherwise, store the
screen on a diskette.
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Text Maker Messages

Disk is write-protected.

Cause: Text Maker tried to write to a write-protected
diskette.

What to do: Make sure that the diskette is not write-

protected and retry.

Drive is not ready.

Cause: Text Maker tried to access a disk but was unsuc

cessful. The drive door probably is open.

What to do: Close the drive door and retry.

ERROR in Alter Color specification:
Invalid characters or format. No changes
were made.

Cause: The command you entered to alter color was
incorrect.

Whait to do: After selecting the Alter Color command,
press F1 for information about the correct format for
Alter Color commands.

File extension must he .CAP or .LIB.

Cause: You selected a file for your active library with an
extension other than .CAP or .LIB.

What to do: If the file is in a library file format, rename
it with a .CAP or .LIB extension to use it as a library.

File is in an unusable format or is damaged.

Cause: The file you tried to retrieve is not in a format
usable by Text Maker. Acceptable formats are; Text
Maker files, text screens captured in a .CAP file by
Picture Taker, and .LIB files created from captured text
screens.
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Text Maker Messages

File not removed.

Cause: The second line of this message contains more
information about why Storyboard Plus did not remove
the file. Find the second line of the message in this list
for more information.

File not saved.

Cause: The second line of this message contains more
information about why Storyboard Plus did not save the
file. Find the second line of the message in this list for
more information.

I/O error.

Cause: A problem was encountered with the disk drive,
the disk controller, or the diskette.

What to do: If the diskette drive door is open, close it. If
the drive door is not open, try using a new diskette. If
the error persists, take the disk drive to your dealer for
testing.

Screen not appended to file. File is in invalid
format.

Cause: Text Maker cannot use the file in which you are
trying to store your text screen.

What to do: Save the text screen in a new file.

Text Maker cannot find STB.PRO.

Press 'Esc' to exit.

Cause: Text Maker must read the STB.PRO file before

beginning the program. The file may have been erased or
renamed.

What to do: Check the Storyboard Plus Diskette 1 for
the STB.PRO file. Copy the file to the disk on which you
are trying to run Text Maker.
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Text Maker cannot find your file.

Cause: Text Maker cannot find the file in the current

directory.

What to do: Verify that you have entered the drive and
directory names where your file is stored.

Text Maker requires more memory to run.

Cause: There is not enough memory available to run
Text Maker. You may be running other programs which
are using memory.

What to do: Remove unnecessary programs from
memory and retry running Text Maker.

The file contains no text screens.

Cause: The file selected as the current library is in the
correct library format, but contains only graphic images.

What to do: Choose another file that contains text

screens as the active library.

The file is not in a library file format.

Cause: The file selected as the current library is not in a
format usable by Text Maker.

What to do: Choose another file as the active library.

The file or device name is incorrect.

Cause: The file or device name was not entered correctly.

What to do: Check that the drive, directory, and filename
you entered are correct.
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Text Maker Messages

The file TM.CAP is not in drive X

or it is improperly formatted. Please correct
this and re-run Text Maker. Press 'Esc' to exit.

Cause: The TM.CAP file is required when using Text
Maker. The file may have been erased or renamed.

What to do: Check the Storyboard Plus Diskette 3, if
you use 3.5-inch diskettes, or Diskette 4, if you use
5.25-inch diskettes, for the TM.CAP file. Copy the file to
the disk on which you are trying to run Text Maker. If
you are using a diskette-based system, make sure that
TM.CAP is on the diskette you are using.

The specified screen number is not a text screen.

Cause: You have selected a graphic image contained in a
file created with the Picture Taker program. Text Maker
cannot display graphic images.

What to do: Press Esc to continue. Try a different screen
number from the file, or try a different capture file.

The specified screen number is too large or is
invalid.

Cause: You have selected a text screen from a file con
taining multiple screen images, but the screen number is
larger than the number of images in the file or it is an
invalid number.

What to do: Make sure the number of the screen you are
trying to retrieve is correct.
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Text Maker Messages

The Text Maker help file is either damaged
or cannot he found.

Cause: You have pressed the F1 key for help, but Text
Maker cannot find the TM.HLP file, which contains the
Help information. The file may have been erased or
renamed, or it may be on a different program diskette, if
you are using a diskette-based system and you have
switched diskettes.

What to do: Check the Storyboard Plus program
Diskette 3, if you use 3.5-inch diskettes, or Diskette 4, if
you use 5.25-inch diskettes, for the TM.HLP file. Copy
the file to the directory from which you are trying to run
Text Maker. If you are using a diskette-based system,
insert the Text Maker diskette in the default drive. Then,
press F1 again.

XJnahle to paste; no cut exists.
Please cut first.

Cause: You tried to use the Paste command, but no cut
area exists.

What to do: First cut an area with the Cut command,
and then try the Paste command again.

Warning: A color was not in picture
or background value out of range.
All valid changes were made.

Cause: Your Alter Color command contained a color

that was not found in your text screen, or you specified a
color other than A through H for a background color
change.

— What to do: Verify your color choices and select the
Alter Color command again.
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You are about to overwrite the working copy.
Get and overwrite (y/n)? [n]

Cause: Text Maker is about to retrieve a screen that will

replace the screen you are currently editing.

What to do: Type Y to replace the current screen with
the new screen, or N to continue editing the current
screen.

You are about to remove this file. If you do,
the picture iu it will he lost.
Remove (y/n)? [n]

Cause: Text Maker is about to erase the file you speci
fied from the disk.

What to do: Type Y to remove the file from the disk, or
tj^e N to return to the Remove File panel.

You are about to save this file and

overwrite the same file

on disk. Save and overwrite? (y/n)? [n]

Cause: Text Maker is about to save the text screen in a

file that already exists.

What to do: Type Y to save this picture and overwrite
the contents of the selected file, or type N to return to the
Save File panel.

Your display cannot show 40 columns.

Cause: The display you are using cannot show text
screens in 40-column format.

What to do: Change displays or switch to 80-column
format.
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Text Maker Messages

Your screen has been added to the file.

Cause: Text Maker added the screen you saved to the
end of the selected file. Text Maker recognizes this file as
one that contains multiple screens under the same
filename.
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Appendiis B. Supported Equipment

This appendix lists the equipment supported by
Storyboard Plus. Refer to Appendix G, "Storyboard Plus
Product Support and License Information" for informa
tion about the minimum equipment and software required
to use Storyboard Plus.

IBW System Units

• IBM Personal System/2® Model 25

• IBM Personal System/2 Model 30

• IBM Personal System/2 Model 30-286

• IBM Personal System/2 Model 50

• IBM Personal System/2 Model 50Z

• IBM Personal System/2 Model 55SX

• IBM Personal System/2 Model 60

• IBM Personal System/2 Model 70

• IBM Personal System/2 Model P70 386

• IBM Personal System/2 Model 80

• IBM Personal Computer

• IBM Personal Computer XT™, Models <

089, 286, and 589

IBM Personal Computer AT®, Models 099, 239, 319
and 339

Personal Systeni/2, Personal Computer AT, and Quietwriter are registered
trademarks of the International Business Machines Corjjoration.

Personal Computer XT, Color Jetprinter, Proprinter, Proprinter XL, Pro-
printer X24, Proprinter XL24, Proprinter X24E, and Proprinter XL24E
are trademarks of the International Business Machines Corporation.
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IBM-Compatibie Tested Systems

• CompaqDeskpro 286'

• Compaq Deskpro 386/25'

• Compaq Deskpro 386S'

• Tandy2 3000NL

• Tandy 4000LX

IBM Graphles Cards

• IBM Color/Graphics Adapter

• IBM Enhanced Graphics Adapter

• IBM Personal System/2 Adapter.

• IBM Personal System/2 8514/A Adapter (1MB of
memory required on card)

Note: The Graphics Memory Expansion Module
and Memory Kit for the EGA is required for the
640 X 200— 16 and 640 x 350— 16 resolution

modes.

IBM-Compatible Tested Graphics Cards

• Compaq Video Graphics Adapter

• Tandy Enhanced Graphics Adapter

• Tandy Video Graphics Adapter

1 Compaq, Compaq Deskpro 286, Compaq Deskpro 386/25, and Compaq
Deskpro 386S are trademarks of Compaq Computer Corporation.

2 Tandy is a trademark of Tandy Corporation.
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IBM Displays

• IBM Color Display

• IBM Enhanced Color Display

• IBM Personal System/2 8512 Display

• IBM Personal System/2 8513 Display

• IBM Personal System/2 8514 Display

iBM=C@mpatible T©stted Displays

• Compaq Video Graphics Monitor

• Tandy Enhanced Graphics EGM-1 Monitor

• Tandy VGM-300 Display

IBM Printers

IBM Color Printer

IBM Color Jetprinter™

IBM Graphics Printer

IBM Proprinter™

IBM Proprinter XL™

IBM Proprinter II

IBM Proprinter II XL

IBM Proprinter III

IBM Proprinter III XL

IBM Proprinter X24™

IBM Proprinter XL24™

IBM Proprinter X24E™

IBM Proprinter XL24E™

IBM Pageprinter

• IBM Personal Pageprinter 010
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IBM Personal Pageprinter 020

IBM Personal Page Printer II

IBM Quietwriter ®Model 2

IBM Quietwriter III

IBM Quickwriter

Note: The IBM Personal Pageprinter 010, IBM
Personal Pageprinter 020, and IBM Personal Page
Printer II are supported in Hewlett-Packard
LaserJet + emulation mode only.

IBM-Compatiisl© Tested Printers

• Epson^ FX 80, FX 100, MX 80, MX 100, RX 80,
RXlOO

• Hewlett-Packard LaserJet -f

• Hewlett-Packard LaserJet 500 + *

• Hewlett-Packard LaserJet Series IF

• Hewlett-Packard PaintJet

• Quadram Quadjet^ QJ9000

Dewlces

» Keyboard

• Joystick (IBM or any IBM-compatible)

• IBM Personal System/2 Mouse

' Microsoft Mouse, model number 039-099 (serial inter
face)

3 Epson is a trademark of Epson America, Incorporated.

4 Hewlett-Packard LaserJet+ , Hewlett-Packard LaserJet 500 + , Hewlett-

Packard LaserJet Series II, and Hewlett-Packard PaintJet are trademarks
of Hewlett-Packard Corporation.

5 Quadram and Quadjet are trademarks of Quadram Corporation.



• Mouse Systems^ PC Mouse, part number 900120-214
(serial interface)

Note: The IBM PC and PC/XT Mouse is compat
ible with Mouse Systems PC Mouse, three-button
serial.

• Visi On' Mouse, part number 69910-1011 (serial inter
face)

• Graphics tablets:

— Summagraphics Summasketch MM 1201

— Kurta® Series One Tablet

— Kurta Series Two Tablet

• Video Input Devices:

— Chorus Data Systems PC-Eye' PC-1000 Video
Capture Board (PC Bus)

— Chorus Data Systems PC-Eye PC-1100 Video
Capture Board (PC Bus)

— Chorus Data Systems PC-Eye PC-1200 Video
Capture Board (PC Bus)

— Jovian Logic Corporation VIA" Video Frame
Grabber Board (PC Bus)

— Jovian Logic Corporation VIA Video Frame
Grabber Board (MCA Bus)

— Truevision TARGA" 16 Videographics Adapter

6 Mouse Systems is a trademark of Mouse Systems Corporation.

7 Visi On is a trademark of VisiCorp.

8 Kurta is a trademark of Kurta Corporation.

9 PC-Eye is a trademark of Chorus Data Systems, Inc.

10 VIA is a trademark of Jovian Logic-Corporation.

11 TARGA is a trademark of Truevision Corporation.
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Frame advance (For Story Teller)

— Kodak EC-1 Remote Control

Sound Cards

— IBM Music Feature

— IBM Personal System/2 Speech Adapter

— IBM Voice Communications Card

Notes:

1. IBM only warrants the compatibility of
non-IBM devices listed in this appendix.

2. Other input devices and printers can be used if
a device driver exists. Your dealer may be able
to identify additional input devices and printers
as they become available.



Appendix C= Steryboard Plus ©n the IBM
PC Local Area Network

This appendix is an aid for Storyboard Plus users who
want to use this product on the IBM PC Local Area

/^\ Network (LAN). This Appendix assumes you are familiar
with the IBM PC Local Area Network and have the IBM

Local Area Network User's Guide.

Installing Storyboard Plus on the IBM PC LAN

To use Storyboard Plus on the IBM PC Local Area
Network, use Backup/Install to install Storyboard Plus on
the server computer's fixed disk to each individual's
private subdirectory. Each individual must have write
access to his private subdirectory.

You can install to the server only from the server com
puter. You cannot install to the server from a remote
node.

Starting Storyboard Plus on the IBM PC Network

If you are at the server computer, start Storyboard Plus
according to the instructions in "Getting Started" on
page 1-6.

If you are at a remote computer, be sure you make the
remote directory the default directory. Then follow the
instructions in "Getting Started" on page 1-6.
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Appendix D= Picture File Format

This appendix is a technical reference for users who may
need more information about the format of Picture

Maker's PIC files.

Header

; file header (128 bytes long) :

OB

DW C184H

DW 3

DW 640

DW 350

DW

DW

DB

DW

DW

DW

16 DUP(O)

0

4 DUP(O)

first byte is ASCII 84 (should not be
used to identify the file)

file ID: C184H for all other modes

C185H for 320 x 200-256 mode (10)
C186H for 640 x 480-256 mode (11)

resolution mode identifier:

1

3

7

8

10

11

640

640

640

320

320

640

200-16

350-16

480-16

200-4

200-256

480-256

(These numbers refer to corresponding
modes in this documentation.)

picture's horizontal size (in pixels):
320 for modes 8, 10
640 for modes 1, 3, 7, 11

picture's vertical size (in pixels):
200 for modes 1, 8, 10
350 for mode 3

480 for modes 7, 11

should be:

2 for modes 8, 10, 11
4 for modes 1, 3, 7

should be:

1 for modes 1, 8, 10, 11
2 for modes 3,7

16-color palette
(See the table later in this section for
color/bit map correspondence.)

reserved

framed area identifier (must be 0)
framed area size (don't care)

patterns validity identifier:
0 for valid patterns
12345 for invalid patterns
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DW

DW

DB

DW

DW

0FFFFH

QFFFFH

78 DUP(O)

?
?

(If identifier is 12345, pattern is not
read into Storyboard Plus, but it is in
the file.)

background color; should be QFFFFH

transparent color; should be QFFFFH

reserved

picture total size LOW WORD
picture total size HIGH WORD
(Picture size includes everything, even
the Header.)

END OF THE HEADER

The 256-color palette is 768 bytes long (256 bytes each for
red, green, and blue). The palette is at offset 128 for
resolution modes 10 and 11, but not in the file for the
other resolution modes.

;Palette for 256 color mode only (3*256 = 768 bytes)

DB 256 DUP(?)
DB 256 DUP(?)
DB 256 DUP(?)

RED component
GREEN component
BLUE component
These 256 RGB colors correspond
directly to pixel numbers on screen.
(This palette is not in picture files
for modes other than 256-color mode.)

There are 16 colors which are always
fixed in Picture Maker:

0 = black RGB=0,0,0

1 = dark gray RGB=21,21,21
2 = light gray RGB=42,42,42
3 = green RGB=0,42,0

4 = light green RGB=21,63,21
5 = red RGB=42,0,0
6 = light red RGB=63,21,21
7 = blue RGB=0,0,42
8 = light blue RGB=21,21,63
9 = brown RGB=42,21,0

10 = yel1ow RGB=63,63,21
11 = magenta RGB=42,0,42
12 = light magenta RGB=63,21,63
13 = cyan RGB=0,42,42

14 = light cyan RGB=21,63,63

255 is White RGB=63,63,63



Patterns Definition

The patterns definition is 960 or 1920 bytes long,
depending on the resolution mode. The patterns are at
offset 128 for resolution modes 1, 3, 7, 8, and 11, and at
offset 896 for mode 10.

;Patterns definition (960 or 1920 bytes long depending on mode)

DB X DUP(0) ; X = 960 for mode 10
; X = 1920 for other modes

Picture ill Planes in Compressed Form

The picture bit planes are at offset 2048 for resolution
modes 1, 3, 7, and 8, at offset 1856 for mode 10, and at
offset 2816 for mode 11.

;Picture bit planes in compressed form

DB X DUP(?) compressed picture bit planes:
1 bit plane for modes 10, 11
2 bit planes for mode 8
4 bit planes for modes 1,3,7

NOTE: The second plane data starts right
after the first plane. You must decom
press the first plane to get to the
second one. The same applies for the
third and fourth planes.

Compression

Bit planes are compressed and saved column by column
from top to bottom (except for the 256-color modes,
where the picture is saved hne-by-line).
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The picture format bit plane (for modes 1,3,7, and 8) is as
follows:

1st column 2nd column Xth column

1st line ** byte 1 ** **byte N+1** . ************ —

2nd 1i ne ** byte 2 ** ************ ^^^ ************ p-j cture
—vertical f ^

size

Nth line ** byte N ** ************ ... * byte N*X * -

' ^ '

picture horizontal size

Note: Each byte in the first column provides one
bit (which one depends on which bit plane you are
on) for each of the first eight columns of pixels.
In 256-color mode, each byte provides the value
for one pixel.

Compression Technique
The bit planes are compressed using a "Pack-Bytes"
scheme. If three or more consecutive data bytes are the
same, they are saved under compressed form; if not, they
are saved in uncompressed form.

Compressed form consists of an identification byte whose
high order bit is set. The lower seven bits indicate how
many times the following byte is to be repeated. Uncom
pressed form consists of an identification byte whose high
order bit is cleared. The lower seven bits indicate the

number of bytes that follow which are to be read just as
they are.
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Compressed Form:

compressed
mode flag
set

number of bytes
being compressed

(123 maximum)

Identification byte

Uncompressed Form:

compressed
mode flag
reset

number of uncompressed
bytes following

1 (123 maximum)

Identification byte

data byte

data bytes...

Note: The number of data bytes following the
identification must be less than or equal to 123.

Mode 11 Compression
The bit plane in mode 11 undergoes a second com
pression. If the Identification byte equals 255, the fol
lowing two bytes (one word) contain the number of bytes
being compressed.

ld.byte=255, count low byte, count high byte, data byte

If the Identification byte equals 254, the following byte
contains the number of bytes to be copied from the line
above.

Id.byte=254, count byte

If the Identification byte equals 253, the following two
bytes (one word) contain the number of bytes to be
copied from the line above.

Id.byte=253, count low byte, count high byte
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The Bit Plane Cemisination/Palette Color
Relationship (from File Header)

Note: Bit plane combinations have BitPlane#l as
LSBit.

Mode 8: 320x200-4

Palette Number and Default Color Values in
Header

Bit Plane

Combina

tion (less
sig. bit on

right)

1 2 3 4

OFH OEH 07H 06H 00
* * * * 11

OBH OAH 03H 02H 10

ODH OCH 05H 04H 01

Note: The second color in each of the four

palettes can be any one of the 16 CGA back
ground colors (as opposed to the Storyboard Plus
background color, which is defined at file header
offset 42).

Modes 1, 3, and 7: 16 Colors
Color Default Color

Number Value

Modes 3

and 7 Bit

Plane

Combina

tion (least
sig. bit on

right)

0000

1111

0110

1001

0011

1100

Mode I Bit

Plane Com

bination

D-6

in

Header

2

3

4

5

6

in

Header

3FH

OOH

38H

07H

02H

3AH

light
white

black

gray

white

green

light
green

0000

1111

0110

1001

0101

1010



Color Default
Number Value

in in

Header Header

Color

I

8

9

10

II

12

13

14

15

16

04H

3CH

OIH

39H

06H

3EH

05H

3DH

03H

3BH

red

light red
blue

light blue
brown

yellow
magenta

light
magenta

cyan

light cyan

Modes 3

and 7 Bit

Plane

Combina

tion (least
sig. bit on

right)

0010

1101

1000

0111

1110

0001

1011

0100

1010

0101

Mode 1 Bit

Plane Com

bination

0100

1011

1000

0111

1110

0001

1101

0010

1100

0011
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To further explain the bit plane structure in the 16-color
modes, we can refer to the EGA (VGA) graphics card.
To properly display the picture from the .PIC file, you
should perform the following steps:

1. Load the four bit planes from the .PIC file into the
corresponding planes of the graphics card.

2. Load the color palette registers of the graphics card
with the values found in the 16-color palette of the
.PIC file header (offset 13), according to the previous
table.

For example, in resolution mode 1 (640 x 200—16):

a. The first color value in the 16-color palette (from
the .PIC file's header) should be loaded into hard
ware color palette register 0000b = OOhex (0000b
is the corresponding bit plane combination for
color 1 in the header).

b. The second color value in the color palette should
be loaded into color palette register 1111b =
OFhex (1111b is the corresponding bit plane com
bination for color 2 in the header).

c. The third color value in the color palette should be
loaded into color palette register 0110b = 06hex.

Continue in the same manner until all color values

have been loaded.



Appendiic E= Constrycting a Bemot© Control

In the Story Teller section "Using Other Devices" on
page 6-9, we mentioned using a Kodak EC-1 Remote
Control for controlling presentations. Wiring and parts
for this device are shown below. Construction by a quali
fied electrician is recommended.

Kodak^ Remote Control Adapter

5-Pin inline Socket

15-Pin Subminiature
D plug assembly

Note: The numbers shown above are on the wire

side of the Radio Shack ' 274-1215 socket. They
do not correspond to the numbers on the plug of
the Kodak EC-1. (Plug pin 1 is socket pin 2; plug
pin 2 is socket pin 1; plug pin 3 is socket pin 4;
plug pin 4 is socket pin 3.)

Radio Shack is a registered trademark of the Tandy Corporation.
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The leads are connected to plug and socket pins as
follows:

5-pin socket lead 1 connects to 15-pin plug lead 2.
5-pin socket lead 2 connects to 15-pin plug lead 5.
5-pin socket lead 3 connects to 15-pin plug lead 12.
5-pin socket lead 4 connects to 15-pin plug lead 7.
5-pin socket lead 5 connects to 15-pin plug lead 4.

Parts list:

5-pin inline socket with leads Radio Shack 274-1215, or
equivalent

15-pin subminiature D plug
assembly

15-pin subminiature D plug
housing

Locking screw retainer

3/32" heat shrink tubing

1/2" heat shrink tubing

E-2

AMP 728-2, or equivalent

AMP 728-3, or equivalent

AMP 732-2, or equivalent

ICO Rally "Heatrax" 8502,
or equivalent

ICO Rally "Heatrax"
HIX-1/2, or equivalent



Appendix Fo Creating New Digitize and
Print Driwers

Dlgltii© Drivers

To use a video input device other than those listed in
Appendix B, you must create a replacement for the
digitize driver included with Storyboard Plus (the
OTHERDIG.PDR file). This section is a technical refer
ence for those users who wish to create a new digitize
driver.

General Requirements
Following are general requirements of any digitize driver
you create for use with Storyboard Plus.

• The driver should be:

— In standard EXE format

— Named OTHERDIG.PDR

— No larger than 60KB

• The digitize driver is loaded by Picture Maker via
DOS using the INT 21H function 4BH. The driver
should then:

— Place the FAR address of the digitizing routines in
interrupt vector 35H (for example, using INT 21H
function 25H)

— Terminate normally (for example, using DOS INT
21H function 4CH)

At this point the driver is resident in memory. When you
select the Digitize option. Picture Maker accesses the
driver using a FAR CALL through the vector. Note that
a FAR CALL, not an INT, is used. Therefore, returning
should be via a FAR RET, not an IRET.
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Functions Requested by Picture Maker
The three functions that may be requested by Picture
Maker are indicated by the value in AX:

AX = 0 This is the initialization call, which is invoked
when you select the Digitize option. The driver
tests for the presence of a video input device. If
the device is present, the Digitize panel is dis
played. A message is displayed if the device is
not present.

AX = 1 This is the digitize call, which is invoked when
you select YES on the Digitize panel. The
driver digitizes an image and displays it on the
screen. A work area the size of the screen is

provided for use, if needed.

AX = 2 This is the adjust call, which is invoked to
process changes in brightness and contrast when
you have altered the settings of these controls
on the Digitize panel. Depending on the equip
ment used, the driver may do nothing or may
send signals to the video input device.

These three function calls are described in the following
sections.

Initialization Call

Upon entry, the AX register is set to 0. The Fix Palette
flag is in BL. When BL = 0, Fix Palette is off. When
BL= 1, Fix Palette is on.

Note: When Fix Palette is on, palette colors
should not be changed.

Upon exiting, the AX register should be set to:

AX = 0 if no video input device is present.

AX = 1 if a video input device is present.
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ES:SI = the pointer to two lines of text to be displayed
on the Digitize panel. Each line can be up to
20 characters long, and should be followed by a
byte containing X'F4'. For example:

HWNAME DB 'Digitizer XYZ',0f4h
DB 'by ABCD Corporation.',Of4h

Digitize Caii

Upon entry, the registers are set as follows:

AX =

BX =

1

the segment address of the work area available to
the driver. The size of the work area depends on
the current resolution mode:

16KB 320 x 200-4

64KB 320 x 200-256

64KB 640x 200-16

112KB 640 x 350-16

153KB 640 x 480-16

76KB 640 x 480-256

CL =

the acquisition type selected on the Digitize panel:

1 = black and white

2 = shades

3 = color

CH =

the input type selected on the Digitize panel:

1 = single input
2 = RGB input

DX =

the segment address of the color palette in
256-color resolution modes.
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DS:DX =

the segment and offset of the color palette in all
other resolution modes.

SI = the Brightness value selected on the Digitize panel
(0 to 100).

DI = the Contrast value selected on the Digitize panel (0
to 100).

BP = the current resolution mode:

I = 320 x 200-4

3 = 320 x 200-256

7 = 640 x 200-16

8 = 640 x 350-16

10 = 640 x480-16

II = 640 x480-256

When designing the code to handle the digitize call, the
nature of the video input device is very important. Keep
in mind the following points:

• The picture is passed from the driver to Picture Maker
via the screen. If colors must be changed, make the
changes to the graphic screen controller and to Picture
Maker's palette.

Colors should be changed only if Fix Palette is off.
For 256-color resolution modes, the colors 0 to 14 and
255 should never be changed.

• If the card does not support color, but merely pro
vides gray scale information, then the value passed in
CL should be interpreted as a request for either Black
and White or Shades, or as a request for false color
(the use of the full palette to show as many intensity
values as possible). In this case, a value of 2 in CH
should be treated as an error.



• If the video input device is a frame-grabber with
memory on the card to hold an acquired image, then
it should be possible to perform as much processing as
needed. However, if the hardware scans the image
and sends values back at a fixed rate, there may be
little time to process each pixel and write it to the
video buffer. In this case, you may need to optimize
the code by preloading the registers, particularly when
running on 8088-based machines such as the IBM
PC/XT

• Where production of an image takes a long time (10
seconds or more), you should consider providing a
way to cancel or restart the scan by pressing a key.
This allows you to adjust the camera controls during
digitizing, and then retry without waiting for digitizing
to complete.

• Accessing the video buffer can be quite complex. In
320 X200 —4 resolution mode, several pixels are
packed in each byte, and even and odd display lines
are not contiguous. In modes that use the Enhanced
Graphics Adapter, you must set mask and mode regis
ters (write mode 2 is recommended for speed).

In the worst case, it may be necessary to save the
image in the work area so it can be processed more
slowly afterwards. When scanning the image takes
several seconds, this method has the disadvantage that
nothing appears on the display until the scanning has
been completed, which means you have no opportu
nity to cancel the scan.

• For scanning-type video input devices, interrupts
probably need to be disabled while scanning occurs.
In this case, remember that peeking the keyboard
using INT 16H re-enables the keyboard. You also
may find it necessary to disable the Print Screen inter-
rupt during scanning so that pressing the Print Screen
key does not distort the image.
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Picture Maker provides no facilities for displa5dng error
messages during or after digitizing. If errors occur, the
easiest technique for displaying messages involves using
INT lOH functions 2 (set cursor) and 9 (write character),
waiting for a keystroke, and then removing the message
by writing it again (the write character interface provides
an XOR option which allows this).

Adjust Call

Upon entry, the registers are set as follows:

AX = 2

SI = the brightness value selected on the Digitize panel
(0 to 100).

DI = the contrast value selected on the Digitize panel (0
to 100).

Color Palette Descriptions
The following sections describe the layout of the color
palette in the various resolution modes.

320 X 200 - 4 Resolution Mode

Four-byte palette, four possible settings:
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Palette Number and Default Color
Values in Header

Bit

Map on
Screen

1 2 3 4

DB OFH OEH 07H 06H llllllllB

DB * * * * OOOOOOOOB

DB OBH OAH 03H 02H OlOlOlOlB

DB ODH OCH 05H 04H lOlOlOlOB

Note: The second color in each of the four

palettes can be any one of the 16 CGA back
ground colors.



256-Color Resolution Modes

256 red, 256 green, plus 256 blue: 768-byte palette

For example, the pixel represented by byte 0 on the screen
has the color of:

ES:[0] —red component
ES:[256] —green component
ES:[512] —blue component

with ES being the segment of the 256-color palette.

Standard color assignments across this 256-color palette
are as follows:

Oto 14 The equivalents of the IBM standard colors
(except white). These colors cannot be
changed.

15 to 230 The RGB color palette, which includes all
combinations of the six intensities of red,
green, and blue.

231 to 254 24 shades (gray scales) for black and white
picture support.

White. This color cannot be changed.255

16-Color Resolution Modes

Sixteen-byte color palette:

Color

Code

Bit Map
on Screen

DB OFH HUB

DB COH GOOOB

DB 08H lOOlB

DB 07H OllOB

DB 02H lOlOB

DB OAH OlOlB

DB 04H lOllB
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Color

Code

Bit Map
on Screen

DB OCR OlOOB

DB OIH OlllB

DB 09H lOOOB

DB 06H OOOIB

DB OEH lllOB

DB 05H OOlOB

DB ODH IIOIB

DB 03H 001 IB

DB OBH llOOB

The LSBit corresponds to plane 0 on the screen.

Note: IBM does not warrant the compatibility of
non-IBM devices.

To use a printer other than those listed in Appendix B,
you must create a replacement for the print driver
included with Storyboard Plus (the OTHERPRN.PDR
file). This section is a technical reference for those who
wish to create a new print driver.

General Requirements
Following are general requirements of any print driver
you create for use with Storyboard Plus.

• The driver should be:

— in standard EXE format

— named OTHERPRN.PDR

— no larger than 30KB
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• The digitize driver is loaded by Picture Maker via
DOS using the INT 21H function 4BH. The driver
should then:

— Place the FAR address of the digitizing routines in
interrupt vector 35H (for example, using INT 21H
function 25H)

— Terminate normally (for example, using DOS INT
21H function 4CH)

At this point the driver is resident in memory. When you
select the Print option. Picture Maker accesses the driver
using a FAR CALL through the vector. Note that a
FAR CALL, not an INT, is used. Therefore, returning
should be via a FAR RET, not an IRET.

When called from Picture Maker, the driver should pre
serve the DS register (save it upon entry and restore it
upon exiting).

Functions Requested by Picture Maker
The two functions that may be requested by Picture
Maker are indicated by the value in AX:

AX = 0 This is the initialization call, which is invoked
when you select the Print option. The driver
returns to Picture Maker the address of the

parameter block and the printer name.

AX = 1 This is the printing action call, which is invoked
when you select YES on the Print panel or
Print Preview on the Define Print Colors panel.

The driver prints part of the picture by placing
data bytes into PRINT_BUFFER, and then
returns to Picture Maker, sending the
PRINT_BUFFER contents to the printer. This
call is repeated until the entire picture is
printed.

These function calls are described in more detail in the

following sections.
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Initialization Call

Upon entry, AX = 0. Upon exiting, ES:BX contains the
far address of the parameter block and ES:SI contains the
far address of the two lines of text (the printer name) dis
played on the Print menu. Each of these text lines can be
up to 20 characters long. Each should be followed by a
byte containing F4H. For example:

HWNAME DB 'Printer XYZ',0f4h
DB 'by ABCD Corporation',0f4h

These two lines are automatically centered by Picture
Maker.

Printing Action Call

Upon entry, AX = 1. The print driver action is con
trolled by variables in the parameter block, which is 80
bytes long. Before each printing action call. Picture
Maker loads the parameter block with required informa
tion. Upon returning from the print driver. Picture
Maker receives information from the parameter block.

The parameter block is shown in the following example.

PARAMETER_BLOCK

DB ? ;INIT_FLAG
; =1 start Picture Printing initialization.
; =0 otherwise

Db'? ;PRINT_FLAG (meaningful when INIT_FLA6 =0)
; = 1 print first part of the picture
; = 0 print next part of the picture.
; = 2 reset printer to its original state (printing aborted by user)

OW X ;reserved
DW X ;reserved

DW ? ;CURRENT_6RAPHIC_M0DE
= 8 for 320x200 4 color mode
= 10 for 320x200 256 color mode
= 1 for 640x200 16 color mode
= 3 for 640x350 16 color mode

= 7 for 640x480 16 color mode

= 11 for 640x480 256 color mode

DW X ;reserved
DW X ;reserved
DW X ; reserved
DW X ;reserved f \
DW X ;reserved

Db'? ;PRINT_0RIENTATI0N
; = 1 for Normal Drientation
; = 2 for Turn Page

DB*? ;PRINT_SIZE (for Normal Orientation ONLY)
; = 0 for Small
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; = 1 for Medium

Db'? ;PRINT_TYPE
; = 0 print with shades
; = 1 print with patterns
9

DW X ;reserved
DW X ;reserved
DW X ;reserved
DW X ;reserved

DD

DW

DW

DB

DB

DW

DW

DW

DW

DW

DW

? ;PM_GET_24LINES
a FAR call to Picture Maker routine to get 24 lines of picture to
print.

? ;START_LINE
first line number of that 24 lines.

X ;reserved

? ;SKIP_LINES
= number of lines (6 lines/inch) to skip before printing picture.

? ;EJECT_FLAG
= 1 eject page (form feed) at the end.
= 0 do NOT eject

? ;RGB_COLOR_BUFFER used with PM_GET_24LINES
(offset inside BUFFERS_SEGMENT)

? ;BUFFERS_SEGMENT
segment of RGB_COLOR_BUFFER

24LINES_BUFFER
PRINT_BUFFER

? ;24LINES_BUFFER used with PM_GET_24LINES
(offset inside BUFFERS_SEGMENT)

X ;reserved

? ;PRINT_BUFFER size=8O0 bytes
(offset inside BUFFERS_SEGMENT)

? ;BYTES_IN_PRINT_BUFFER
number of bytes in print buffer

DW ? :PICTURE_HOR_SIZE in pixels
DW ? :PICTURE_VERJIZE in pixels

DW ;reserved

Dw'? ;LINE_DONE_FLAG
; = 1 end of graphic line
; = 0 in the middle of graphic line

Dw'? ;ALL_DONE_FLAG
; = 1 end of printing
; = 0 not done yet

DB 19 DUP(X) ;reserved

end of Parameter Block —
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How Picture Maker Interacts with the Print Driver

When the Print panel is displayed. Picture Maker loads
the print driver in memory, gets its FAR address through
interrupt vector 35H, and executes the initialization call
(AX = 0) to get the parameter block address and printer
name.

After you select YES on the Print panel or Print Preview
on the Define Print Colors panel, the following events
occur;

1. Picture Maker executes the initialization call: AX= 1

& INIT_FLAG= 1. If the printer does not require
initialization, ignore this call and return to Picture
Maker.

2. Picture Maker executes the printing action call:
AX= 1, INIT_FLAG = 0 & PRINT_FLAG= 1 (the
first time; PRINT_FLAG=0 other times).

The driver prints part of the picture by executing a
FAR call to the PM_GET_24LINES routine to get 24
lines of the picture (this call is described in more detail ^
later in this section). ' ^

Because Picture Maker is handUng the printer output,
the driver places the data bytes in PRINT_BUFFER
(800 bytes maximum). When the buffer is full, or at
any time before, the driver can return to Picture
Maker to print the PRINT_BUFFER contents. Three
variables in the parameter block must be set before
returning to Picture Maker:

• BYTES_IN_PRINT_BUFFER: the number of data
bytes in PRINT_BUFFER that must be sent to
the printer.

• LINE_DONE_FLAG: = 1 if the
PRINT_BUFFER does NOT contain the end of
the graphic line; = 0 if the PRINT_BUFFER con-
tains the end of the graphic line.

Note: Picture Maker will check for the Esc key
only if this flag is set, so you should print the
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PRINT_BUFFER contents at the end of each
graphic line.

ALL_DONE_FLAG: = 0 if the printing is not fin
ished; = 1 if there is no more data to print.

Note: When the driver returns to Picture Maker

with ALL_DONE_FLAG= 1, the contents of the
PRINT_BUFFER are not sent to the printer. All
data bytes must be sent to the printer before this
flag is set.

3. If the ALL_DONE_FLAG = 1, Picture Maker assumes
that the entire picture has been printed, and exits the
printing action.

4. Picture Maker sends BYTES_IN_PRINT_BUFFER
bytes from PRINT_BUFFER to the printer.

5. If LINE_DONE_FLAG = 1 and the Esc key is
pressed, Picture Maker executes a Printer Reset call
before stopping the printing action:

AX=1, INIT_FLAG=0, PRINT_FLAG=2

The driver should reset the printer to its original state,
since picture printing was stopped.

6. Picture Maker loops back to step 2 until the
ALL_DONE_FLAG is set or printing is stopped.

How to Use the PM_GET_24LINES Routine
To get 24 lines of the picture to print, the driver should
load START_LINE with the number of the first line to
get (the first line number is 1), and then execute a FAR
call to the PM_GET_24LINES routine.

Upon return, the 24LINES_BUFFER (inside
BUFFERS_SEGMENT) contains up to 24 lines of the
picture to print. Those lines are in a standardized format,
which is the same regardless of the resolution mode. Each
line is composed of PICTURE_HOR_SIZE bytes, each
byte (representing one pixel) is the index (0 to 255) to the
RGB_COLOR_BUFFER (inside BUFFERS,
SEGMENT). RGB_COLOR_BUFFER is 768 bytes long
(256 bytes each for red, green and blue).
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For example, index byte = 0 has the color of:

ES:[SI] = red component (0 to 63)
ES:[SI + 256] = green component (0 to 63)
ES:[SI + 512] = green component (0 to 63)

where ES = BUFFERS_SEGMENT and
SI = RGB_COLOR_BUFFER.

Each line is always 640 bytes long, even if only the first
PICTURE_HOR_SIZE bytes are valid

When PRINT_ORIENTATION = 2 (Turn Page), the
picture lines returned by PM_GET_24LINES routine are
already turned 90 degrees, and PICTURE_HOR_SIZE &
PICTURE_VER_SIZE contain the size of the turned
picture.
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Product support is available for IBM Storyboard Plus
Version 2.00 for one year from the date of registration.

You must register to receive product support. To register,
fill out and return the enclosed registration card. When
we receive your registration card, you become entitled to
product support by calling the number printed on the
enclosed registration card insert.

If you have a question about Storyboard Plus, follow
these steps before you call IBM:

1. Press F1 for on-line help.

2. Check the Contents or Index in this manual for the

sections that describe what you are trying to do.

3. Refer to other manuals if your question involves the
use of other equipment or software with Storyboard
Plus.

If you do not find an answer to your question after fol
lowing these steps, call IBM. Make sure that when you
do call us, you are at your computer and you have the
answers ready for these questions:

• What version of Storyboard Plus are you using? (The
version number appears on the Quick Menu/Setup
screen, on the module main menus, and on the ori
ginal program diskettes.)

What is the make and model of your computer?

How much memory does your computer have?

What version of DOS are you using?

Are you running on a network, and if so, which one?
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• What is the make and model of your printer?

• What type of graphics adapter are you using?

• What type of display are you using?

• What other types of equipment are you using with the
system?

• Do you use any memory-resident programs, such as a
keyboard enhancer?

• What were the last steps you performed before you
encountered the problem?

• What messages did you see, if any?

Licensed Program Specification

The following Licensed Program Specification applies
only to the United States and Puerto Rico.

Statement of Limited Warranty
IBM Storyboard Plus Version 2.00 is warranted to
conform to this Licensed Program Specification when
properly used in its designated hardware and software
environment. Any other documentation with respect to
this licensed program, excluding any documentation refer
enced in this program specification, is provided for infor
mation purposes only and does not extend or modify this
Storyboard Plus Licensed Program Specification. The
Storyboard Plus Licensed Program Specification may be
updated from time to time. Such updates may constitute
a change to these specifications.

This limited warranty and the three-month program
media warranty are contained in the IBM Program
License Agreement supplied with this product and is
available to all licensees of Storyboard Plus.
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statement of Function Warranted

IBM warrants that:

• The media of the software disks and this Storyboard
Plus manual are not defective.

• The program is properly recorded on the media.

• This Storyboard Plus manual is substantially complete
and correct and contains the information which IBM

deems necessary for use of the software.

• The program functions substantially as described in
this manual.

Statement of Operating Environment

Equipment

• One of the following system units with at least 512KB'
of memory and one 5.25-inch (360KB) or one 3.5-inch
(720KB) diskette drive (or one diskette drive and a
fixed disk):

— IBM Personal System/2 Model 25
— IBM Personal System/2 Model 30
— IBM Personal System/2 Model 30-286
— IBM Personal System/2 Model 50
— IBM Personal System/2 Model 50Z
— IBM Personal System/2 Model 55SX
— IBM Personal System/2 Model 60
— IBM Personal System/2 Model 70
— IBM Personal System/2 Model P70 386
— IBM Personal System/2 Model 80
— IBM Personal Computer
— IBM Personal Computer XT, Model 086, 087, 088,

089, 286, or 589
— IBM Personal Computer AT, Model 099, 239, 319

or 339

— Compaq Deskpro 286
— Compaq Deskpro 386/25

Memory requirement excludes DOS. Story Editor running in 640 x
480—16 or 640 x 480 —256 resolution mode requires 528KB of memory.
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— Compaq Deskpro 386S
— Tandy 3000NL
— Tandy 4000LX

• One of the following display combinations:

— IBM Color Display and IBM Color/Graphics
Adapter

— IBM Color Display and IBM Enhanced Graphics
Adapter

— IBM Enhanced Graphics Display and IBM
Color/Graphics Adapter

— IBM Enhanced Graphics Display and IBM
Enhanced Graphics Adapter with 256KB of
memory

— IBM Personal System/2 8512, 8513, or 8514
Display (with IBM Personal System/2 computer)

— IBM Personal System/2 8512, 8513, or 8514
Display and IBM Personal System/2 Display
Adapter or IBM Personal System/2 8514/A
Display Adapter with 1MB of memory

— Compaq Video Graphics Monitor and Compaq
Video Graphics Adapter

— Tandy Enhanced Graphics Monitor EGM-1 and
Enhanced Graphics Adapter

— Tandy VGM-300 Display and VGA Adapter

For information about optional equipment such as
printers and input devices other than the keyboard, refer
to Appendix B.

Soflware

• DOS environments:

— For IBM system units: IBM Personal Computer
Disk Operating System (DOS) Version 3.30 or 4.00

— For Compaq system units: CoiPpaq Personal
Computer DOS Version 3.30

— For Tandy system units: MS-DOS^ Version 3.30

2 MS-DOS is a trademark of Microsoft Corporation.
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Network environment:

- DOS 3.30 or 4.00

- PC LAN Network Version 1.1 or higher

Statement of Product Support

Version 2.00 Program Product for one year from the date
of registration. You must register to receive product
support, as described in "Product Support" on page G-1.

Redistribution Information

Only the following IBM Storyboard Plus module may be
copied onto your application diskette when your applica
tion is dependent on it:

ST.EXE

Each diskette copy of the above module must be labeled
as follows:

CONTAINS

IBM Story Teller Run-time Module
© Copyright IBM Corporation 1985, 1986, 1987, 1989
All Rights Reserved

Copies of this module are provided "AS IS."
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active drawing color 2-103
active pattern, selecting 2-114
alignment in pictures 2-72—2-74
Alter Color option 2-129
altering color (Text Maker) 4-19
animation sequences,

creating 5-76
AREA column 5-70

ASCII characters, editing 2-89

B
background color,

changing 2-106
background color, setting (Text

Maker) 4-17
backing up program

diskettes 1-6

BIOS, Picture Taker use of 3-13
BLEND dissolve method 5-68

blink setting 4-21
blurring spread

boundaries 2-112

Bold option 2-80
border color, of Text Maker

screen 4-20

boxes, drawing (Text
Maker) 4-24

brush shape, changing 2-115
BSave format, saving pictures

in 2-145

Buffer Fill option 2-128
Button action 1-17

button status 2-10, 5-8
Buttons 1 and 2 1-17

CALL command 5-54

capture files, getting 2-149, 3-13,
4-14, 5-39

capture keys 3-10
capturing screens 3-3
Centered option 2-80
Change Color option 2-130
Change Position option 2-81
changing color 2-130
changing Picture Maker

defaults 2-154

characters, selecting (Text
Maker) 4-20

CHECKER dissolve

method 5-69

circles, drawing 2-65
CLEAR command 5-44

Clear Monitor option 5-86
Clear option 2-130
color

active drawing,
selecting 2-103

altering 2-129
background, changing 2-106
changing (Picture

Maker) 2-130
changing (Story Editor) 5-41
inverting 2-125
palette, changing 2-104, 2-106
scales 2-105

screen, changing 2-107
spreads 2-108

COLOR command 5-41

color, use of in Text Maker 4-16
commands, Story Editor 5-34

Input comment 5-62
/CALL 5-54
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commands. Story Editor (con
tinued)

/CLEAR 5-44
/COLOR 5-41
/DISPLAY 5-36
/END 5-63
/EXEC 5-55
/GOSUB 5-45
/GOTO 5-46
/IF 5-48
/IFNOT 5-48
/INPUT 5-47
/INT 5-55
/LOCK OFF 5-61
/LOCK ON 5-61
/MUSIC OFF 5-51
/MUSIC ON 5-51
/PALETTE 5-43
/PRINT 5-61
/RETURN 5-45
/SHOW 5-36
/SOUND EFFECTS 5-52
/SPEAK 5-53
/TELL 5-54
!* 5-63

compatible equipment B-1
Composite Video option 2-73
Constrain option, using

with the Circle icon 2-65

with the Line icon 2-67

with the Rectangle icon 2-64
Contour option 2-124
controlling presentations 6-8
Copy Block option 5-82
Copy option 2-122
copying parts of a picture 2-122
copying pictures 2-139
copying story lines 5-82
Create or Edit option (Text

Maker) 4-15

X-2

creating fonts 2-87
Crosshair option 2-72
CRUSH dissolve method 5-66

current story line 5-10
Cut option 2-128

D
date format 1-12

default buffer path 1-13
default data path 1-15
defaults, changing

in Picture Maker 2-154

in Story Editor 5-93
Define Print Colors

option 2-153
Delete Block option 5-82
deleting lines (Text Maker) 4-27
deleting story lines 5-80, 5-82
DIAGONAL dissolve

method 5-69

digitizing
Digitize option 2-118
selecting a card 1-15
supported input devices B-5

DIR column 5-66

DISPLAY command 5-36

display modes, switching
between 4-14

dissolve method and

direction 5-66

Dither option 2-112
Double Horiz option 2-79
Double Verti option 2-79
drawing area, scrolling 2-137
drawing color, selecting

active 2-103

drawing, freehand 2-68
drawing, using Picture

Maker 2-63-2-74

drawing, using Text Maker 4-23



editing fonts 2-87
ellipses, drawing 2-65
END command 5-63

END parameter 5-50
erasing a picture

- with the Clear option 2-130
^ with the Eraser icon 2-69

error messages A-1
EXEC command 5-55

exiting Storyboard Plus 1-11
EXPLODE dissolve

method 5-67

extended palette 2-104

FADE dissolve method 5-67

Fill icon 2-115,2-128
Fill Shape option, using

with the Circle icon 2-65

with the Rectangle icon 2-64
filling from a buffer 2-128
Fix Palette option 2-105, 2-110
Fix Spacing option 2-79
Flip Vertical/Horizontal

options 2-125
Font Editor option 2-87
fonts

changing 2-78
creating and

editing 2-87—2-93
doubUng width and height

of 2-79

size of, selecting 2-78
foreground color, setting (Text

Maker) 4-17
freehand drawing 2-68
FROM PICTURE column 5-71

Full Screen option (Picture
Maker) 2-138

Full Screen option (Story
Editor) 5-85

Get Attributes option 2-85
Get Background Color

parameter 5-44
Get Color parameter 5-44
Get Existing Label

parameter 5-46
Get Existing Name
parameter 5-38

Get Line Color option 5-70
Get option (Text Maker) 4-14
Get Palette Colors

parameter 5-43
Get Picture option 2-147
Get Story option 5-89
Get Text option 2-85
Get Text & Attr. option 2-85
Get 1 Color parameter 5-42
Get 2 Colors parameter 5-43
GOSUB command 5-45

GOSUB Label parameter 5-49
GOTO command 5-46

Goto Label 5-34

GOTO Label parameter 5-49
graph value 2-96
graphs

coloring 2-99
drawing 2-100
entering data for 2-94
generating 2-94
labeling 2-102
line styles for 2-100
moving 2-101
parameters, setting 2-96
scaling 2-101
shadowing 2-100
type 2-95
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Grid option 2-72

H
Help information,

displaying 2-3, 3-4, 3-10, 4-3,
5-3

high mark 2-99
Hollow Shape option, using

with the Rectangle icon 2-64

I
icons 2-9

IF command 5-48

IFNOT command 5-48

INPUT command 5-47

Input Comment command 5-62
Input Coordinates option 5-74
input device, choosing 1-16
Input Label parameter 5-46
Input Name parameter 5-40
Input Number parameter 5-47
Input Parameters

parameter 5-56
Input Wait Delay option 5-65
inserting lines (Text

Maker) 4-27
inserting story lines 5-80
installation on fixed disk 1-8

INSTANT dissolve method 5-68

INT command 5-55

Invert option 2-125
Italic option 2-80

joystick, using as input
device 1-17, 6-9

justifying text 2-80

X-4

K
Key option 5-65
keyboard, use of

with Picture Maker 2-3, 2-4
with Story Editor 5-3, 5-9
with Story Teller 6-8

LBR files 2-132

Left Justified option 2-80
left-handed operation 1-17
libraries. Picture Maker 2-131
libraries. Text Maker 4-30
LINE column 5-69

line styles
active 2-63

area 2-9

selecting 2-63
lines, drawing

with the Line icon 2-67

with the Pencil icon 2-68

LOCK OFF command 5-61

LOCK ON command 5-61

low mark 2-99

M
magnifying pictures
Mark Block option
marking story lines
Medium parameter
Merge Story option
METHOD column

Microscope option
mirror-image effect with

spreads 2-109, 2-112
Monitor option 5-85
mouse

changing buttons 1-17
making selections with

5-7

2-141, 2-143
5-81

5-81

5-62

5-90

5-66

2-141
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Move option 2-122
moving parts of a picture 2-122
MUSIC OFF command 5-51

MUSIC ON command 5-51

N
No Line option 5-70
No Page Eject option 2-152
No Wait (0) option 5-65

on-line Help information, dis
playing 2-3, 3-4, 3-10, 4-3, 5-3

Opaque option 2-124

Page Eject option 2-152
Paint icon 2-115

PALETTE command 5-43

palette, extended 2-104
palette, 16-color 2-106
parameters. Story Editor

END 5-50

Get Background Color 5-44
Get Color 5-44

Get Existing Label 5-46
Get Existing Name 5-38
Get Palette Colors 5-43

Get 1 Color 5-42

Get 2 Colors 5-43

GOSUB Label 5-49

GOTO Label 5-49

Input Label 5-46
Input Name 5-40
Input Number 5-47
Input Parameters 5-56
Medium 5-62

O (no wait) 5-47
Small 5-62

Turn Page 5-62
Use PM Palette 5-44

parameters. Story Editor (con
tinued)

View Picture 5-41

1 Keystroke 5-47
partial screens, displaying 5-70
Paste option 2-128
patterns 2-114

editing 2-116
filling with 2-115
painting 2-115
selecting active 2-114
spraying 2-114

PCX files 2-148

Pencil icon 2-68

Picture Maker

defaults, saving 2-154
exiting 2-7
icons 2-9

learning 2-12
messages A-1
on-line Help 2-3
screen 2-8

starting 2-4
starting from Story

Editor 5-30

tutorial 2-12

Picture Taker

learning 3-6
messages A-17
on-line Help 3-4, 3-10
options, setting 3-10
starting 3-4
tutorial 3-6

pictures
capturing 3-3
clearing 2-130
controlling alignment in 2-72
copying parts of 2-122
cutting and pasting 2-128
editing 2-121
erasing 2-69, 2-130
file format of D-1
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pictures (continued)
flipping 2-125
getting 2-147
moving parts of 2-122
printing from Picture

Maker 2-151

printing from Story
Editor 5-86

removing 2-150
retrieving 2-147
rotating 2-125
saving 2-144
scaling 2-126
selecting areas of 2-121
showing 2-150
tutorial 2-12

pixel 1-20
pointer 2-3
PRINT command 5-61

Print option (Picture
Maker) 2-151

Print Preview option 2-153
Print Story option 5-91
printer resolution 1-19
printer, selecting 1-18
printing pictures from Picture

Maker 2-151

printing pictures from Story
Editor 5-86

programs, running from a
story 5-55

Proportional option 2-79
PUSH dissolve method 5-67

Quick Menu maintenance 1-23
Quick Save feature 2-144, 5-87

X-6

Record Voice option 5-94
rectangles, drawing 2-64
remote control adapter, con

structing E-1
Remove Picture option 2-150
Remove Story option 5-91
removing sprites 5-60
removing Storyboard Plus from

fixed disk 1-9

REPLACE dissolve

method 5-67

Reset Colors option 2-154
resolution modes

choosing 1-20
definition 1-20

equipment required for 1-21
resolution, printer 1-19
retrieving pictures 2-147
retrieving stories 5-89
RETURN command 5-45

Rewrite Last Text option 2-83
RGB color system 2-104
Right Justified option 2-80
right-handed operation 1-17
Rotate option 2-125
Ruler option 2-73
Run Story option 5-85
Run & Print Story option 5-86

Save BSave option 2-145
Save Defaults option 2-154
Save Text & Attr. option 2-84
Save TIFF option 2-145
saving pictures 2-144
saving stories 5-87
saving text screens 4-28
scale interval 2-98

Scale option 2-126
screen colors, selecting 1-20



screen color, changing 2-107
screen coordinates

displaying in Picture
Maker 2-72

displaying in Text
Maker 4-28

screens, capturing 3-3
Scroll icon 2-137

select box 2-30

use of in Picture Maker 2-121

use of in Story Editor 5-59,
5-73

Select icon 2-121

selecting 2-3, 5-7
selecting areas of a

picture 2-121, 2-124
Set Attributes option 2-77
Set on Full Screen option 5-73
Set on Monitor option 5-73

Set Shadow option 2-70
Set Spacing option 2-79
setting up Storyboard Plus 1-11
Shadow option 2-80

_r-i.... shadows 2-70
SHOW command 5-36

Show Page option 2-150
sketch pad 2-139
Skip 2 Lines option 2-153
Small parameter 5-62
SOUND EFFECTS

command 5-52

sound, switching on/off 1-23
SPEAK command 5-53

SPLIT dissolve method 5-68

Spray icon 2-114
Spread option 2-108
SPRITE command 5-57

sprites 5-57
squares, drawing 2-64
Start New Story option 5-82

starting Storyboard Plus 1-10
status line 4-16

Step Story option 5-85
stories

creating 5-10
editing 5-80—5-84
getting 5-89
merging 5-90
presenting 6-3
printing 5-91
removing 5-91
saving 5-87
tutorial 5-14

viewing 5-85
Story Editor

defaults 5-93

exiting 5-6
learning 5-14
messages A-1
on-line Help 5-3
partial screens 5-70
starting 5-3
tutorial 5-14

story lines
copying 5-82
deleting 5-80, 5-82
inserting 5-80
labeling 5-32
marking 5-81
unmarking 5-82

story monitor 5-8
clearing 5-86

story table 5-8, 5-10
additional columns 5-65

clearing 5-82
scrolling 5-10

Story Teller
distributing 6-5
learning 6-3
starting 6-6
tutorial 6-3
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Storyboard Plus
backing up 1-6
exiting 1-11
installing on fixed disk 1-8
messages A-1
removing from fixed disk 1-9
setting up 1-11
starting 1-10

STRIPES dissolve method 5-68

Switch Page option 2-139

TELL command 5-54

text attributes, saving and
retrieving 2-83

text attributes, setting 2-77
text fonts, changing 2-78
text fonts, creating and

editing 2-87—2-93
Text icon 2-75

Text Maker

exiting 4-5
learning 4-6
messages A-18
on-line Help 4-3
starting 4-4
tutorial 4-6

text screens

creating 4-15
cutting and pasting 4-26
deleting lines from 4-27
displaying coordinates in 4-28
editing 4-15
erasing 4-25
inserting lines in 4-27
removing 4-29
retrieving 4-14
saving 4-28

text, entering (Text Maker) 4-22
text, using in pictures 2-75—2-93
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TIFF files 2-147

TIFF,-saving pictures in 2-145
TIME column 5-63

timing, controlhng in Story
Editor 5-63

TO SCREEN column 5-71

Transparent Color option 2-123
Transparent option 2-123
Turn Page parameter 5-62
tutorials

Picture Maker 2-12

Picture Taker 3-6

Story Editor 5-14
Story Teller 6-3
Text Maker 4-6

type styles, choosing 2-80

u
Underline option 2-80
undoing changes (Picture

Maker) 2-121
undoing changes (Text

Maker) 4-27
Unmark Block option 5-82
unmarking story lines 5-82
updates from Version 1.01 v
Use PM Palette parameter 5-44
Use Shades/Patterns

options 2-152

Version 2.00 enhancements v

video camera, creating pictures
with 2-118

video input devices B-5
View Picture parameter 5-41
voice files, using with

stories 5-53, 5-94
voices, recording 5-94



w
WAIT column 5-64

Wave Effect option 2-109,2-112
WEAVE dissolve method 5-69

X
X,Y Coordinates option 2-72

z
Zoom option 2-143

Numerics
0 (no wait) parameter 5-47
1 Keystroke parameter 5-47

Special Characters
/* command 5-63
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Continued from inside front cover.

SUCH WARRANTIES ARE IN LIEU OF
ALL OTHER WARRANTIES, EXPRESS
OR IMPLIED, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS

FOR A PARTICULAR PURPOSE.

Some states do not allow the exclusion

of implied warranties, so the above
exclusion may not apply to you.

LIMITATION OF REMEDIES

IBM's entire liability and your exclusive
remedy shall be as follows:
1) IBM will provide the warranty

described in IBM's Statement of

Limited Warranty. If IBM does not
replace defective media or, if appli
cable, make the Program operate as
warranted or replace the Program
with a functionally equivalent Pro
gram, all as warranted, you may
terminate your license and your
money will be refunded upon the
return of all of your copies of the
Program.

2) For any claim arising out of IBM's
limited warranty, or for any other
claim whatsoever related to the

subject matter of this Agreement,
IBM's liability for actual damages,
regardless of the form of action,
shall be limited to the greater of
$5,000 or the money paid to IBM, its
Authorized Dealer or its approved
supplier for the license for the
Program that caused the damages
or that is the subject matter of, or is
directly related to, the cause of
action. This limitation will not apply
to claims for personal injury or
damages to real or tangible personal
property caused by IBM's negligence.

3) In no event will IBM be liable for any
lost profits, lost savings, or any
incidental damages or other conse
quential damages, even if IBM, its
Authorized Dealer or its approved
supplier has been advised of the
possibility of such damages, or for
any claim by you based on a third
party claim.

Some states do not allow the limitation
or exclusion of incidental or consequen
tial damages so the above limitation or
exclusion may not apply to you.

GENERAL

You may terminate your license at any
time by destroying all your copies of the
Program or as otherwise ctescribed in
this Agreement.

IBM may terminate your license if you
fail to comply with the terms and condi
tions of this Agreement. Upon such
termination, you agree to destroy all your
copies of the Program.

Any attempt to sublicense, rent, lease or
assign, or, except as expressly provided
herein, to transfer any copy of the
Program is void.

You agree that you are responsible for
payment of any taxes, including personal
property taxes, resulting from this
Agreement.

No action, regardless of form, arising
out of this Agreement may be brought by
either party more than two years after
the cause of action has arisen except for
breach of the provisions in the Section
entitled "License" in which event four

years shall apply.
This Agreement will be construed under

the Uniform Commercial Code of the
State of New York.
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